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Important Information

Warranty

Copyright

Trademarks

The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not
execute programming instructions if National Instruments receives notice of such defects during the warranty period.
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully
reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves
the right to make changes to subsequent editions of this document without prior notice to holders of this edition. The
reader should consult National Instruments if errors are suspected. In no event shall National Instruments be liable for
any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE
CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS,
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence.

Any action against National Instruments must be brought within one year after the cause of action accrues. National
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product;
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties,

or other events outside reasonable control.

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical,
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without
the prior written consent of National Instruments Corporation.

Lookout™, natinst.com™, and National Instruments™ are trademarks of National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS

(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING
FOR A LEVEL OF RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS
OR AS CRITICAL COMPONENTS IN ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN
REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE
PRODUCTS CAN BE IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO
FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, COMPUTER HARDWARE MALFUNCTIONS,
COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS AND DEVELOPMENT
SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC
MONITORING OR CONTROL DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE
AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON THE PART OF THE USER OR
APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER COLLECTIVELY
TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK
OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM
FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE
REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT
LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS
CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A
USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION
WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING
AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL
INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT
LIMITATION, THE APPROPRIATE DESIGN, PROCESS, AND SAFETY LEVEL OF SUCH SYSTEM OR
APPLICATION.
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About This Manual

This manual describes Lookout object classes, listed in alphabetical order,
in two sections.

Conventions

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

> @

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click on in the software,
such as menu items and dialog box options. Bold text also denotes
parameter names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

monospace bold Bold text in this font denotes the messages and responses that the computer
automatically prints to the screen. This font also emphasizes lines of code
that are different from the other examples.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value
that you must supply.
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About This Manual

Related Documentation

The following documents contain information that you might find helpful
as you read this manual:

»  Getting Started With Lookout
*  Lookout Developer’s Manual
*  Lookout Operator’s Manual

»  Lookout Object Developer’s Toolkit Reference
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Introduction to the Lookout
Object Class Reference

This manual describes Lookout object classes, listed in alphabetical order,
in two chapters.

Chapter 2, Lookout System Objects, covers the Lookout System object
classes, native to Lookout. You use objects made from these classes as
controls and for data analysis and display.

Chapter 3, Lookout Driver and Protocol Objects, contains Lookout driver
and protocol objects that you use to connect to PLCs, RTUs, and other
hardware that is a part of your industrial automation and control system.

Input parameter syntax and data members are documented for each object
class, along with a description of the functionality of each object class.

@ Note Lookout assists you in building graphical screen displays when possible. When you
place a displayable object (like Pots or Switches) on a control panel, the appropriate
Display Parameter dialog box appears, prompting you to select a display type. If the
object is not displayable but supports an implicit signal (like Counters, LatchGates, and
OneShots), Lookout inserts an expression on the control panel.

You can elect not to display an object or its signal by clicking on the
Cancel button at any time. If you change your mind later, you can display
the object or its signal using the_ Insert»Displayable Object or
Insert»Expression commands, respectively.

Some object classes have neither a display member nor an implicit
signal—instead they have multiple data members. If you want to display
the result of a logical or numeric data member on a control panel, you can
use the Insert»Expression command and choose the appropriate name and
data member, or drag and drop the data member from the Lookout Object
Explorer.

See the Getting Started with Lookout manual for more information on
creating objects, modifying their databases, and linking them together.

© National Instruments Corporation 1-1 Lookout Object Reference Manual



Lookout System Objects

This chapter describes Lookout System object classes, listed in alphabetical
order. Input parameter syntax and data members are documented for each
object class, along with a description of the functionality of each object
class.
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Chapter 2 Lookout System Objects

Accumulator

Accumulator is a numeric totalizer. It samples the numeric Input any time
the Sample value transitions from off to on, adding each new sample to the
previous running total. It resets the totalized value to zero when Reset
transitions from off to on.

M ame: W
Input = ||
Sample = I
Reset = I
QK | Cancel | Help |

Figure 2-1. Accumulator Definition Parameters Dialog Box

Input is a numeric expression while Sample and Reset are logical
expressions.

The following HyperTrend demonstrates the relationship between Input,
Sample, and Reset.
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Accumulator Data Members

Chapter 2 Lookout System Objects

Table 2-1. Accumulator Data Members

Data Members

Type

Read

Write

Description

(implicit)

numeric

yes

no

Current totalized value, totalized since the
most recent Reset signal. Updated at the
defined Sample rate.

Comments Reset could be a regular pulse interval created by a Pulse timer, as shown

in the dialog box in Figure 2-1.

The Counter object class totalizes a number of logical events and the
Integral object class totalizes rates. Use Accumulator to totalize numeric
variables.

Related Objects Average, Minimum, Maximum, Sample

© National Instruments Corporation
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Chapter 2 Lookout System Objects

Alarm

Alarm is a flexible and powerful object class you use to create various
logical- and numeric-triggered alarms that are displayed in the alarm
window.

@ Note You should first read about the Lookout alarm system in Chapter 9, Alarms, in the
Lookout Developer’s Manual to aid you in designing the most efficient alarming scheme
for your application.

Lookout Object Reference Manual

Create Alarm E

M ame:

ILogicaIAIarm Alarm area: IF'Iant J

Meszage = I"Helief walve failed to open after 30 zeconds"

Condition = IF'LEI‘I reliefyly &MD DelayOnTimer

Friority
[1-10):

—* | ogical alam

m?ve IC:\ Browse... |

" Mumeric alam

FEriaritiss

Hittilevel= | [
Hilevel= | [
Lrlevel= I l_

Lher{ b evel = I l_
Erateiaf change = I l_

(= I [Examples 1RV ar penmiaute]

Sample = I

QK I Cancel | Help

Figure 2-2. Typical Settings for a Logical Style Alarm

There are two basic alarm types: Logical and Numeric. When Logical
alarm is selected, Lookout prompts you to enter a logical expression in
the Condition field. It then uses the logical Condition to trigger and reset
the alarm. If the alarm Condition is true, the alarm is active, and if the
condition is false, the alarm goes inactive. You can also connect an audio
Wave file to individual logical alarms. See Playwave for additional

information.

Lookout queues alarm .wav files, with up to 100 files in the queue. Each
alarm .wav file plays completely before the next file plays. If more than
100 alarms fill the queue, new alarms cancel the currently playing files and
begin playing instead.

2-4

www.natinst.com



Chapter 2 Lookout System Objects

When you pick the Numeric alarm selection, the name of the Condition
field changes to Signal. This prompts you to enter a numeric expression in
the field against which your various alarm setpoints are measured. Hi-Hi,
Hi, Lo, and Lo-Lo are all numeric expressions. Rate of change generates
an alarm when the signal is actively changing by the set amount for the
period of time between any two Sample pulses. The Unit time setting
determines the time units for the rate of change.

Create Alarm E
Mame: IAIarm‘I Alarm area: I J

Meszage = I

Signal = I

~" Logical alam
Eriarity e
il file I Bratse... |

—* Mumeric alam

Pricrity:

HiHilevel = [HiHiSetpoint s
Hilevel = | [ ]

Lo level = I l_

Lo-Lo level = ILoLoSetpoint IB_
Fiate of change = |2.5 |4—

Lnit time: IDD:D‘I :00.0 [Example: 1:00 for per minute]

Sample = IF'uIse [true, 0:0:1.0, 0.0]

QK I Cancel | Help |

Figure 2-3. Typical Settings for a Numeric Style Alarm

Alarm area specifies the group name associated with the alarm object. All
previously defined groups appear in the list box and may be selected with
the mouse.

Priority ranges from 1 to 10 where 10 is the most important.

Message is a text expression whose result is displayed in the alarm window
when this object generates an alarm. If alarm style is numeric, the relevant
alarm trigger prefixes your message (for example, HiHi level: Alarm
message). See Chapter 9, Alarms, in the Lookout Developer’s Manual for
additional information.
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Chapter 2

Lookout System Objects

Alarm Data Members

Table 2-2. Alarm Data Members

Data Members Type Read Write Description

active logical yes no Result of logical alarm status. True if
alarm is active and false if alarm is
inactive.

hi logical yes no Result of numeric alarm hi data member
status.

hihi logical yes no Result of numeric alarm hihi data member
status.

lo logical yes no Result of numeric alarm lo data member
status.

lolo logical yes no Result of numeric alarm lolo data member
status.

rate logical yes no Result of numeric alarm rate data member
status.

Comments A common alarm condition is caused by a measured value going out of an
acceptable range. For example, a storage tank whose level is too low or too high can
generate several alarms: Hihi: Tank level is out of range,or Lo: Tank level
is out of range. If you use a numeric style alarm to trigger the alarm and if the tank
level fluctuates or “jitters” around the alarm level settings, a new alarm record is
generated in the alarm window each time the tank level fluctuates above or below the
level settings. To alleviate this condition, you could use the Neutralzone object to filter
out minor tank fluctuations.

Note Alarms can also be defined through parameter settings on object data members.
Many times, this is the most efficient method of defining and creating alarm conditions.
See Database-Generated Alarms in Chapter 9, Alarms, in the Lookout Developer’s
Manual, and Editing Object Databases in Chapter 4, Using Lookout, in the Getting Started
with Lookout manual.
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$Alarm

Chapter 2 Lookout System Objects

$Alarm is a global object. It makes available global alarm data such as the
number of currently active alarms.

You can use $Alarm data members just like other data members. By
inserting an expression you can display the number of active alarms in any
particular group. Or, by connecting a pushbutton to an acknowledge data
member, operators can acknowledge alarms through pushbutton selection.

Assume, for example, that you want to create a pushbutton that
acknowledges all alarms. First create a pushbutton object. Next, use the
Object»Edit Connections... command to connect the pushbutton (Pb1)
to the . ack data member of $Alarm. Such a connection is shown in the
following illustration.

— Select member:
Mwritable: members: Eisting connections: St obiect...l
test =]

water
waveforms

ack
activatePanel
mminimizeP anel hd

=
Accept |
$dilarm. ack = |
MNew logical connection Clear |

— Signals:

Tags: [C|533] Path Mode: IHeIative j
In: IE paroikos. dy. natinst. com Eiailiats kel bagie]
", chilf1-24
g
% shift.f1-24
I-{;&S— $larm
----- 3% Panell

Paste \ “$Kepboard 1 Help |

Figure 2-4. Edit Connections Dialog Box for using $Alarm

The expression (Pb1) acknowledges all active alarms any time the
pushbutton is depressed. You could make similar connections to
acknowledge individual alarm areas.
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Chapter 2 Lookout System Objects

You can define new alarm areas through Alarm objects and by modifying
object database parameters. As you create each new alarm area, Lookout
adds new readable and writable data members to the $Alarm object.
$Alarm data members are described in the following table.

$Alarm Data Members

Table 2-3. $Alarm Data Members

Data Member Type Read | Write Description
ack logical no yes Upon transition from FALSE to
TRUE, acknowledges all alarms.
Ackselected logical no yes | Upon transition from FALSE to
TRUE, acknowledges all selected
alarms.
ActivatePanel logical no yes | Calls Alarm Window upon transition

from FALSE to TRUE, making it
visible on the screen.

Active numeric yes no Total number of currently active
alarms (that is, alarm conditions that
still exist).

Groupname text yes no Alarm area name associated with the
most recent alarm.

Groupname.ack logical no yes Upon transition from FALSE to
TRUE, acknowledges all alarms
within the specified group.

Groupname.active numeric yes no Number of currently active alarms
within the specified group.

Groupname.unacked numeric yes no Number of unacknowledged alarms
within the specified group.

Message text yes no Text of the message of the most recent
alarm

MinimizePanel logical no yes | Closes Alarm Window upon transition
from FALSE to TRUE, changing it to
an icon.

Priority numeric yes no Alarm priority associated with the

most recent alarm.

Lookout Object Reference Manual 2-8 www.natinst.com



Chapter 2 Lookout System Objects

Table 2-3. $Alarm Data Members (Continued)

Data Member Type Read | Write Description
PriorityOl.active — numeric yes no Number of currently active alarms of
Priority10.active the specified priority.
PriorityOl.unacked — numeric yes no Number of unacknowledged alarms of
Priority10.unacked the specified priority.

Silence logical no yes | Turns off alarm sounds when set to
TRUE.

Name text yes no Object name associated with the most
recent alarm.

Unacked numeric yes no Total number of unacknowledged
alarms (that is, alarm conditions that
have not yet been acknowledged).

Update logical yes no Pulses high every time there is a new
alarm.

Comments Groupname in the preceding table represents the name of any specified

alarm area. The $Alarm object contains an .active, .unacked, and .ack data

member for every alarm area.

Using $Alarm with Other Objects

Every time a new alarm appears in Lookout, $Alarm.Message,
$Alarm.Name, SAlarm.Groupname, and $Alarm.Priority

are updated with the appropriate information for the new alarm. Then
$Alarm.Update pulses high to alert you that those four data members
contain fresh values.

These data members can serve many purposes, but they are specifically
designed to work with the Pager object class. In a typical application, you
could use SAlarm.Update to initiate a page, possibly including the other
four data members in the text of the page. With this system you can also
filter which alarms you want to page, and which alarms the pager ignores.

© National Instruments Corporation
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Chapter 2 Lookout System Objects

Alternator

Alternator is an object class Lookout uses to control a series of devices with
various commands. Typically this means rotating the usage of the devices
at specified times.

Mew Alternator E
MName:  [EIHETE
Devices: I
I awimurn run time:
DD:HH:MM:SS
Delay between device starts:
DD:HH:MM:SS

Device failure alarm priority: |5

Device rezponse time:

DD:HH:MM:SS
Device name: I
Timer update:

DD:HH:MM:SS

QK I Eancell Help |

Figure 2-5. Alternator Definition Parameters Dialog Box

Devices determines the maximum number of devices that can be controlled
by the alternator.

Maximum run time is the maximum amount of time that any one device
is allowed to run continuously. This function can be disabled by entering 0.

Delay between device starts is the minimum amount of time between
device starts that are initiated by the alternator object. This function can be
disabled by entering 0.

Device failure alarm priority determines the priority level of alarms
generated by the alternator. This defaults to 5.

Device response time is the amount of time the alternator waits for a
response from a device before activating an alarm. This function can be
disabled for individual devices by not connecting anything to the
Response data member.

Device name is a string describing the type of device that is being
controlled by the alternator. This is used to create the alarm messages and
is also the name of the group to which the alarms belong.
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Timer update specifies the resolution of the timers used by the alternator
to decide which devices to turn on and off. This also specifies how often the
alternator updates the ElapsedTime and RunTime data members.

Alternator Data Members

Table 2-4. Alternator Data Members

Data Member Type Read | Write Description

Advance logical no yes Turns on the next device in the
sequence and turns off the last device
in the sequence

Command numeric no yes How many devices the alternator is to
have running

DeviceConnectl - logical yes no States whether device is in the active

DeviceConnect100 sequence considered by the alternator

DeviceOnl - logical yes no Confirmation of the actual device

DeviceOn100 state

DeviceRequest1 - logical yes no Output to whatever drives the device

DeviceRequest100

ElapsedTimel - numeric yes no Elapsed time device has been on since

ElapsedTime100 last reset

HOAmodel - numeric no yes States whether device is in Hand, Off,

HOAmode100 or Auto mode

Resetl - Reset100 logical no yes Used to reset the ElapsedTime data
member

Responsel - logical no yes Response bit from device

Response100

RunTimel - numeric yes no Elapsed time device has been on

RunTime100 continuously
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Chapter 2

Lookout System Objects

Connecting the Alternator

The DeviceRequest data members should be connected to whatever
drivers are controlling your devices. Notice that when you connect the
DeviceRequest data member to anything, the DeviceConnect data
member goes high. This connection is the only one required for the
alternator to consider your device connected. The RunTime,
ElapsedTime, DeviceConnect, and DeviceOn data members can be
connected to or not depending on whether you want that information.

The Command data member is the essential writable data member to
connect to. The connection to Command can be any numeric expression,
but a pot is probably most convenient, especially for testing and
demonstration purposes. It only accepts values in the integer range from
zero to the number of Device connections specified as a parameter.

To the Response data members should be connected a response bit from
each device. If no connection is made to Response the alternator does
not require any response from the device. The Advance, Reset, and
HOAmode data members are not essential either; You need only make
connections to them if you want their functionality. Advance and Reset
typically are connected to pushbuttons, and HOAmode typically connects
to a pot. The HOAmode data member only accepts values in the integer
range from one to three.

Command and Advance

Lookout Object Reference Manual

The Command data member is the number of devices that the alternator
is to have running at one time. When you send the alternator its first
command, it requests a corresponding number of devices to turn on.

The DeviceRequest data member for each of these devices goes high to
signify this. When the devices respond that they are in fact on via the
Response data member, (if it is connected) the alternator recognizes that
the device is on and the DeviceOn data member goes high. Conversely, if
the Command data member specifies that devices are to be turned off, the
DeviceRequest data members for the corresponding number of devices
goes low. The devices should then respond accordingly via the Response
data member.

When you give the alternator a numeric command, it takes into account the
number of devices currently running, and makes its requests accordingly.
Because of this, it is important to know how the alternator counts the
number of devices running. Devices running as a result of a Hand command
from the HOAMode data member are NOT counted. All other running
devices (including those with active alarms) are.
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When the alternator is asked to turn on a new device it chooses the device
that has been off the longest. When asked to turn off a device it chooses the
device that has been on the longest.

The Advance command turns on one device and turns off another device.

Maximum Run Time and Delay Operation

The Maximum run time parameter specifies how long any one device can
be running. Each device has its own timer to ensure that this is enforced.
When one of these timers informs the alternator that its device has been
on for the maximum allowed time, the alternator executes a command
identical to the Advance command. Notice that there are two cases where
the maximum time limit is not enforced strictly. One of them is when you
have turned on a device via the HOAmode data member. (Its operation is
discussed in the next section.) The other is when it conflicts with the
operation of the Delay between device starts feature.

Delay between device starts is specified as a parameter, and limits how
often the alternator can turn on devices. An example of the operation of the
Delay between device starts would be beginning with a new alternator that
has none of the devices on. You issue a command using the Command data
member of 3. If the delay feature is in use, the alternator sends three ON
requests separated by the amount of time specified by Delay between
device starts.

Hand-0ff-Auto Modes

The HOAmode data member gives the user direct control over each
device. The integer value of this numeric data member corresponds to

an operating mode. (See Table 2-5.) When the HOAmode data member is
in Auto mode (as it is by default if you never connect anything to this data
member) it is subject to the commands of the alternator. Its DeviceConnect
data member will be high to signify that the alternator recognizes it. When
you select Hand mode, two things happen: The device is disconnected and
is sent an on request. Similarly in Off mode the device is disconnected and
requested off. In these two modes, the alternator does not recognize or
request anything of these devices. If you select Auto mode again, the device
is reconnected.
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Table 2-5. HOA Modes

HOA mode Integer
Hand 1
Off 2
Auto 3

Elapsed Time, Run Time, and Reset

The Elapsed Time data member keeps track of how long a particular device
has been on since its last reset (or since it was created). Its value is in days,
so by viewing it through a numeric expression you may select any time
format.

The RunTime data member keeps track of how long a particular device
has been on continuously. Its value is in days, so by viewing it through a
numeric expression you may select any time format.

The Reset data member is used to reset ElapsedTime.

Alternator Status Messages

Not responding to on request

A device that was sent an ON request via the DeviceRequest data member
did not respond that it had in fact turned on. The alternator attempts to turn
it on again when its turn comes and the alarm remains active until the
device responds properly to an alternator command.

Not responding to off request

A device that was sent an OFF request via the DeviceRequest data member
did not respond that it had in fact turned off. The alternator attempts to turn
it off again when its turn comes and the alarm remains active until the
device responds properly to an alternator command.

Turned on unexpectedly

A device that was previously off and that the alternator expected to remain
off turned on without reason. The alternator attempts to turn it off when its
turn comes, and the alarm remains active until the device responds properly
to an alternator command.
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Turned off unexpectedly
A device that was previously on and that the alternator expected to remain
on turned off without reason. The alternator attempts to turn it on when its
turn comes, and the alarm remains active until the device responds properly
to an alternator command.

Not responding to HOA command

A device did not respond properly to a command from the HOAmode data
member. The alternator attempts to request it when its turn comes, and the
alarm remains active until the device responds properly to an alternator
command.
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Animator

The Animator object class provides full graphical animation including
horizontal and vertical motion, dynamic resizing and visibility, dynamic
symbol sequencing and programmable color changes.

When you first create an animator object, the Select graphic dialog box
appears.

Select graphic

11 Arrows
I_1 Conveyor
I_1] Demo
|_1 Hoppers
I_1 Indicatr
-1 Meters
-1 Misc

-1 Mizers
I_1 Motors
I_1 Pipes
I_1 Pumps
|- Switches
I_1 Spstem
I_1 Tanks
I_1 Valves

N

MizchHorse. bmp

Trangparent pizel:
b IU Y ID

=1

0
M k\\\\\\\\{: LialSl

\\\‘ |
N\ (B

A\
N\

Cancel | Help

Figure 2-6. Select Graphic Dialog Box

Select the graphic you want to animate. To animate colors, you must select
a Windows Metafile (.wmf). A moving animation must have the series of
images you want to animate arranged in a single bitmap so that each cell of
the animation can be defined by a grid of rows and columns.

Lookout Object Reference Manual
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To create a moving animation, select the Animation name.

Create Animator Object EHE

Color  Animation |

Tag: IAnimator‘I

[:Mlook4hgraphicgiMisci\Horze. brp

100% Size [in pixels]:

Width Height

S

K= IHorizontaIF’ot

W= IVerticaIF’ot

Size = ISizeF’ot

Wisible = [visibilitySwitch

Cel/Rate = Fows Columnis

Filrnztrip:
|7 & Cel ¢ Rate[cels/zec) Brp Grid

|RatePot |5 Jn

QK I Cancel | Help |

Figure 2-7. Animator Definition Parameters Dialog Box, Animation Tab

The graphic file you select determines what images appear on the screen.
You delineate the images in a bitmap graphic by dividing it into a grid of
Rows and Columns. In the preceding illustration, the single column is

48 pixels Wide and each row is 28 pixels High. Conceivably, the grid could
consist of 32,000 cells. 100 cells would be more practical.

Each grid cell is a filmstrip image. Internally, the Animator assigns a cell
number to each image. It normally plays the filmstrip by progressing from
left to right and top to bottom, from the lowest cell number to the highest
cell number.

The Rate (cells/sec) selection you use to specify a frequency at which the
Animator progresses from one cell image to the next. The rate value can be
positive or negative and can range from 0.0000005 (one frame every
23.148 days) to 100 frames per second.
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Color Animation

Lookout Object Reference Manual

If the rate value is negative, the Animator plays the filmstrip backwards,
starting at the last cell.

You can use the Cell selection in the definition dialog box to identify a
particular cell number to display. For example, you might use this selection
to display a specific image when a PLC register is equal to a particular
value. This is similar to the multistate object, but can provide many more
states, depending on the number of cells in the bitmap.

The X and Y parameters specify the horizontal and vertical position of the
image, respectively. These numeric parameters range from 0 to 100, and
together provide the X-Y position of the image as a percent of the Animator
dimension on a control panel.

Size is a numeric parameter that ranges from 0 to 100 percent, where
100 percent is the full size of a single cell as specified by W and H.

Visible is a logical parameter that causes to the image to appear when it
goes true and disappear when it goes false.

To create color changes programmatically, select the Color tab.

With this option, you can set the color map on a . wmf graphic using a series
of five logical conditions and a default state. If no condition is true, the
default state (or color map) is imposed.

You can choose a custom color map by clicking on the color sample
associated with each logical condition. You can then select any color from
the palette available on your computer.
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Select the Show Original Colors box if you want the original color map of
the . wmf file to be imposed for that condition.

Create Animator Object EHE

Calar | Animation I

Gray Proximity

Proximity of the ariginal color to gray
necessary before it will be changed
ta the new colar.

Original Colar Show

Original Colors
= l -
Elseif= | Il -
Elseif= | [ | m
Elseif= | I =
Elseif= | l -
Else - r

QK I Cancel | Help |

Figure 2-8. Animator Definition Parameters Dialog Box, Color Tab

Gray Proximity determines the color saturation point at which the selected
color replaces an original color. When this parameter is set to 0, most colors
change. When this parameter is set to 100, most colors will not change. You
can test the effects of this setting by putting your cursor over the color
button and observing the change in the graphic displayed in the dialog box
window.

Notice that the if and else if statements are evaluated in sequence. If several
conditional expressions are true at once, Multistate displays the graphic
associated with the first true expression.

For instance, if your If parameters use less-than comparisons, such as
PumpSpeed<50, the following Else if parameter must have a larger
comparison value, such as PumpSpeed<75. If you use a smaller
comparison value, such as PumpSpeed<25, the color change will not take
place. In other words, the comparison values must be used from smallest to
largest.
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In the same way, if you are using greater-than comparisons, such as
PumpSpeed>50, you must list your comparison values from largest to
smallest, so that the next Else If parameter would have to be something like
PumpSpeed>25.

Put If parameters using equality, such as PumpSpeed=>50, before

parameters using inequalities.

A few minutes experimentation should help you understand the interactions

of the color choice conditions.

Animator Data Members

Table 2-6. Animator Data Members

Data Member

Type

Read

Write

Description

none

Animator objects do not have data

members

Comments Consider using an Integral object instead of a Counter/Pulse combination
when trying to achieve smooth animation.

Related Objects DialGauge, Gauge, Multistate, Pipe, Spinner

Lookout Object Reference Manual
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Average actively calculates the average value of Data over time. Average
is only active when the Enable expression is true and resets to zero when
the Reset expression transitions from off to on. Average also maintains an
array of up to 35 previous averaged values. If Enable is left blank, the
object always actively calculates the average.

Mame: IW
[rata = ||
Reset = I
Enable =
QK | Cancel | Help |

Figure 2-9. Average Definition Parameters Dialog Box

Data is a numeric expression while Reset and Enable are logical
expressions.

Average Data Members

Table 2-7. Average Data Members

Data Members

Type Read | Write Description

(implicit)

numeric yes no Current average calculated since the
most recent Reset signal. Updated
approximately once per second.

1-35

numeric yes no Previous average values. Signal 1 is
the most recent prior average since the
Reset signal went high.

DataReset

logical no yes Upon transition from FALSE to
TRUE, resets to zero all data
members—including the current
average and all previous averages.
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Comments The Reset expression could be a regular pulse interval created by a
TimeOfxxxx timer, so that the pulse is synchronized to the top of the hour or day. For
example, if you want to calculate the daily average flow rate, use the output signal
from a TimeOfDay timer or a daily Spreadsheet object to reset the average calculation
at the beginning of each day. If you want to calculate the average flow rate only when
a pump is running, use the input signal from the pump motor relay in the Enable
parameter.

Related Objects Minimum, Maximum, Sample
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Counter

Counter counts the number of times that the Count expression transitions
from off to on. The digital display shows the number of pulses counted so
far, and is updated approximately once per second—however, it can
receive and count multiple pulses within a given second. The counter can
count to just under 4,503,600,000,000,000 or 142,710 years worth of pulses
at one pulse per second. When the Reset expression transitions from off to
on, the counter resets to zero.

Create counter: E

QK | Cancel | Help |

Figure 2-10. Counter Definition Parameters Dialog Box

Both Count and Reset are logical expressions.

Counter Data Members

Table 2-8. Counter Data Members

Data Member Type Read | Write Description

(implicit) numeric yes no numeric total of pulse count

Comments You should not use Counters to count external pulse signals that cycle
more often than about once per second. For higher counting speeds, use the
accumulator capabilities built into your PLC.

Related Objects Accumulator, Integral

© National Instruments Corporation 2-23 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

DataTable

DataTables are used in the following applications:
e Multiplexing various data sources into a single display template.

* Importing or exporting large quantities of data to other applications
using DDE. (Unlike the DdeTable, the DataTable provides
bidirectional DDE communications. See DdeTable.)

¢ Networking multiple Lookout nodes (see Chapter 5, Networking, in
the Lookout Developer’s Manual).

A DataTable contains a matrix of rows and columns, much like a
spreadsheet. Each column is represented by a letter (A — IV). Each row

is represented by a number (1 — 1,000). Letter-number combinations
represent intersections of rows and columns. Such intersections are called
cells. Any given cell contains a value. A cell value can be numeric, logical,
or textual.

@ Note DataTables are advanced tools that require a mastery of Lookout object databases.
Make sure you understand editing, connecting to, and using object databases and aliases
before creating a DataTable object. See Chapter 4, Using Lookout, and Chapter 5,
Developer Tour, in the Getting Started with Lookout manual for more information on
object databases.

The following dialog box appears when you create a DataTable:

Create table E
M ame: ITabIe‘I
T able location r— |mport/E xport
& Local File Type: IXLS 'l Alarm priority: IS
" DDE -
" Clear table if impart eror
SEnyiGe: I
Tl I Filename =
GHE I"tblsmp.-"xls'1

IEerm: I

Security level: ID ¥ Log events

QK I Eancell Help |

Figure 2-11. DataTable Definition Parameters Dialog Box
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Specify DDE parameters if you want to use the DataTable to exchange
large quantities of data from an external source (such as Excel)
continuously, with both Lookout and the other program running.

See Chapter 6, Dynamic Data Exchange, of the Lookout Developer’s
Manual for more information on DDE connections to other programs.

Specify Local if you are using the DataTable to import or export data from
Lookout into or out of a static file. Also specify Local if you are using the
DataTable to multiplex various signals into a single display or graphic
template.

To exchange data with another DataTable running in another Lookout
process, you can use ordinary Lookout connections.

The export and import data members control the transfer of data between
Lookout and a Microsoft Excel spreadsheet. The spreadsheet filename
must be entered in the Import/Export section of the Create table
dialog box.

@ Note The data table import and export data members only work with Microsoft Excel
Version 4 at this time. This feature does not work with Excel Version 5 or greater.

Instead of entering a file name in the Import/Export dialog box, you can
enter a Lookout expression in the Filename field. You can then import and
export different files using a switch setting, a text entry box, or some other
expression input. If something goes wrong with the transfer of data,
including data corruption, Lookout reports an alarm.

Click on the Clear table if import error checkbox to clear the DataTable
before importing either from a spreadsheet or an ODBC database. This only
affects what happens if there is an error during the import. If there are no
errors during the import, the imported data always replaces the old data in
the table. However, if the checkbox is selected, the DataTable is always
cleared before starting an import, so that, if an error occurs, the DataTable
is left empty. If the checkbox is not checked and an error occurs, the old
data is left in the table.
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Create table E
M ame: |Table1
Table location — Import/E spart
@ Lacal File Type: I 'l Alarm priority: IE_
" DDE .
™ Clear table if impart erar
SEmne; |
: Connect Sting =
Tapie: I

i I SOL command =

Security level: ID ¥ Log events

0K I Cancell Help |

Figure 2-12. DataTable Definition Parameters Dialog Box; Import from ODBC Database

The Connect String= field specifies the DataSource Name (DSN) as well
as any other parameters needed by the ODBC driver to make the connection
to your chosen data source.

The SQL command= field is where you enter the SQL string you want to
pass to the ODBC driver. See the SqlExec object for more information
about using SQL queries in Lookout.

Use the Clear table if import error checkbox to clear the DataTable
before importing either from an ODBC database or a spreadsheet. This only
affects what happens if there is an error during the import. If there are no
errors during the import, the imported data always replaces the old data in
the table. However, if the checkbox is selected, the DataTable is always
cleared before starting an import, so that, if an error occurs, the DataTables
left empty. If the checkbox is not checked and an error occurs, the old data
is left in the table.

Multiplexing Displays and Graphics

Lookout Object Reference Manual

You can use DataTables to multiplex signals into a single control panel,
used as a template. For instance, assume you have nine identical pump
stations. At each site you have a single PLC monitoring the pressure, flow
rate, and status of two pumps. You are also controlling an analog output
with an operator setpoint from Lookout. Instead of developing nine
identical control panels in Lookout, you can build just one panel and
multiplex the signals from the nine sites into a single set of graphics.
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The following figure is a graphical representation of the connections for a
possible DataTable.

A B C D E F
1 |Sitel FLC1 press FLCT flow FLCT pmp1  |PLC1 pmp2
2 |Site2 FLCZ press PLCZ flow la) dg, FLCZ pmp1  |PLCZ2 pmp2
3 |Sited FLC3 press FPLC3 flow % ’60 FLC3 pmp1  |PLC3 pmp2
4 |Sited FLC4 press PLCA flow 3,‘ e FLC4 pmp1  |PLC4 pmp2
5 |Sited FLCS press PLCS flow é FLCS pmp1  |PLCS pmp2
6 |Site FLCE press PLCE flow % FLCE pmp1  |PLCE pmp2
7 |Site7 FLCT press PLCT flow FLCY pmp1  |PLCT pmp2
8 |Sited FLCE press FPLCE flow FLCE pmp1  |PLCE pmp2
9 [Sited PLCY press PLCAO flows PLCO pmp1  |FPLCY. pmp2
Figure 2-13. Graphical Representation of a DataTable Showing Connections
@ Note At this time there is no actual view in Lookout for you to see this table. It is a

representation, not a screen capture of a Lookout dialog box or display element.

Each row of the table is connected to the site name, the data you want to
keep track of from the PLC at that site, and a place for the operator setpoint
data for that site.

Notice the names of the nine PLCs (P1.Cc1, PLC2...). Each value has an alias
(press, £low, pmpl, pmp2). Each cell represents a connection made from
that PLC output to the that cell of the DataTable.

The open column D represents the connection of a single Pot object called
Setpoint to the column—not to individual cells. This way Lookout only
changes the value of a cell in column D when that particular row has been
made active. You connect the individual cells in column D (D1 through D9)
to the correct holding registers (outputs) on the respective PLCs. For
example, Tablel.D1 would be connected to the appropriate data member
of PLC1 — Tablel.D2 to the appropriate data member of PLC2, and so
on. In other words, when you intend to multiplex signals to a panel through
a data table connect inputs from a PLC or RTU to individual cells. Connect
operator setpoints (outputs) to columns.

© National Instruments Corporation 2-27 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

DataTable Example

To practice using a DataTable, you can create a PLC simulator as shown in
the following illustration. You can use a separate control panel for each
PLC output simulator, or place all the objects you make on one panel.

Site1Pressure
(simulates B
PLC1.press)

&— —— pumpi_1 (simulates PLC1.pmp1)
?slti(;:uii\(::s &—— pump1_2 (simulates PLC1.pmp2)
PLC1.flow)

@ PLC1 M= 3

Setpoint indicator
(operator input)

\

Lookout Object Reference Manual

Use two slider pots as your pressure and flow outputs, and two switches as
the on/off indicators for pumps one and two. You can use the dial gauge at
the bottom to check the operator input, Setpoint. Instead of connecting
the cells of your data table to PLC outputs, you connect directly to the
Lookout objects, named after the outputs for clarity.

You should create at least three sets of PLC input/output simulators. The
following example refers to the 9 PLCs mentioned in the Multiplexing
Displays and Graphics section, but you can explore using a data table
using 2 or 3 simulators.

Connect specific DataTable cells from the D column to the Setpoint
indicator for each PLC simulator.
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After you have built your simulators, open a new Control Panel to use as
your display and create a DataTable. You will create the rest of the display

in a later step.

When it first appears, the DataTable contains the number 0. This indicates
the contents of cell Al. You can increase the size of the display window,
but you cannot show the entire array of data in the table. You can view the
contents of any cell in column A by clicking on the window when you are
in run mode. Selecting the contents of that cell activates that row of the
data table.

Enter text expressions into the cells of column A to act as your table index.
For example, enter the string "Site 1" asthe connection to your
DataTable A1 . txt data member. Connect the outputs of your PLC
simulators to the cells in the B, C, E, and F columns shown in the following
figure. You will connect an operator input to the entire column D, and than
later connect individual cells in the D column to your PLC simulators.

A B C D E F
1 |Site 1 Site1Pressure | Site1Flow pump1_1 |pumpl_2
2 |Site 2 Site?Pressure | Site2Flow pumpZ_1 |pump2_2
3 |Site 3 Site3Pressure | Site3Flow pump3_1 |pump3_2
4 |Site 4 SitedPressure | SitedFlow pumpd_ 1 |pumpd_2
5 |Site 5 SiteSPressure | SiteSFlow pumps_1 |pump5_2
6 |Site B SiteBPressure | SiteBFlow pumpé_1 |pumpb_2
7 |Site 7 Site7Pressure | Site7Flow pump?_1 |pump?_2
8 |Site 8 SiteBPressure | SiteSFlow pumpé_1 |pumps_2
9 |Site 9 Site9Pressure | Site9F low pumpg_1 |pump9_2

Connecting Signals to DataTables

To connect a value to a particular cell or column within a DataTable,
use the Object»Edit Connections... command. Select the specific data
member of the DataTable to be written, and identify the data member of
the source object.
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Connecting to Cells

The value from SitelPressure is numeric. To write the value of
SitelPressure into cell B1, connect the simulated output to B1—not
Bl.logical or Bl.txt. The Edit connection dialog box is shown in the
following illustration.

Tablel connections E
— Select member: :
writable: members: Eisting connections: St Db|ECL"|
% 1.1-1000.30 - AZ kst ;I
AT4.30 Ad bt
TSR
Alogical. 1V lagical 30 Adtat
y (oaea e gl A5 bt
A bt 14V .30 Y
% A11000 AT ket
A7 logical-¥1000. logical - ALkt
? #1.logica ogical x| ot

F
Accept |

Tablel.B1 = Site pressure

Existing numeric connection —IEIear

— Signals:
Tags:

Ir: IE paroikoz. dy.natinst. com

Path Mode: I Relative j

Contents [readable]: numeric

LlLdz

% Site2Pressure
<3 SiteIFlow
ity SitePressure

Paste | Sitel pressure Help |

3 Sitelpressure
<3 Site2Flow J

Figure 2-14. Edit Connections Dialog Box

After you establish a connection to a cell, the value within the cell changes
any time the expression changes. Any time the value of SitelPressure
changes, the value within cell B1 changes.
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Connecting to Columns

To connect the value of the Setpoint potentiometer to column D,
select D—not D. logical or D.txt—as shown in the following
illustration. As with the previous value, you use D because you are using
a numerical value. There is no number following the D because you are
connecting to a column, not a cell.

Tablel connections E

— Select member: :
writable: members: Eisting connections: St Db|ECL"|

7 AT b1 000t =]
" cursor-cursor 30

enable

executeS0L

export

import -

P
Accept |
Tablel.D = Setpaint
Existing numeric connection il

— Signals:
Tags: L3Pat  Path Mode: IHeIative j
In: IE paroikos. dy.natinst.com j Contents [readable]: numeric

-4ty pump3d_2
-4ty Setpaint
-ty Site1Flaw

-ty Sitelpressure
-ty Site2Flaw J

ity Site2Pressure
-ty SiteSFlaw

Quit |
Paste | Setpaint Help |

Figure 2-15. Edit Connections Dialog Box

Once a connection to a column is established, the value within the cell at
the currently selected row changes when the expression changes. So, if you
activate row 4 and change the value of Setpoint changes, the value within
cell D4 changes. No other cells are affected until you move the cursor to
activate another row and the operator adjusts the pot.
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Reading a Cell Value Back to a Lookout Object

When you connect the display panel potentiometer called Setpoint to
Tablel.D, you should configure your pot with the appropriate Remote
parameter to ensure that it automatically adjusts to track the value in any
cell (within the specified column) when the cursor moves to a new row.

M ame: IF'ot‘I
Minirriurm: ID
I awimurn: I‘IDD

Resolution: |1
— Position source
 Local

& Femate
’VUHL = I\\paroikos\tablesamp\T ablel.D

= DDE

SEnyiGe: I
Tapie: I
IEerm: I

Contral security level: ID V Logevents

Cancel | Help |
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The Display Panel

Now that your DataTable (called Tablel) is complete, you can return to
your display panel (where you placed the DataTable object initially) and
begin to build a single control panel that allows you to multiplex the data
from your PLCs. A sample panel is shown in the following illustration.

 Control Panel

Pressure Setpoint

Table1.E.logical

Table1.B
Table1.Flogical
Table1.B Table1 display
(no connection
necessary)
Table1.C Potentiometer connected to Table1.D
(Column D)

Instead of using expressions that reference the actual values from your
driver objects to display values, use the column names from Tablel. For
instance, the bar graph and numeric readout for Pressure both represent the
expression Tablel.B. The actual value for Tablel . B depends on the what
row is currently active in the DataTable. In the illustration row 1 is active,
so all the expressions return the value in their respective columns at row 4.
The callouts in the picture indicate how the control panel was developed.
All are Lookout expressions except the Pot and the DataTable, which are
displayable objects.
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Operating Your Mu

Itiplexed Panel

The plate in bottom right corner of the control panel is the DataTable object
(Tablel). To view a different site with the control panel (that is, to activate
a different row, thereby selecting a different PLC), click on Tablel and the
following dialog box should appear.

Site 3
Site 4
Site b
Site 6
Site 7
Site §
Site 9

Tablel | ]
ISite1

EreyiEus |

Mext
This list box gets the row

names from Column A
in the Data Table

Cancel |

DataTable Cursors
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By selecting a site, you connect your control panel to the PLC at that site.
This is referred to as moving the cursor to that row.

The cursor is a DataTable pointer that you can move from row to row to
activate the values in the cells of that row. There are several methods for
controlling the location of the cursor:

*  Connect a numeric expression to the cursor data member. A typical
example would be to connect a potentiometer (minimum = 1,
maximum = the number of rows in table, resolution = 1) to the cursor.

*  Connect logical expressions to appropriate row numbers. A typical
example would be to create a pushbutton for every row and then
connect them to their respective row numbers.
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e Use the display (list box) built into the DataTable object. A typical
example was described previously where you connected text values to
cells in column A and then displayed the table as a plate.

The following example provides a graphical representation of a DataTable
(called Tablel) showing typical values within its many cells. You can
create a multiplex effect in Lookout by referencing column names and then
selecting the row with the information you want to use. If you reference
column names (instead of individual cells), the DataTable outputs only the
values within the currently selected row. If you reference individual cells,
the DataTable outputs the current value within the cell—no matter where
the cursor is.

A B C F
1 |Site 1 540 0 1
2 |k 2 0 1
3 |Site 3 57.3 480 78 0 1
4 |Site 4 57.8 410 51 1 1
5 |Site 5 51.8 560 92 1 0
6 |Site 6 88.3 490 40 0 1
7 |Site 7 79.4 530 63 1 0
8 |Site 8 921 520 71 1 0
9 |Site 9 59.9 550 62 0 1
Outputs = Site2 77.9 460 78 0 1

Figure 2-16. DataTable with Cursor at Row 2 and Corresponding Outputs

© National Instruments Corporation
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The value of cell B2 is currently 77.9. Therefore, the Tablel.B data
member is also 77.9. If you move the cursor to row 9, the value of
Tablel.B changes to 59.9, as shown.

A B C D E F
1 |Site 1 67.8 540 0 1
2 |Site 2 779 460 0 1
3 |Site 3 57.3 480 0 1
4 |Site 4 57.8 410 1 1
5 |Site 5 51.8 560 1 0
6 |Site 6 883 490 0 1
7 |Site 7 794 530 1 0
8 |Site 8 92.1 520 1 0
9 550 0 1
Outputs = Site9 59.9 550 62 0 1
Figure 2-17. DataTable with Cursor at Row 9 and Corresponding Outputs
Using Multiple Cursors
The previous description assumes you are using just one cursor. But a
DataTable can have up to 20 cursors. Multiple cursors allow you to select
multiple rows at the same time. When using multiple cursors, you also
use multiple names for each column. For a given column, each name is
associated with a given cursor. If you are using two cursors in the previous
example (cursor and cursor. 2), you can reference the column name of
a given column as follows:
Table 2-9. Column Names
A B C D E F
cursor A.txt B C D E.logical Flogical
cursor.2 A.txt.2 B.2 C2 D.2 E.logical.2 Flogical.2

Lookout Object Reference Manual

Earlier, when you were using just one cursor, you connected the value of a
potentiometer called Setpoint to column D. Subsequently the value of
Setpoint was written to the cell at the row selected by the cursor. But
when there are multiple cursors, you have to select which cursor you are
writing to. Thus, depending on how you want your table to work, you might
connect the potentiometer to both Tablel.D and Tablel.D.2.
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Table 2-10. DataTable Data Members

Data Members

Type

Read

Write

Description

executeSQL

logical

no

yes

Imports data from an ODBC database
into the DataTable when value goes
high, using the connect string and
SQL command you enter in the
Create/modify DataTable dialog box.

(implicit)

DdeTable

no

no

Not displayable in Lookout, but it can
be referenced by a DDE link from
another application.

1.1-1000.20

logical

no

yes

Specifies row (1, 2, 3, ...1000) or
specifies row.cursor (for example,
24.2 is the selector for row 24,
cursor 2). Upon transition from false
to true, the specified cursor moves to
specified row.

A.1-1IV.20

numeric

yes

yes

Specifies column names (for
example, A, B, C...IV) or specifies
column names and associated cursor
numbers (such as, A.1,B.1, A.2, B.2,
and so on.)

Read—returns a numeric value from
the cell specified by the column and
currently selected row of the indicated
cursor.

Write—writes a numeric value into
the cell specified by the column and
currently selected row of the indicated
cursor.

© National Instruments Corporation
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Table 2-10. DataTable Data Members (Continued)

Data Members

Type

Read | Write

Description

Alogical.1 —
IV.logical.20

logical

yes yes

Specifies column names

(for example, A.logical, B.logical,
C.logical, ...IV.logical) or specifies
column names and associated cursor
numbers (such as, A.logical.l,
B.logical.1, A.logical.2, B.logical.2,
and so on.)

Read—returns a logical value from
the cell specified by the column and
currently selected row of the indicated
Cursor.

Write—writes a logical value into the
cell specified by the column and
currently selected row of the indicated
Cursor.

A.xt.l - IV.txt.20

text

yes yes

Specifies column names (for
example, A.txt, B. txt, C. txt, ...IV.
txt) or specifies column names and
associated cursor numbers (such as,
A.txt.1, B. txt.1, A. txt.2, B. txt.2, and
SO on.)

Read—returns a text value from the
cell specified by the column and
currently selected row of the indicated
cursor.

Write—writes a text value into the
cell specified by the column and
currently selected row of the indicated
Cursor.

Al -1V16384

numeric

yes yes

Specified cell interpreted as numeric
value

Al.logical
-IV16384.1ogical

logical

yes yes

Specified cell interpreted as logical
value

Al.txt -1V16384.txt

text

yes yes

Specified cell interpreted as text value

Lookout Object Reference Manual
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Table 2-10. DataTable Data Members (Continued)

Data Members

Type

Read

Write

Description

Cursor.1 — Cursor.20

numeric

yes

yes

Specifies the currently selected row of
the indicated cursor.

enable

logical

yes

yes

If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is on. The input is ignored for
non-DDE TextEntry objects.

export

logical

no

yes

When this input transitions from false
to true, the Lookout data table is
exported to the designated
spreadsheet file.

import

logical

no

yes

When this input transitions from false
to true, the Lookout data table imports
data from the designated spreadsheet.

Modified

logical

yes

no

Pulses TRUE when any cell value in
the DataTable changes.

Update

logical

yes

no

Pulses each time the cursor changes
rows. Often used to “call up” a control
panel.

Related Objects DdeTable, DdeLink
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DdeLink

DdeLink creates a unidirectional Dynamic Data Exchange (DDE) link to
another application. The other application could be running on the same
computer or on another computer over a network. DdeLink objects provide
an easy way to import remote values into Lookout. See Chapter 5, Dynamic
Data Exchange, in the Lookout Developer’s Manual for more information
on DDE. For each DdeLink object you define, Lookout creates a separate
link to the other application. If you need to import large quantities of data,
you should use the DdeTable or DataTable object. See DdeTable and
DataTable for more information.

DdeLinks on Same Computer

If you are importing values from another application running on the same
computer, your DDE parameters will look similar to the ones in the
following illustration.

Create DdeLink E

M ame: |DDE‘I

DDE p -
Service: lExceI—
Topic: W
Item: l”d—

QK | Cancel | Help |

Figure 2-18. DdeLink Definition Parameters Dialog Box (Same Computer)

Service specifies the application name, Topic specifies the file, and Item
points to the individual value (rlcl refers to the cell at row1, columnl.
Unfortunately, Excel does not support the more convenient Al cell
references with DDE).

DdeLinks to Remote Computer

If you are importing values from another application running on a remote
computer, your DDE parameters will look similar to the ones in the
following illustration.
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M ame: |DDE‘I

DDE p

Service: I\EomputerName\NDDE$
Tapic: IProcessFiIe$
Item: Iname

Help |

Figure 2-19. DdeLink Definition Parameters Dialog Box (Remote Computer)

Notice the differences in the Service, Topic, and Item parameters.

The backslashes (\\) and dollar signs ($) are standard requirements for
making network connections in Microsoft Windows. ComputerName
specifies the network name of the computer you are connecting to. If you
are connecting to a value in another Lookout application, ProcessFile is
the Lookout file name running on the remote computer, and Name refers to
the name you are linking to.

DdeLink Data Members

Table 2-11. DdeLink Data Members

Data Members Type Read | Write Description

(implicit) numeric yes no DDE link interpreted as numeric
value.

enable logical yes yes If TRUE (the default), enables DDE.
If FALSE, disables DDE. This input
is ignored for non-DDE TextEntry
objects.

hot logical yes no Status of DDE link.

logical logical yes no DDE link interpreted as logical value.

txt text yes no DDE link interpreted as text value.

Related Objects DdeTable, DataTable
© National Instruments Corporation 2-41 Lookout Object Reference Manual
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DdeTable

DdeTable creates a unidirectional Dynamic Data Exchange (DDE) link to
another application. The other application could be running on the same
computer or on another computer over a network. See Chapter 5, Dynamic
Data Exchange, in the Lookout Developer’s Manual for more information
on DDE. You can use DdeTable to import large quantities of data from
other applications. The table format is much more efficient at transferring
data than the Link format because a table can contain hundreds or even
thousands of data points that all share a single link. On the other hand, the
link format can only transfer a single value per link—and every link
requires a certain amount of CPU overhead. If you are only importing a
relatively small amount of data, you may find the DdeLink technique easier
to implement.

DdeTable on Same Computer

Lookout Object Reference Manual

If you are importing values from another application running on the same
computer, your DDE parameters will look similar to the ones in the
following figure.

Create DdeT able E

M ame: |DDE‘I

DDE p -
Service: lExceI—
Topic: W
Item: l”d—

QK | Cancel | Help |

Figure 2-20. DdeTable Definition Parameters Dialog Box (Same Computer)

Service specifies the application name, Topic typically specifies the file,
and Item specifies the particular data item name.

2-42 www.natinst.com



Chapter 2 Lookout System Objects

The following example shows an Excel spreadsheet with the highlighted
range named Data.

Data = Pressures

Flows Times

Ammonia

NG| N BN =

You can now display any value in the range Data with this Lookout
DdeTable object.

Select Insert»Expression... and then choose the DdeTable data member
corresponding to the Excel spreadsheet cell containing the value you want
to display. Make sure that the type of data member you select matches the
type data in the spreadsheet cell.

Insert expression E
|DDET. 41 bt
Dizplay Type: Itext 'l Path Mode: IHeIative j
— Signals:
Paste | DODET.AT kxt
IE paroikoz. dy.natinst. com j Contents:
L3 implicit
bE” 4116384
" % Allogicalv16384 logical
D7 A1 taV1E384 et
P8 enatle
W hat
DdeT able text

Cancel Help

Figure 2-21. Inserting a DdeTable Expression
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Notice the reference for the displayed item in the Lookout status bar.

_EI_-Lookoul - [Process1 =] - [Control Panel] M= 3

File Edit Options Alams  Window Bun  Help _|ﬁ||1|
Pressuresl

|osAo11:58 | Administrator |National Instrurnents Internal Use Only | = | = | 1 alarms

DdeTable to Remote Computer

Using the DdeTable object over a network is somewhat different from the
previous example.

Create DdeT able E
M ame: |DDE‘I
DDE p

Service: I\\EomputerName\NDDE$
Tapic: IProcessfiIe$
Item: [LocalT able

QK I Eancell Help |

Figure 2-22. DdeTable Definition Parameters Dialog Box (Remote Computer)

Notice the differences in the Service, Topic, and Item parameters.

The backslashes (\\) and dollar signs ($) are standard requirements for
making network connections in Windows. ComputerName specifies the
network name of the computer you are connecting to. If you are connecting
to a DdeTable or DataTable in another Lookout application, ProcessFile
is the Lookout file name running on the remote computer, and
LocalTablel refers to the DdeTable or DataTable object you are

linking to.
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DDETable Data Members

Table 2-12. DdeTable Data Members

Data Members Type Read | Write Description

(implicit) numeric yes no Cell Al interpreted as a numeric
value

Al -1V16384 numeric yes no Specified cell interpreted as a numeric
value

Al .logical — logical yes no Specified cell interpreted as a logical

IV16384.1ogical value

Al.txt —IV16384.txt text yes no Specified cell interpreted as a text
value

enable logical yes yes If TRUE (the default), enables DDE.
If FALSE, disables DDE. This input
is ignored for non-DDE TextEntry
objects.

hot logical yes no Status of DDE link

Related Objects DataTable, DdeLink
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DelayOff
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DelayOff is an adjustable delay timer. When On/off signal transitions
to off, the Timer delay begins to count down. At the end of the delay
countdown, the output signal turns off. On/off signal must remain off
during the time delay period for the output signal to turn off. The output
immediately turns on when the On/off signal turns on.

Timer delay can range from 0.0 seconds to several years, and the effective
resolution is 0.1 seconds over the entire range. The timer display digitally
shows the time delay remaining, and is updated approximately once per
second. If the On/off signal is high, the timer display shows on. If the
Timer delay period has expired, the display shows of£.

Mame: W

On/off signal = W
Timer delay = |U15—
Dizplay format: lm

Cancel | Help |

Figure 2-23. DelayOff Definition Parameters Dialog Box

The On/off signal is a logical expression while Timer delay is a numeric
expression. Normally, this is a simple time constant such as 0:20—twenty
seconds. See Numeric Data Members in Chapter 2, Introduction, of the
Getting Started with Lookout manual for information on entering time
constants.
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& Transparent

off

Cancel |

Font... |1DptAriaIEloId

DelayOff Data Members

Figure 2-24. DelayOff Display Parameters Dialog Box

Table 2-13. DelayOff Data Members

Data Member

Type

Read

Write

Description

(implicit)

logical

yes

no

Logical timer value

Comments

The DelayOff timer can prevent a pump from short-cycling.

Related Objects DelayOn, Interval, OneShot, Pot, TextEntry
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DelayOn

Lookout Object Reference Manual

DelayOn is an adjustable delay timer. When On/off signal transitions
to on, the Timer delay begins to count down. At the end of the delay
countdown, the output signal turns on. On/off signal must remain on
during the time delay period for the output signal to turn on. The output
immediately turns off when the On/off signal turns off.

Timer delay can range from 0.0 seconds to several years, and the effective
resolution is 0.1 seconds over the entire range. The timer display digitally
shows the time delay remaining and is updated approximately once per
second. The timer display shows of £ when the On/off signal is low. If the
Timer delay period has expired, the display shows on.

Create DelayOn timer: | ]
Ta: IPumpRun

On/off signal = IPumpSwitch

Timer delay = ID:15|

Display format: IMM:SS j

Ok I Cancel |

Figure 2-25. DelayOn Definition Parameters Dialog Box

The On/off signal is a logical expression while Timer delay is a numeric
expression. Normally, this is a simple time constant such as 0:20—twenty
seconds. See Numeric Data Members in Chapter 2, Introduction, of the
Getting Started with Lookout manual for information on entering time
constants.
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off

Cancel |
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Figure 2-26. DelayOn Display Parameters Dialog Box

DelayOn Data Members

Table 2-14. DelayOn Data Members

Data Member

Type Read | Write

Description

(implicit)

logical yes no

Logical timer value

Comments The DelayOn timer can be used to prevent pumps from cycling too often,
to allow one operation to complete before another begins, or to require a condition to
exist for a period of time before an alarm is activated.

Related Objects DelayOff, Interval, OneShot, Pot, TextEntry
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Derivative

Derivative can also be called a rate of change object—it calculates the rate
of change of the incoming numeric input signal. You can use this class to
calculate the rate at which a tank is filling or draining, or to convert a
changing totalized flow value into a flow rate. The output units are in Input
Units/Time Unit.

M ame: W
Input = ||
Update = I
Time unit: I
QK | Cancel | Help |

Figure 2-27. Derivative Definition Parameters Dialog Box

The previous example calculates the rate of change in the water level of a
tank. Lookout polls the RTU connected to the tank level transmitter every
5 minutes, so this example uses the RTU update data member as the Update
pulse for the Derivative object. Tanklevel is in feet and Time unit is

1 minute, so the output result is in feet per minute.

Input is the numeric expression you are monitoring for rate of change.

Update can be a logical expression or numeric constant. If you specify
Update as a numeric constant, it creates an internal pulse timer with a pulse
period of the specified time and a pulse duration of zero. See Numeric Data
Members in Chapter 2, Introduction, of the Getting Started with Lookout
manual for information on entering time constants. If you specify Update
as a logical variable, the variable should pulse at the frequency you want
to use.

The Update expression triggers the calculation of a new rate-of-change
based on the Input value at the prior Update, and the current Input value.
The current Input value is then stored as the prior Input value for the next
calculation. The Update period should be greater than the refresh rate of
the incoming signal; or if the Input is generated directly by external I/O,
the update data member generated by the PLC object should be used. If
the Update period is less than the Input refresh rate, the rate of change
calculation fluctuates erratically between zero and a high value.
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Time unit is a numeric expression used as the basis for unit time on the
Input signal. For instance, if the rate of change should be in feet per minute,
the Input signal would be feet, and Time unit would be one minute (entered
as 1:00). Typically the Time unit is one second (0:01), one minute (1:00),
one hour (1:00:00), or one day (1:00:00:00). However, you can specify any
unit, such as 5:23 (a rate of change in Input units per five minutes and

23 seconds).

Derivative Data Members

Table 2-15. Derivative Data Members

Data Member

Type Read | Write Description

(implicit)

numeric yes no Rate of change

Comments Derivative performs the inverse function of Integral—you can
theoretically run a signal through an Integral object and then a Derivative object
(or vice versa) and you would end up with the original signal. (Discretization of the
time calculations by the computer may cause the final and original signals to differ

somewhat).

It is important to consider the resolution of the process variable measured
by the PLC when determining the Update period for this object. For
instance, if a pressure transmitter connected to a PLC only has a resolution
of 0.5 psi and you want to measure rates down to 1 psi/minute, the Update
pulse must be greater than 30 seconds even if the PLC is polled once per
second (i.e., 0.5 psi/l psi/min. = 30 sec.). For this application, the Update
pulse should probably be about two minutes.

Related Objects /ntegral
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DialGauge

The DialGauge object class displays a numeric signal as a sweeping needle
on an analog gauge or dial.

M ame: lDiaI‘I—
Signal = IAirPressurel
Minirriurm: ID—

I awimurn: I‘IDD—

Dial needle p

Starting angle: 225 degrees clockwizse from vertical

Fiotational sweep: |2?D degrees clockwize
QK I Eancell Help |

Figure 2-28. DialGauge Definition Parameters Dialog Box

Signal is a numeric expression.

Starting angle indicates the position of the needle when the Signal is at its
Minimum value. As shown here, you specify the starting needle position
by counting the degrees clockwise from vertical.

00
270°
225°
Default
Starting 180°
Angle

Rotational sweep specifies the number of degrees clockwise that the
needle will rotate as the Signal approaches the Maximum value. As shown
in the diagram here, you count the Rotational sweep in degrees clockwise
from the Starting angle.
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o
2706 ﬂ
Starting
Angle
180°

After you specify the DialGauge definition parameters, Lookout presents a
display parameters dialog box, as shown here. You use this dialog box to
specify needle color, thickness, and length.

Display dial gauge | ]
Meedle colar:

0 ECEEN
HNENEENEN NEEE
Meedle thickness: |1 pixels(1-10)

MNeedle length: 100 %

oK | Cancel |

Figure 2-29. DialGauge Display Parameters Dialog Box

Needle thickness defines how wide your needle will be. Thickness can
range from one pixel (hairline) to 10 pixels wide.

Needle length specifies the length of the needle as a percent of the radius.
At 30 percent, for example, only the outer tip of the needle is visible—you
cannot see the part of the needle closest to the origin. At 100 percent, the
needle extends the full radius of the circle.
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30%

DialGauge Data Members

Table 2-16. DialGauge Data Members

Data Members Type Read | Write Description
(implicit) numeric yes no Current value of signal parameter
2 0w
40 &0

10 50
20 - 100

10 110

120

Comments The DialGauge object class only displays a needle. You may wish to
enhance it with a corresponding scale or dial face as shown. You can create a scale or
dial face by importing one from a graphics package. See Creating Custom Graphics in
Chapter 2, Graphics, in the Lookout Developer’s Manual for more information.

@ Note If you choose to import a scale or dial face from an external package, you should use
a bitmap instead of a metafile.This makes the display refresh cleaner when the needle
changes position.

Related Objects (expression), Gauge
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ElapsedTime is an elapsed time meter or “hour meter” that totals the
amount of time the Enable expression is on. If Enable is the logical
constant ON, the meter reflects the time since the process was started. If a
Reset expression is specified, the meter resets to zero the moment Reset
transitions from off to on. The display always shows the elapsed time, and
is updated approximately once per second.

Create Elapsed-Time Meter: E
Mame:  [ETM1
Enable = ||
Reset = I
QK | Cancel | Help |

Figure 2-30. ElapsedTime Definition Parameters Dialog Box

ElapsedTime Data Members

Table 2-17. ElapsedTime Data Members

Data Member

Type Read | Write Description

(implicit)

numeric yes no Total elapsed time—updated once per
second, while meter is running

Comments ElapsedTime meters are used primarily to record the amount of time that
individual pieces of equipment have been running. It is also straightforward to set up
an alarm that sounds when a particular device has been operating for a certain time and
needs routine servicing. The plant operator could then perform the service and reset

the ElapsedTime meter with a pushbutton.

ElapsedTime can also record the amount of time a particular device

is operated each day and you can record the resulting time to a daily
Spreadsheet which you can then use to automatically reset the meter
after the data is permanently recorded.
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Event is a flexible and powerful object class you can use to define event
messages that are triggered based on a user-defined logical expression.
Lookout logs such events to the Citadel database and you can subsequently
print and archive them. See Chapter 7, Logging Data and Events, in the
Lookout Developer’s Manual for more information on logging events.

M ame: IW
Trigger = IPLEPressure>1 a0
Trigger hi text = I"The water pressure just exceeded 150 P51
Trigger lo text = I"The water pressure just dipped below 150 PSI™
Cancel | Help |

Figure 2-31. Typical Settings for an Event

When the result of the Trigger logical expression transitions from FALSE
to TRUE, it logs the result of the Trigger hi text expression as an event in
the EVENT . DAT file. When the results of the Trigger expression transitions
from TRUE to FALSE, it logs the results of the Trigger lo text expression
as an event.

Event Data Members

Table 2-18. Event Data Members

Lookout Object Reference Manual

Data Member Type Read | Write Description
none — — — Event objects do not have data
members
Comments For each event logged, Lookout records the date and time, the name of the

user currently logged on, and the expression text.

Although event messages are shown for both Trigger hi text and Trigger
lo text, you do not have to include text in both fields.
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(expression)

Named expressions, shown as (expression)s, are flexible, powerful
real-time calculators. They create and calculate the result of
spreadsheet-style formulas that include a mixture of constants and signals
from other objects. There are over fifty built-in functions that you use in
expressions, including logical, mathematical, statistical, text and
trigonometric functions. See Chapter 2, Expressions, in the Lookout
Developer’s Manual for more information on expressions and expression
functions.

Named expressions can be short and simple, or extremely complex with
several signal inputs, function calls, and multiple levels of parentheses.
A single expression may incorporate text, logical, and numeric
calculations. The variable type returned by the outermost function or
operator in the expression determines the signal type generated by the

expression.
Tag: IF'ump1F|un
Expression =
IF'ump‘ISpeed.Act:‘I 0OF [HOA=3 AMD PumplMeutralZone below)
Cancel |
Figure 2-32. Create Expression Dialog Box
@ Note You typically use (expression) objects when you need to define a unique condition

that is used multiple times throughout your application.

When you define an (expression) object (as opposed to inserting an
intrinsic expression), you create a unique name for your expression and can
therefore reference the output signal generated from the expression in other
expressions or objects. Instead of defining the same expression in many
places, you create it one time and use its name any time you need this
expression.
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@ Note The expression may not express a condition.

Table 2-19. Expression Data Members

Data Member Type Read | Write Description
(implicit) numeric, yes no Value of expression. The variable type
logical, returned by the outermost function or
or text operator in the expression determines
the signal type generated by the
expression.
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Flipflop

Flipflop changes its logical output signal from on to off, or from off to on
when the Input signal goes high. The output signal does not change when
the signal goes low. Input is a logical expression.

Create Flipflop E
Mame: IFIiprop‘I
Input = I

QK | Cancel | Help |

Figure 2-33. Flipflop Definition Parameters Dialog Box

Flipflop Data Member

Table 2-20. Flipflop Data Member

Data Member Type Read | Write Description

(implicit) logical yes no Current state

Comments Flipflop can be used to alternate the operation of two pumps, or when
connected to a pushbutton, provides a pushbutton on/off control device.

Related Objects LatchGate
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Gauge

Gauge displays the Signal expression in digital or bar graph format. Gauge
display parameters change depending on the values of the Conditional
expressions. Gauge determines which colors to display based on the order
and current status of your conditional expressions. For instance, if several
conditional expressions are true at once, Gauge displays the color
associated with the first true expression.

You can use the Transparent background style with numeric expressions
and gauges displayed as bar graphs. This means you can have bar graphs
with transparent backgrounds.

Name:
Signal = I
Conditional expressions: Gauge colors:
[ D |
If=
! EEEEEE
: |
Else if =
! EEEEEE
Eleit= | |
o EEEEER
R T
R msnEn
Elze .
ENNEEEN
Flash when = I Fast
QK | Cancel | Help |

Figure 2-34. Gauge Definition Parameters Dialog Box
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Conditional expressions and Flash when are logical expressions while
Signal is a numeric expression. The Fast option instructs the Gauge to flash
faster when enabled than when disabled.

Display Gauge | ]

Background stle—— —Frame style——
Background color

oW I
....... l i F:Zitangle i+ Norluj

& Transparent

—Display Style —

- et o Eentered R
tinimum ID  Digital
haximum |1DD & Bar (up)

= Bar (down)
MNumetric farmat = Bar (right)
IGeneraI j = Bar (leff)

it |1DptAriaIEloId OK I Cancel

Figure 2-35. Gauge Display Parameters Dialog Box

Gauge Data Members

Table 2-21. Gauge Data Members

Data Member Type Read | Write Description

(implicit) numeric yes no Numeric value of Gauge

Comments You should use a Gauge object when you need a bar graph or digital
display to change colors and/or flash upon certain conditions. If you do not need either
of these capabilities, you should display a bar graph or digital value with the
Insert»Expression... command.
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Histogram

The Histogram object class is one of the Lookout Statistical Process
Control (SPC) tools and can play an important role in a Total Quality
Management (TQM) program. This object class displays the distribution
and/or relative distribution of a signal value. It shows the central tendency
and variability of the sampled data. It also calculates process capability
ratio (PCR), PCR confidence interval, mean, variance and standard
deviation.

Mame: IHistogram‘I

Sampled signal = ||

Sample tigger = I

Reset = I
— Bin setting

Murnber: IS

Minimurn = I

I awimum = I

— Categorize
& Al samples

" Most recentl zamples

LSL= |
usL = |

Confidence level: |95 % [90-995)

QK | Cancel | Help |

Figure 2-36. Histogram Definition Parameters Dialog Box

Sampled signal identifies the value that you are statistically monitoring.
Histogram reads and categorizes the Sampled signal any time Sample
trigger transitions from off to on.

You can either Categorize all samples since Reset last transitioned from
off to on, or you can Categorize a sliding window of the most recent
2 — 1000 samples.

Bin Settings define the Number of desired categories. The difference
between Minimum and Maximum determines the width of each bin or

category.

The settings for the following Histogram graph call for eight bins. Because
the difference between Minimum and Maximum is 80 and because there
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are eight bins, each class interval has a range of 10 (80/8 bins = 10). So bin,
contains sample values ranging from zero to less than 10; bin, contains
sample values ranging from 10 to less than 20, and so on.

This object always allocates two more bins than you request. These bins are
used for accumulating samples less than the Minimum and greater than the
Maximum. The lower bin is always data member £0. The upper bin is

fn+1, where n=Number in Bin Settings.

In the following example, Bin, (data member £0) contains all sample
values less than Minimum and bin9 contains all sample values greater than
or equal to Maximum.

200
175+
150 —
1254

bin 1

A0+
25
0
a

100 —
75—

fO

Actual Frequency Distribution

f2

4

5
f6 f7 {8

f9

T
10 20 30 40 50 6O 7O 8O 90 100

minimum

bin 8

maximum

Figure 2-37. Graph from Inserting Ten Numeric Expression Barcharts
(Data Members f0 through f9 as Shown) and Two Scales

LSL and USL identify the lower and upper specification limits. These
limits generally define the range of acceptable sample values. Histogram
uses LSL and USL to calculate the process capability ratios (PCR

and PCRk).

The Confidence level expresses the degree of certainty or probability that
the actual value of PCR (the process capability ratio) falls within the
confidence interval (that is, between PCRL and PCRU). A typical value is
95 percent. The lower the confidence level, the tighter the interval.
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@ Note Histogram does not have a display parameters dialog box. However, you can easily
display the results of its output signals by referencing them in expressions.

Histogram Data Members

Table 2-22. Histogram Data Members

Data Member

Type

Read

Write

Description

f0 — 201

numeric

yes

no

Frequency of sampled signal values
falling within the identified bin

LSL

numeric

yes

no

Lower specification limit

mean

numeric

yes

no

Average of sampled values, where
2
i=1

n

X =

PCR

numeric

yes

no

Process capability ratio measuring the
uniformity or variability of the
sampled signal using upper and lower
specification limits. This ratio
measures potential capability. If
standard deviation = 0, PCR = 0.
Otherwise

USL-LSL
60

PCR =

PCRk

numeric

yes

no

One-sided process capability ratio for
an off-center process. This ratio takes
process centering into account,
measuring actual capability.

- LSL USL—EQ
36’ 30

PCRy = min%x

PCRL

numeric

yes

no

Lower limit of the confidence interval

PCRU

numeric

yes

no

Upper limit of the confidence interval

rfO — rf201

numeric

yes

no

Relative frequency (percent) of
sampled signal values falling within
the identified bin
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Table 2-22. Histogram Data Members (Continued)

Data Member Type Read | Write Description
samples numeric yes no Number of sampled signal values
sdev numeric yes no Sample standard deviation, where
USL numeric yes no Upper specification limit
variance numeric yes no Sample variance, where
n
2
Z (i =)
g2 = =1
n—1

Comments The confidence interval is the range of values determined by the limits
PCRL and PCRU.

Related Objects Average, Maximum, Minimum, Sample, XBarR

Related Functions Avg, Max, Min, Stdev, Stdevp, Sum, Var, Varp
See Chapter 1, Expressions, of the Lookout Developer’s Manual for more information
on these functions.
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HyperTrend

A HyperTrend object displays a trend graph on a control panel. It plots any
number of logical and numeric trend lines.

HyperTrends provide instant access to both real-time and historical data in
a single graph. For each plot line, they combine both real-time and
historical data into a seamless, contiguous trace of data. See Citadel
Historical Database in Chapter 7, Logging Data and Events, in the
Lookout Developer’s Manual.

@ Note There has been an important change in the way Lookout logs data to the Citadel
database to be displayed on the HyperTrend object.

In Lookout 3.xx, creating a trend line in a HyperTrend object automatically logged the
requested data to the database.

In Lookout 4, you must select the Log to historical database option in the Edit Database
dialog box for any data you want to display in a HyperTrend object before you can display
the data. This is because logging must be configured in a Lookout Server process, while

trending is typi

cally done in a separate Lookout client process.

You can log information by connecting to a symbolic link, but only if the data source the
symbolic link represents has had the Log to historical database option selected.

Lookout Object Reference Manual

You can use HyperTrends to pan and zoom both the X axis and the Y axis,
enabling dynamic adjustment of the vertical and horizontal resolutions of
each plot line on the graph. Using this feature, you can, for example, zoom
into a particular area of focus on the trend.

The graph scrolls from right to left, plotting current, real-time signals at the
right end of the graph.

The icon in the upper left of the display accesses a menu you can use to
change the group of traces being plotted, activate the cursor, and start or
stop scrolling. The arrow-shaped buttons make it easy for you to scroll the
trend graph forward and back in time. It provides instant access to data that
has scrolled off the left end of the graph (that is, historical data stored in the
Citadel database).
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B R ) L

[ ] Change Group
Hyper Curzor
Start / Stop

The button bar includes scroll arrows, a cursor button, date, time, and a stop
and go light. Use the scroll arrows to move back and forth through time-the
bigger the arrow button you select, the further the trend jumps in time. The
scroll arrows also function much like a horizontal slider. Click on them and
slide the mouse left and right while holding down the mouse button. The
further you slide the cursor from dead center, the faster the trend scrolls in
that direction.

Use the date and time indicators to choose a specific month, day, year, hour,
minute, or second. If you click on the lower part of the hour, for example,
it jumps back in time by one hour.

If you click on the upper part of the hour, it jumps ahead by one hour.

It works the same way for month, day, year, minute and second.

The stop & go light on the button bar is either red or green. If the light is
green, it indicates the far right edge of the trend window displays the
current time.

When you scroll back in time or if you click on the light when it is green,
it changes to red, indicating that the trend is temporarily frozen in time. The
date and time appears in the button bar indicating the exact time at the far
right edge of the trend window. As you scroll back and forth through time,
the data and time changes accordingly.

If you click on the light when it is red, the trend jumps back to current time
and starts scrolling while plotting real-time values.

© National Instruments Corporation 2-67 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

@ Note The Citadel database continues to log data no matter what state the HyperTrend is
in. You do not lose any data when it is in "historical" mode (that is, when the HyperTrend

is not scrolling

Lookout Object Reference Manual

in real-time).

When you click on the cursor button, a vertical cursor bar appears in the
center of the graph along with an associated cursor dialog box. The dialog
box indicates the value of each trend line at the current location of the
cursor. As you drag the cursor bar left and right on the trend graph, the
values in the pop-up change to reflect the new cursor location.

You can select how the trend line values are shown by choosing a format
through the cursor control menu.

i HyperTrendl Cursor E
Time: IDBJD‘I /1993 12:40:14.3 ﬂ
Sparoikoz, dy.natingt comskiyServera avetorm. cozine wave 0 BBE

Find
( ﬂ ﬂlBreaka’Mina’Max |

Figure 2-38. HyperTrend Cursor Dialog Box

Time indicates the current location of the cursor bar. The increment and
decrement buttons beside the field move the cursor left and right in the
trend graph. Choose the size of the incremental move by clicking on the
desired portion of the date/time. The hour portion is selected in the previous
example, so each time you click on the increment or decrement button, the
cursor bar jumps ahead or back by an hour. It works the same way for any
portion of the date and time.

Use the Find combo box to search for a break in the trend line, a signal peak
or valley, or a specific value. For example, you can find the last instance in
which a process control limit value was exceeded. To find the last time a
trend line crossed a specific value, choose the desired trend line by clicking
on it in the list box, select Value in the Find combo box, enter the desired
value, and clock on the scroll back button.
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To create a hypertrend object, choose Object»Create or right-click on a
process in the object explorer and select New Object. Select HyperTrend.
The following dialog box appears.

Add [tem | Mame: IHyperTrend‘I | QK I Cancel | Help |

Expreszion | Type | Line Color | Min/hd ax/Poz/Hgt |

First you must create a group of trends. Double-click on the AddGroup
button. The following dialog box appears.

Edit Group E

Mame IF'ump Station 1

Timeling labels

Horizontal grid style——
Paper color :: EEI:::::; Maijor incremerts I‘]U
|:| . .. . & Huorizontal [zmal] (e rEnaete |2
HENENEEEEN BEEE o
Grid colar © Vertical [small]

|:|. .. . ()8 | Eancell
......... .... Trend Width ID:BD:DD ¥ Show Button bar

Configuring the group sets the appearance of the HyperTrend object when
it displays traces from that group. You can set different paper and grid
colors for different groups to help operators distinguish between them.

Give your group a name that clearly identifies it. Be sure to set the Trend
Width for the period of time you want under observation for that group.
Graphs may have a default width, or time span, of anywhere from two
seconds to four years. The default Trend Width in the example dialog box
indicates a time span of 1:00:00 or one hour. See Numeric Data Members
in Chapter 2, How Lookout Works, of the Getting Started with Lookout
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manual for more information on entering time constants. After creating the
HyperTrend object, you can make the trend width adjustable by connecting
a numeric signal to the TrendWidth data member.

Major increments specifies the number of heavy horizontal grid lines on
a trend graph. This value is independent of the range of any trend
expressions.

Minor increments specifies the number of light horizontal grid lines
between the major increment grid lines on a trend graph. This value is
independent of the range of any trend expressions.

After you create a group, you must add individual items. Right-click on the
group you want to add a trace to. Select Add Item (or click on the Add
Item button). The following dialog box appears.

Add Item E
URL = ||

Type Logical & Mumeric

Minirnum I awirnum
ID I‘I oo

Line color:

|
ENEEEE [ ]
()8 | Cancel |

Right-clicking in the URL field displays the object selection dialog box
covering all the registered computers running Lookout on your network.
Select the computer and process generating the value you want to display
on your HyperTrend chart. See the URLs section for more information on
this type of Lookout connection.

Minimum and Maximum set the scale for the trace on your display. If you
are charting a logical data member, position and height set the base display
line and the height of the trace from that point when your signal goes
TRUE. Minimum is the bottom of the graph while Maximum is the top of
the graph, regardless of the range of the expression. These settings create
an imaginary vertical scale and affect each expression independently.

For example, take two numeric expressions, both of which range from 0 to
50. Set the Minimum and Maximum to 0 and 100 on the first expression,
and -50 and 50 on the second. The first expression plots in the bottom half
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of the chart while the second expression plots in the top half of the chart,
even though they both fluctuate between 0 and 50.

. i i :
0 143745 143500 143515 143530 143545 143900 143915 143935

This figure shows the imaginary scale of the first expression
(where min. = 0 and max. = 100). Because the expression ranges from 0 to

50, it is plotted in the bottom half of the graph.
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143745 143500 143515 143530 143545 143900 143915 14395

This figure shows the imaginary scale of the second expression (where
min. = -50 and max. = 50). Because the expression ranges from 0 to 50, it is

plotted in the top half of the graph.
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When both expressions are entered on a single trend graph, you get the
following effect. Notice the custom scales at either end of the graph.

ey j
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If you select Logical for the expression type, the minimum and maximum
settings changes to Position and Height. These two values now represent a
number between 0% and 100%, and determine the baseline location of the
trend line and its unit height when the expression goes TRUE.

i e B el e Bl e B ool
HIL T 1 I 1 Ltk
15:01:30 15:02:00 15:02:30 15:03:00

Use Insert»Scale to label the values being charted according to your
minimum and maximum settings.

Comments HyperTrend objects access data from the Citadel database. Think of them
as windows into your historical database. See Chapter 5, Developer Tour in the Getting
Started with Lookout manual, and Chapter 7, Logging Data and Events, in the Lookout
Developer’s Manual, for more information on specifying a point to be logged to the

Citadel database.

HyperTrends are updated as quickly as once per second, depending on
screen resolution, the size of the graph, and the trend width setting.
Computers with slow display adapters may slow down considerably when
you display a large trend graph. On slower computers with slow display
cards (no graphics coprocessor), consider limiting the size of your
HyperTrends to less than one fourth the screen size.
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Table 2-23. HyperTrend Data Members

Data Members Type

Read | Write

Description

ActiveGroup numeric

yes yes

Sets which of the HyperTrend trace
groups is active.

Enable1- Enable 999 logical

yes yes

When TRUE, the identified trend line
is visible. When FALSE, the trend
line hidden. The default value is
TRUE. Trend lines are identified by
the group number followed by the
item number, so Enablel.2 would
refer to item 2 in group 1.

numeric

Height1 — Height999

yes yes

Specifies the amplitude or height of
the identified trend line (distance
from baseline) when the logical
expression goes TRUE. Height
should be between 2 and (100 minus
position). Trend lines are identified by
the group number followed by the
item number, so Height1.2 would
refer to item 2 in group 1.

Max1 — Max999 numeric

yes yes

Specifies the top of the graph for the
identified numeric trend line (the
value of the trended line when it is at
100 percent of the Y axis). Trend lines
are identified by the group number
followed by the item number, so
Max1.2 would refer to item 2 in
group 1.

Minl — Min999 numeric

yes yes

Specifies the bottom of the graph for
the identified numeric trend line (the
value of the trended line when it is at
zero percent of the Y axis). Trend
lines are identified by the group
number followed by the item number,
so Min1.2 would refer to item 2 in
group 1.

© National Instruments Corporation

2-73

Lookout Object Reference Manual



Chapter 2 Lookout System Objects

Table 2-23

. HyperTrend Data Members (Continued)

Data Members

Type

Read

Write

Description

Pos1 — Pos999

numeric

yes

yes

Specifies the baseline location of the
identified logical trend line. Baseline
position should range should be 1-98.
(posl is associated with trend line 1)
Trend lines are identified by the group
number followed by the item number,
so Pos1.2 would refer to item 2 in
group 1.

TrendWidth

numeric

yes

yes

Specifies the span of time that the X
axis covers.

UseButtonBar

logical

yes

yes

When TRUE, the HyperTrend button
bar becomes visible on the control
panel. When FALSE, it is invisible.
The default value is TRUE.

Visible

logical

yes

yes

When TRUE, the HyperTrend
becomes visible on the control panel.
When FALSE, it is invisible. The
default value is TRUE.

Converting Lookout 3. xx HyperTrends to Lookout 4

If you convert a process created in a version of Lookout earlier than 4.0
which contains a HyperTrend object that is displaying a complex
expression, Lookout automatically creates a named (expression) for the
converted HyperTrend to chart. To maintain your legacy HyperTrend
objects you must use or replace these (expression) objects.

Lookout Object Reference Manual

2-74

www.natinst.com




Chapter 2 Lookout System Objects

Integral

Integral is a totalizer—it totals the numeric Input signal. This class is
typically used to total a measured flow rate.

Mame: W
Input = ||
Update = I
Time unit: I
Reset = I
()8 | Cancel | Help |

Figure 2-39. Integral Definition Parameters Dialog Box
Input is the numeric expression that you want to totalize or integrate.

Update can be a logical expression or numeric constant. If you specify
Update as a numeric constant, it creates an internal Pulse timer with a pulse
period of the specified time and a pulse duration of zero. See Numeric Data
Members in Chapter 2, How Lookout Works, of the Getting Started with
Lookout manual for information on entering time constants. If you specify
Update as a logical variable, the variable should pulse at the desired
frequency.

The Update expression extrapolates an interim total based on the current
total and the most recent Input value. The interim total is then sent out as
the output. The total is calculated using the trapezoidal numeric integration
technique, and the total is corrected any time the incoming signal is
refreshed.

Time unit is a numeric expression used as the basis for unit time on the
Input signal. For instance, if the Input rate is in units of gallons per minute,
the Time unit should be entered as one minute (1:00) so the totalized flow
is in gallons. Typically the Time unit is one second (0:01), one minute
(1:00), one hour (1:00:00), or one day (1:00:00:00). However, you can
specify any unit, such as 5:23 (a rate of change in Input units per five
minutes and 23 seconds).

Reset is a logical expression that resets the totalizer value to zero upon
transition from OFF to ON.
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@ Note Integral does not have a display parameters dialog box. You can easily display the
result of the Integral output signal by referencing its data member in an expression.

Integral Data Members

Table 2-24. Integral Data Members

Data Member

Type

Read

Write

Description

(implicit)

numeric

yes

no

Totalized value

Comments The Update pulse forces the calculated total to continue changing between
Input signal updates. For example, if a remote RTU that is monitoring a flow rate is

polled every ten minutes, the Update pulse could be set at five seconds so the operator
can watch the totalized flow continue to change on the screen as an extrapolated value.
The corrected totalized value is calculated any time the Input signal refreshes—in this
case, every ten minutes.

If totalized values are logged to a spreadsheet on a daily basis, for example,
and the total should be reset at the end of every day, use the update pulse
generated by the Spreadsheet object to reset the total—this guarantees that
the total is recorded before the totalizer is reset. The example on the
previous page totalizes the hourly flow for permanent data logging by a
spreadsheet object named HourlySheet. Notice that the spreadsheet update
pulse HourlySheet . logged is used to reset the totalizer.

Related Objects Accumulator, Counter, Derivative
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Interpolate

The Interpolate object class performs a linear interpolation between a set
of X,Y coordinate pairs to determine a corresponding output for any given
input. A single Interpolate object can have up to 1,000 coordinate pairs.
Although this object class can be used for any calculation requiring linear
interpolation, it is especially useful for tank strapping applications.

Create interpolate object: E
Name: lTank‘I— Entry Inputs(x] Ouputs(y]
a 5 3
MNewenty——————— | 1 4 4
Inpt{s): I 2 2 3
3 1 2
Ouput(y]: I 4 1] 1

Dete |

Mew entry |

5 entries
Input farmat: Input(x] multiplier =
I General =
Olutput format;: Olutput{y] multiplier =
I General j I

Sort order [inputs)
' Increasing ak. | Cancel | Help |
& Decreasing Mew =.p point added.

Figure 2-40. Interpolate Definition Parameters Dialog Box

The following diagram visually depicts the basic functionality of the
Interpolate object, and the set of coordinate pairs as entered.

Based on this graphical representation of the object, you can readily see
how different X inputs give corresponding Y outputs. Also notice that an
X input of 5.5 yields a Y output of 2.5—even though the last coordinate
pair was (5,3). Lookout uses straight line extrapolation at both end points
with a slope determined by the last two coordinate pairs.
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Outputs (Y)

(4,4)4—— X,Y Coordinate Pairs

.......................................................

\

(0,1)

1 2 e

Inputs (X)

The New entry parameter fields enable adding, modifying and deleting
Input(x) and Output(y) coordinate pairs. Input(x) and Output(y) are
numeric parameters.

Input format and Output format define the numeric format of the
Input(x) and Output(y) coordinate pairs displayed in the definition
dialog box.

Sort order (inputs) specifies whether the dialog box lists X,Y coordinate
pairs in Increasing or Decreasing order. The sort order has no bearing on
output calculations or the values of the readable data members.

The Input(x) multiplier and the Output(y) multiplier are numeric
expressions. These two parameters are useful for the more advanced
calculations often found in tank strapping applications. They can be used
for such things as temperature, pressure, density, and product correction
factors. As their names imply, Lookout multiplies the corresponding
Input/Output by the respective multiplier. If you specify an Input(x)
multiplier, the object multiplies the input by the appropriate multiplier
before calculating an interpolated output. If you specify an Output(y)
multiplier, the object multiplies an interim output by the appropriate
multiplier before calculating the final output value.
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Step through a simple example using the preceding diagram to clarify this
concept. Use an Input(x) multiplier of 1.5, and a Output(y) multiplier
of 2. Assume the variable input is currently 2. The object first multiplies
2 by 1.5 to produce 3. It then uses the coordinate pairs to find the
appropriate output value for an input of 3. As you can see, the interim
output would be 3.5. Because you specified an output multiplier, it must
first multiply 3.5 by 2 to give a final output of 7.

Situations may arise where you want multiple inputs going through a single
Interpolate object, giving multiple respective outputs. Instead of creating an
Interpolate object for each input, Lookout can connect multiple inputs to a
single object and read their corresponding outputs. The inputs are writable
data members (X0 — X999). For each input, there is a corresponding
readable output (YO — Y999 respectively). The following diagram shows a
numeric signal called TankLevel connected to an input, X0.

Tank1 connections E
— Select member:
writable: members: Eisting connections: St obiect...l
T w0939
% w039

Select | |><g
Tank1.%0 = TankLevel -
New numetic connection Clear |

— Signals:
Tags: Pot Path Mode: IHeIative j
In: IE paroikos. dy.natinst.com j Contents [readable]: numeric
6l $Keyboard [implicit]

$5pstem value
-EL Processi

$dslarm

gty Panell

gty Tankl

ity TankLevel Quit |
Paste | TarkLevel |
Help

The Interpolate object now multiplies the X0 input by the Input(x)
multiplier, find the two coordinate pair parameters that X0 falls between,
interpolate, and multiply the interim output by the Output(y) multiplier,
then send the resulting value to the YO readable data member.

@ Note The Interpolate object class does not have a display parameters dialog box.
However, you can easily display the result of its output signals by referencing its data
members in expressions.
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Interpolate Data Members

Table 2-25. Interpolate Data Members

Data Members Type Read | Write Description
X0 -X999 numeric yes yes Input value
YO0 -Y999 numeric yes yes Output value. For a given input, Xn,

the object outputs the result of the
interpolation as a corresponding Yn
value.

Comments If you want to interpolate another input using the same coordinate pair
parameters and multipliers (that is, the same Interpolate object), connect to another
input like X23, and read its corresponding output, Y23.

Lookout Object Reference Manual

Because Xn and Yn data members are both readable and writable, the
object can also act as a bi-directional interpolator. For example, you can
connect a numeric signal to a Yn data member, and read the corresponding
interpolated Xn data member. A real-world example of this could be a
typical tank strapping problem. Normally, you would use a tank level as an
input to X0, and read the interpolated output YO as the corresponding tank
volume. Hence you begin with a level and end up with a volume. However,
you might also be monitoring the volume and would like to use that value
to calculate a corresponding level. In that case, you might want the
Interpolate object to be bi-directional, which it is. If YO ever changes, the
object divides YO by the Output(y) multiplier, interpolate between the two
closest Output(y) parameters, calculate a corresponding input value based
on the two closest Input(x) parameters, divide it by the Input(x)
multiplier, and send the resulting value to the X0 data member.

2-80 www.natinst.com




Interval

Chapter 2 Lookout System Objects

© National Instruments Corporation 2-81

Interval is an adjustable delay timer. When On/off signal transitions to on,
its output turns on and the Timer delay begins to count down. At the end
of the delay countdown, the output signal turns OFF. If On/off signal is
dropped at any time, the output signal turns OFF, and the timer is reset.

Timer delay can range from 0.0 seconds to several years, and the effective
resolution is 0.1 seconds over the entire range. The timer display digitally
shows the time delay remaining. It is updated approximately once per
second. If the On/off signal is low, or the time delay period has expired, the
timer display shows OFF.

Create Interval timer: E
Mame: Timerl

On/off signal = I
Timer delay = I
Dizplay format: I Mk:S5 - l

Ok | Cancel | Help |

Figure 2-41. Interval Definition Parameters Dialog Box

The On/off signal is a logical expression while Timer delay is a numeric
expression. Normally, this is a simple time constant such as 0:20 (twenty
seconds). See Numeric Data Members in Chapter 2, How Lookout Works,
of the Getting Started with Lookout manual for information on entering
time constants.

Text calor S dayl = o
. .. . ackground style rarme style

&+ Flate  Black

EENEEEEEE EEEE ©F- Vil

Background color
LN |
ENENEEE

 Justify left & Justify centered  Justify right

;  Rectangle & Mone
& Transparent

ﬂ Cancel |

Font... |1DptAriaIEloId

Figure 2-42. Interval Display Parameters Dialog Box
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Interval Data Members

Table 2-26. Interval Data Members

Data Member

Type

Read

Write

Description

(implicit)

logical

yes

no

Logical timer value

Comments The Interval timer can be used to enforce a maximum run time for a pump.

Related Objects DelayOff, DelayOn, OneShot, Pot, TextEntry

Lookout Object Reference Manual
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Junction receives up to nine numeric values, each of which could be the
result of a complex numeric expression. It outputs the value of the last
Additional input that changed (event driven). Notice, however, that it will
not output a value until the Initializing input has changed. After that, any
change in any input is immediately output.

Mew Junction E

Initializing input =

Additional inputs =

QK | Cancel | Help |

Figure 2-43. Junction Definition Parameters Dialog Box

Junction Data Members

Table 2-27. Junction Data Members

Data Member

Type Read | Write Description

(implicit)

numeric yes no The value of the input that most
recently changed

Comments Junction is a unique class that should be used only in rare circumstances.
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Panell connections E
Select object... |

$Keyboard is a global object. Its data members represent the keyboard
function keys. Unlike other object classes in which you can create several
objects of the same class, you cannot create or delete $Keyboard objects,
but you can use the one supplied.

You can use the $Keyboard global object to perform such functions as
calling a particular control panel, activating a batch sequence, or
acknowledging alarms by pressing a key.

Think of $Keyboard data members (which represent function keys on the
keyboard) as Lookout pushbuttons. Just as you can connect a pushbutton to
the activate data member of a panel, you can also connect a $Keyboard data
member to the activate data member of a panel. Such a connection is shown
in the following illustration.

— Select member:

‘wiitable members: Existing connections:

activate

masimize
minirnize

print

Gelect | Iactivate

Parell. activate =

[} *¥¥eyboard /5 :

MNew logical connection Clear |

— Signals:
Tags:

Ir: IE paroikoz. dy.natinst. com

[class]  Path Maode: I Relative

j Contents [readable]: logical

+
+
+

Paste | 4. M$keyboard. F

33 $Keyboard chil.F1-24
oy $5ystem f1-24
|, Process shift.f1-24

Quit |
Help |

Lookout Object Reference Manual

Figure 2-44. Edit Connections Dialog Box

The logical expression, $Keyboard.F1 calls up Panell any time a user
presses the F1 key on the keyboard. Similar connections could be made to
other panels. You can easily connect a different panel to each function key.
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Just as easily, you can connect a function key to a batch process trigger.
When the key is pressed, (that is, when the $Keyboard data member goes
TRUE) the batch is activated—reading batch ingredients from a recipe
object, opening and closing valves, starting mixers, bottling finished
material, and so on.

You might also connect a function key to $Alarm.ack. This would enable
users to acknowledge alarms through a single keystroke.

$Keyboard Data Members

$Keyboard has 72 readable data members. Each data member represents a
unique key sequence, described in the following table.

Table 2-28. $Keyboard Data Members

Data Member Type Read | Write Description

Ctrl-F1 - Ctrl-F24 logical yes no Each of these 24 data members
represent a function key, F1 —
F24—when pressed in conjunction
with the Ctrl key. A given data
member returns logical TRUE when
the Ctrl key and function key are
pressed together and FALSE when the
keys are released.

F1 - F24 logical yes no Each of these 24 data members
represent a function key, F1 — F24. A
given data member returns a logical
TRUE when its associated function
key is pressed and FALSE when the
key is released.

Shift-F1 - Shift-F24 logical yes no Each of these 24 data members
represent a function key, F1 —
F24—when pressed in conjunction
with the Shift key. A given data
member returns logical TRUE when
the Shift key and function key are
pressed together and FALSE when the
keys are released.

© National Instruments Corporation 2-85 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

Comments $Keyboard function keys are global in nature. Any time F1 is pressed, the
$keyboard.F1 signal goes TRUE—regardless of what panel the user is looking at. If
you want a function key to be unique from one control panel to the next, use the Panel
object class function key data member. See Panel object class definition for more
information.

Related Objects L3Pushbutton, Pushbutton
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L3Pot

L3Pot is a potentiometer that you use to change numeric setpoint values.
You can display pots on a control panel as a knob, vertical slider, horizontal
slider, increment/decrement pushbuttons, or digital entry. You can also use
pots as multiple-position switches.

If you change the background color of a panel and add a Pot object
displayed as a slider, its color is always gray. To change the background
color of a Pot to match your panel, select the Pot object, then pick
Change»Background Color from the menu.

New potentiometer: | ]

Tag: IPressSetPoint

inimum: 125
|
Maxirnurm: |1?5
Cancel |
Fesolution: |.1

—Position source
 Local

o+ Remote
Position = IPLC1.HiPressAIarm

' DDE

EEfIEE I
i I
[teri I

Contral security level: ID V¥ Log evants

Figure 2-45. L3Pot Definitions Parameters Dialog Box
Minimum is the lowest value signal the Pot will generate.
Maximum is the highest value signal the Pot will generate.

Resolution is the smallest increment of change, or detent spacing the Pot
supports.

Position source determines where the value of the Pot resides. Local
indicates the value of the Pot lies within the object itself—on the control
panel.
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Remote pots get their values from a remote source, often the register on a
controller they are connected to. Adjusting the Pot changes the value in the
register, and changing the value in the register adjusts the Pot. In effect, the
Pot is tracking a remote value. This is especially useful when you want to
prevent Lookout from changing the value of setpoints or registers upon
initial startup, or reconnection of lost communication. When you use this
style Pot you are creating a kind of looped signal. Half the loop is formed
when you connect the controller register to the Pot with the Position
expression, while the second half is formed when you connect the Pot
output signal to the controller register. Position is a numeric expression.
Do not forget to complete the second half of the loop with the Object»Edit
Connections... command.

Much like Remote Pots, DDE (Dynamic Data Exchange) Pots get their
values from a remote source. This could be a cell in a spreadsheet, another
DDE aware application, or a second copy of Lookout running on the
network. The last DDE parameters used on any object automatically
become the default values for any new DDE object. See Chapter 5,
Dynamic Data Exchange, of the Lookout Developer’s Manual for more
information on Service, Topic, and Item parameters.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it.

The Log events option creates a permanent audit trail for the object—who
did what and when. All adjustments of the Pot are logged to disk, including
the time of the adjustment, the operator account name, and what adjustment
was made. See Chapter 7, Logging Data and Events, in the Lookout
Developer’s Manual for more information on event logging.

Insert: PressSetPoint | ]

BEE

() K] (2] (4

Cancel |

Figure 2-46. L3Pot Display Parameters Dialog Box
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@ Note You can modify the background color on vertical and horizontal sliders with the
Change»Background color... menu command. You can modify the font and font color of
digital pots using Change commands.

L3Pot Data Members

Table 2-29. L3Pot Data Members

Data Member Type Read | Write Description
(implicit) numeric yes no Current value
decrement logical no yes When this data member value

transitions from FALSE to TRUE, the
implicit value of the Pot object
decreases by the Pot Resolution
amount.

enable logical no yes If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is on. This input is ignored for
non-DDE TextEntry objects.

enter Value logical no yes Under specific circumstances, when
this value transitions from FALSE to
TRUE, pops up a Enter new value
dialog box for an operator to use in
entering a value for the pot. See the
note following the table for more
detailed information.

The enterValue data member is
designed for use under unusual
circumstances, in particular when
pointing devices are not available on a
computer running Lookout. Because
of its unusual operation, this data
member should not be used unless it is
necessary for hardware reasons.
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Table 2-29. L3Pot Data Members (Continued)

Data Member Type Read | Write Description

increment

logical no yes When this data member value
transitions from FALSE to TRUE,
the implicit value of the Pot object
increases by the Resolution amount.

visible

logical no yes When FALSE, the Pot object cannot
be seen on the display panel. When
TRUE, the Pot can be seen and
controlled.

5

Note When the entervalue input transitions from FALSE to TRUE, and
if the Pot is visible,
if Lookout is not in edit mode, and
if the Pot has at least one digital display,

The Enter new value dialog box pops up so an operator can input a value, just as if he had
clicked on the digital display.

The numeric format and position used for the dialog box are based on the digital display
for a pot.

Even if the panel containing the Pot digital display is inactive, the Enter new value dialog
box will pop up. You can prevent this by predicating the entervalue input on the panel’s
active data member.

Comments Potentiometers are one of the most common control objects used in process
controls. Using Pots, a plant operator can make setpoint changes with the mouse.
L3Pots also work well as HOA switches. To create an HOA switch with a Pot, specify
the minimum as 1, the maximum as 3, and the resolution as 1.

The increment and decrement data members enable quick connection of
pot objects to $Keyboard and Panel function keys, and screen Pushbuttons.
These are often used to control Pot objects when Lookout is running on an
industrial PC platform that has restricted or no mouse functionality.
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L3Pushbutton

L3Pushbutton generates a logical signal for receipt by other objects. A
pushbutton changes state when you position the cursor over it and press the
mouse button, trackball, touchscreen, or space bar. The pushbutton remains
depressed and the output signal remains high until you release the button.
If a Verify on message is defined, the operator must first acknowledge the
message, then the output signal goes high, but only momentarily.

Create pushbutton | ]

Tag: IMotorStanPb

Button text: IStart

“erify on = I“DD wou want to start kotar 27"

—Position source
 Local

- Femote
Pasition = [PLC.C101

' DDE

EEfIEE I
i I
[teri I

Contral security level: ID V¥ Log evants

oK I Cancel |

Figure 2-47. L3Pushbutton Definitions Parameters Dialog Box

Button text displays the specified text on the pushbutton.
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Use Verify on to create a dynamic text expression to be displayed in a
message dialog box. See Chapter 6, Security, in the Lookout Devioper’s
Manual for more information on security.

MotorStartPb =]

@ Do you want to start Maotor 27

Mo |

Figure 2-48. Verification Message Dialog Box

Position source determines where the value of the pushbutton resides.
Local indicates the value of the pushbutton lies within the pushbutton
itself—on the control panel. If the pushbutton is not depressed its signal
is OFF, if depressed its signal is ON.

Remote pushbuttons get their values from a remote source, often the
register in a controller they are connected to. Depressing the pushbutton
changes the status of the register, and changing the status of the register
depresses the pushbutton.

The Remote option is especially useful when you want to prevent Lookout
from changing the value of setpoints or registers upon initial startup, or
reconnection of lost communication. When you use this style of pushbutton
you are creating a sort of looped signal. Half the loop is formed when you
connect the controller register to the pushbutton with the Position
expression, while the second half is formed when you connect the
pushbutton output signal to the controller register. Position is a logical
expression. Do not forget to complete the second half of the loop with the
Object»Edit Connections... command.

When you select the Remote option, you can choose whether or not the
pushbutton latches its output. The Latch output check box configures
Lookout for controlling a latching-relay.

When a user clicks on a pushbutton that has latching selected, the
pushbutton remains depressed, sending an ON signal (TRUE or high) until
the Remote Position signal turns ON. Assume for example that an operator
clicks on MotorstartPb, configured previously. The pushbutton remains
pushed in, sending a TRUE signal, until PLC.C101 goes TRUE. As soon
as PLC.C101 goes TRUE, the pushbutton releases.
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Much like Remote pushbuttons, DDE (Dynamic Data Exchange)
pushbuttons get their values from a remote source. This could be a cell in a
spreadsheet, another DDE aware application, or a second copy of Lookout
running on the network. See Chapter 5, Dynamic Data Exchange, in the
Lookout Developer’s Manual for information on Service, Topic, and Item
parameters.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it. See
Chapter 6, Security, in the Lookout Developer’s Manual for more
information on security.

The Log events option creates a permanent audit trail for the object—who
did what and when. Any depression of the pushbutton is recorded to disk,
including the time the button was depressed, and the operator’s account
name. See Chapter 7, Logging Data and Events, in the Lookout
Developer’s Manual for more information on logging events.

Text color Style
. .. . & Button
HEEEEEEEN EEEE © Terceect

Button colar 0K |
| |

ENEEEEE ==

 Justify left & Justify centered  Justify right

Font... |1DptAriaIEloId

Figure 2-49. L3Pushbutton Display Parameters Dialog Box
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L3Pushbutton Data Members

Table 2-30. L3Pushbutton Data Members

Data Members Type Read | Write Description

(implicit) logical yes no Value of object (TRUE when button is
depressed)

enable logical no yes If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is on. This input is ignored for
non-DDE TextEntry objects.

visible logical no yes When FALSE, the pushbutton cannot
be seen on the display panel. When
TRUE, the button can be seen and
controlled.
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L3Switch

L3Switch generates a logical signal for receipt by other objects. Switches
change state when you click on them with a mouse button, trackball,
touchscreen, or space bar on your keyboard.

- —Position source
Tag: ISW|tch1
) .  Local
Action wverification messages —
On = I“Are You Sure?" Position = IPLC1 Purnp?4|
off= | - DDE

EEfIEE I
i I
Ok I Cancel | lterm: I—

Control security lewvel: I? IV Log events

Figure 2-50. L3Switch Definition Parameters Dialog Box

Use Action verification messages to create dynamic text expressions to be
displayed in message dialog boxes. See Chapter 6, Security, in the Lookout
Developer’s Manual for more information on security.

Switch1 =]

@ Are You Sure?

Figure 2-51. Verification Message Dialog Box

Position source determines where the value of the switch resides. Local
indicates the value of the switch lies within the object itself—on the control
panel. If the switch is up the signal is ON, if down the signal is OFF.

Remote switches get their values from a remote source, often the register
on a controller they are connected to. Flipping the switch changes the status
of the register, and changing the status of the register flips the switch.

The Remote option is especially useful when you want to prevent Lookout
from changing the value of setpoints or registers upon initial startup, or
reconnection of lost communication. When you use this style switch, you
are creating a sort of looped signal. Half the loop is formed when you
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connect the controller register to the switch with the Position expression,
while the second half is formed when you connect the switch output signal
to the controller register. Notice Position is a logical expression. Do not
forget to complete the second half of the loop with the Object»Edit
Connections... command.

Much like Remote switches, DDE (Dynamic Data Exchange) switches get
their values from a remote source. This could be a cell in a spreadsheet,
another DDE aware application, or a second copy of Lookout running on
the network. See Chapter 5, Dynamic Data Exchange, in the Lookout
Developer’s Manual for more information on Service, Topic, and Item
parameters.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it.

The Log events option creates a permanent audit trail for the object—who
did what and when. All adjustments of the switch are logged to disk,
including the time the switch was flipped, the operator’s account name,
and the direction the switch was flipped. See Chapter 7, Logging Data and
Events, in the Lookout Developer’s Manual for more information on event

logging.

Display switch: Switchl | ]
 Standard

VELEE

X

You can replace the standard switch types with custom graphic symbols.
If you decide to use custom graphics, you must specify both symbol
parameters, On and Off. See Chapter 2, Graphics, in the Lookout
Developer’s Manual for more information on creating custom graphic
symbols and the use of Transparent pixels.
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Table 2-31. L3Switch Data Members

Data Members

Type

Read

Write

Description

(implicit)

logical

yes

no

L3Switch Position

enable

logical

no

yes

If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is ON. This input is ignored for
non-DDE L3TextEntry objects.

visible

logical

no

yes

When FALSE, the switch object
cannot be seen on the display panel.
When TRUE, the switch can be seen
and controlled.

Comments If a switch with more than two positions is needed, use a Radiobutton

object instead.

Related Objects L3Pushbutton, L3Pot, Pushbutton, Pot
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With L3TextEntry you can manually enter textual notes with the keyboard.
These notes may contain any combination of numeric and alphanumeric
characters; however, the result of your entry is converted to a text value.
Just like any other text expression in Lookout, your note can be logged to
disk, connected to other data members that accept text signals, and so on.
The note is saved and displayed as a single line entry—you cannot embed
carriage returns into the message.

New TextEntry: | ]

Tag: ITextE ntryl

Entry prompt:

IReason for Setpoint change

— Textsource

& Local
- Remote

EasiticEn = I

i DDE

EEfIEE I
i I
[teri I

Contral security level: ID V¥ Log evants

(o]

Figure 2-52. TextEntry Parameters Dialog Box

Cancel |

Entry prompt is the text that appears at the top of the text entry dialog box
when an operator selects the text entry pushbutton.

Text source determines where the user-entered text resides. Local
indicates the user-entered text lies within the object itself—on the control
panel.

Remote indicates that the user-entered text resides in a remote source,
such as a text expression or another TextEntry object.

Much like Remote TextEntry objects, DDE TextEntry objects get their
values from a remote source. This is the option you use to tie the text to a
cell in a spreadsheet, a database lookup table, or any DDE aware
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application—including a second copy of Lookout running on the network.

See Chapter

5, Dynamic Data Exchange, in the Lookout Developer’s

Manual for more detailed information on Service, Topic and Item.

5

Note

The last DDE parameters used on any object automatically become the default

values for any new DDE object.

Control security level specifies the minimum security level operators must

have to gain

access to this individual object, and thus control it.

The Log events option creates a permanent audit trail for the object—who
did what and when. When selected, all text entries in this object are logged
to disk. Each entry includes the time of the entry, the operator’s account

name, and what entry was made. See Chapter 7, Logging Data and Events,
in the Lookout Developer’s Manual for more information on event logging.

Lookout presents the following display parameters dialog box after you
define the object. It lets you define the text font and presentation style.

Text calor Bock ey - N
. .. . ackground styla rame style
NEEEEEEEE EEEN C° b,
Background color e ite
D. .  Rectangle ¢ Mone
.......  Transparent

 Justify left

& Justify centered  Justify right

O

Cancel |

Font... |1DptAriaIEloId
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Figure 2-53. TextEntry Display Parameters Dialog Box
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L3TextEntry Data Members

Table 2-32. L3TextEntry Data Members

Data Members Type Read | Write Description
(implicit) text yes no Current, user-entered text
enable logical no yes If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is ON. This input is ignored for
non-DDE TextEntry objects.
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LatchGate

LatchGate is latched on and off by two incoming signals. It retains the state
of the signal that most recently went high, regardless of the state of the
other signal. When the Turn Off signal transitions from OFF to ON, the
LatchGate output goes OFF until the Turn On signal transitions from OFF
to ON. The output signal does not change when either incoming signal
transitions from ON to OFF. Both Turn Off and Turn On are logical

expressions.
Create LatchGate E
M ame: ILatchGate‘I
Tumn On = ||
Tum Off = |
QK | Cancel | Help |

Figure 2-54. LatchGate Definition Parameters Dialog Box

LatchGate Data Members

Table 2-33. LatchGate Data Members

Data Member Type Read | Write Description

(implicit) logical yes no Logical output signal value

Comments Two pushbuttons connected to the Turn On and Turn Off expressions of
a LatchGate create pushbutton start/stop controls for a pump or other device.

Related Objects Flipflop
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Lookout Object Reference Manual

Use the Lookout Loader to load or unload a Lookout process in response to
a logical trigger. Using a Loader object in conjunction with a Monitor
object is how you create failover redundancy with Lookout. See

Chapter 10, Redundancy, in the Lookout Developer’s Manual for more
information on redundancy.

Create Loader E
Mame: I Process Mame: I
Process File: I Browse. .. |

— State Information:
' Save State File with Process Fils
7 Save State File in Lookout Folder (Based on Process Mame)
™ Save Standby State Fil:

I Browse.. |

V' Save state file(s) every IBD [1-1440) minutes.

— Citadel D atabase:
V' Use Default Values
Eomputer Hame:

JSANJEEY
LEitadel|latabase Falder:
Id:\lookout4.0 betaZ?hdatabase

Load = I Unload = I

QK I Cancel | Help |

You may notice that the information in the State Information and Citadel
Database sections of this dialog box are the same as those areas in the
Create Process dialog box and, in the case of the Citadel Database
section, the System Options dialog box. Just as the Citadel Database
section of the Create Process dialog box overrides the system database
location settings for a particular process, any settings you make in the
Loader object for database location or saving of state files override both
system defaults and whatever settings you may have made when you
created the process being loaded.

Process Name is the name that the process runs under when you open the
Process File. You can use a process name other than the one used when the
process file loaded was created.

Process File is the name of the file this Loader object will load when
activated. You must enter a complete path to the file. You can specify a file
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from another computer on your network, but you must map the location on
the remote computer as a network drive on your own computer first.

The State Information section of this dialog box lets you set where
Lookout saves state files for the process just loaded, and under what name
the files are saved.

Select Save State File with Process File to save the state file in the location
where the process file was opened.

Select Save State File in Lookout Folder to save the state file in the
Lookout folder of the copy of Lookout your are currently running. The state
file name is the same as the process name.

Select the Save Standby State File checkbox to save one or more extra
copies of the state file in a location of your choosing. Enter a complete path,
including state file name, to each location you want to save a state file.

If you are saving the state file to more than one backup or alternative
location, separate the paths with the vertical bar (|) operator symbol.

Check the Save State File(s) every NNy (1-1440) minutes option to set
the frequency with which Lookout saves the state file. The Lookout default
is 60 minutes.

The Citadel Database section sets the location of the Citadel database that
Lookout logs data to for the process you load. If you check the Use Default
Values checkbox, Lookout uses the default location set in the System
Options dialog box of any instance of Lookout running the process.

If you enter a computer name and a path on that computer to a specific
folder, Lookout logs data to that location on that computer, no matter what
computer is running the process.

To designate a specific computer and path for your process to log data to,
enter the fully qualified network name for the target computer in the
Computer Name field, and the complete path to the target database
directory in the Citadel Database Folder field.

Load is the logical signal you use to activate the Loader and load the
process.

Unload is the logical signal you use to activate the Loader and unload the
process you loaded earlier.
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The Loader can only load one process at a time, and can only load a process
to run inside the instance of Lookout currently running the process that
contains the Loader.

To load multiple processes with one trigger, you must use multiple Loader

objects.

Loader Data Members

Table 2-34. Loader Data Members

Data Member Type Read | Write Description

SaveWithProcess logical yes no When TRUE, Lookout saves a state
file in the same location as the process
file it contains the state for.

DatabaseComputer text yes no Sets the computer on which Lookout
saves Citadel database files.

DatabaseFolder text yes no Sets the folder in which Lookout
saves Citadel database files.

Failure logical yes no Monitor this data member to be
alerted if a load attempt fails.

Failuretext text yes no Returns the reason for a failure to load
the process designated by the loader.

Load logical yes yes Triggers the loader to load the
designated process file.

ProcessFile text yes no Name of the process the loader loads
when activated.

ProcessName text yes no Specifies the process name a loaded
process runs under.

SavePeriod numeric yes no Sets how often, in minutes, that
Lookout saves the state file for the
loaded process.

SaveWithLookout logical yes no When TRUE, Lookout saves the state
file in the Lookout directory, using
ProcessName as the name for the
state file as well.
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Table 2-34. Loader Data Members

Data Member Type Read | Write Description
StandbyFile text yes no Complete path to the location in
which you want Lookout to save
copies of the state file.
Unload logical yes yes Triggers the loader to unload the
designated process.

Loader Error Messages

Load: No process file specified
Specify a process file in the ProcessFile field.

Load: No process name specified

Name your process in the ProcessName field.

Load: Process already exists: loadername.processname

The process specified by your Loader object is already running under that
name in this instance of Lookout. Only one process may run under each
process name.

Load: No state file specified

You must specify state file information for any process you load with a
Loader object.

Load: Invalid process name

You have chosen an invalid process name. See the Object Names section in
Chapter 4, Using Lookout, of your Getting Started With Lookout manual
for detailed information on valid Lookout process and object names.

Load: Invalid database computer name

The computer name you have entered in the ComputerName field is not

registered as being a part of your Lookout network. Check the spelling of
the name or register the computer through the Lookout Object Explorer or
the Lookout Connection Browser.

Load: Invalid database folder

Check the path you have entered in the Citadel Database Folder field to
make sure the path you entered does exist on the computer specified in the
ComputerName field.

© National Instruments Corporation 2-105 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

Lookout Object Reference Manual

Load: Can't open process file processfilename

Lookout was unable to open the file processfilename. Check to see that
the file exists in the specified location and has not been corrupted.

Unload: No process name specified

Enter the name of the process you want to unload in the Process Name
field.

Unload: Process not found

Lookout must be running a process with the name specified in the Process
Name field for the Loader to unload a process. If no process with the
specified name is running when the Loader attempts to unload a process,
Lookout returns this error message.
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Maximum

Maximum actively calculates the maximum value of Data over time.
Maximum is only active when the Enable expression is TRUE. It resets to
zero when the Reset expression transitions from OFF to ON. Maximum
also maintains an array of up to 35 previous maximum values. If Enable is
left blank, the object always actively calculates the maximum. Data is a
numeric expression while Reset and Enable are logical expressions.

Marme: W
Data = I
Reset = I
Enable = I
ok | Cancel | Help |

Figure 2-55. Maximum Configuration Parameters Dialog Box

@ Note Maximum does not have a display parameters dialog box. However, you can easily
display Maximum by referencing it in an expression.

Maximum Data Members

Table 2-35. Maximum Data Members

Data Members Type Read | Write Description
(implicit) numeric yes no Current maximum value
1-35 numeric yes no Previous maximum values. Signal 1 is

the most recent prior maximum since
the Reset expression went high.

DataReset logical no yes Upon transition from FALSE to
TRUE, resets to zero all data
members—including the current
maximum value and all previous
maximum values.
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Comments The Reset interval could be a regular pulse interval created by a
TimeOfxxxx timer, so that the pulse is synchronized to the top of the hour or day. For
example, if you want to calculate the daily maximum flow rate, use the output signal
from a TimeOfDay timer or a daily Spreadsheet object to reset the maximum
calculation at the beginning of each day.

Related Objects Average, Minimum, Sample, SampleText
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Minimum actively calculates the minimum level of Data over time.
Minimum is only active when the Enable expression is TRUE. It resets to
zero when the Reset expression transitions from OFF to ON. Minimum
also maintains an array of up to 35 previous minimum values. If Enable is
left blank, the object is always actively calculating the minimum. Data is a
numeric expression while Reset and Enable are logical expressions.

M ame: IMinimum‘I

Data = I

Reset = I

Enable = I

ok |

Cancel |

Help |

Figure 2-56. Minimum Configuration Parameters Dialog Box

5

Minimum value referencing it an expression.

Minimum Data Members

Note Minimum does not have a display parameters dialog box. You can easily display the

Table 2-36. Minimum Data Members

Data Members Type Read | Write Description

(implicit) numeric yes no Current minimum value

1-35 numeric yes no Previous minimum values. Signal 1 is
the most recent prior minimum since
the Reset expression went high.

DataReset logical no yes Upon transition from FALSE to
TRUE, resets to zero all data
members—including the current
minimum value and all previous
minimum values.
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Comments The Reset interval could be a regular pulse interval created by a
TimeOfxxxx timer, so that the pulse is synchronized to the top of the hour or day. For
example, if you want to calculate the daily minimum flow rate, use the output signal
from a TimeOfDay timer or a daily Spreadsheet object to reset the minimum
calculation at the beginning of each day.

Related Objects Average, Maximum, Sample, SampleText
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The Lookout Monitor object is integral to Lookout redundancy. The
Monitor object maintains a connection with a data member in any process
you want to watch from another computer or process. If the data flow from
that source stops, the Monitor signals the halt, allowing you to respond.

Using a Monitor object in conjunction with a Loader object is how you
create failover redundancy with Lookout. See Chapter 10, Redundancy,
in the Lookout Developer’s Manual for more information on redundancy.

Create Monitor: E

MName: IMonitor‘I

Output goes high if connection to URL
fl
is lost for more than I seconds.

QK I Cancel | Help |

In the Output goes high field enter a data member in the process you want
to monitor. If the data quality of that expression goes bad for more than the
number you enter in the seconds field, the monitor goes high (TRUE),
letting you know there is a problem with the process.

Monitor Data Members

Table 2-37. Monitor Data Members

Data Member

Type Read | Write Description

(implicit)

logical yes no Goes TRUE when the data member
the Monitor is watching cannot be
accessed after a specified length

of time.

timeout

numeric yes no The length of time in seconds that the
data member being monitored must
be unavailable before the Monitor
goes TRUE.

© National Instruments Corporation 2-111 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

Multistate

Multistate displays different graphics on a control panel as dictated by the
values of Conditional expressions. You can use up to six Graphic files,
but at least one is required. Multistate determines which graphic to display
based on the order and current status of your Conditional expressions. If
several Conditional expressions are true at once, Multistate displays the
graphic associated with the first true expression.

New Multistate

M ame:

Else if =

Else if =

Else if =

Else if =

Elze

JMs1

Conditional expressions:

o]

Cancel |

Help |

Figure 2-57. Multistate Configuration Parameters Dialog Box

Conditional expressions must result in logical values (TRUE or FALSE).
See the Animator section for more information about constructing logical
statements. Double-click in a Graphic file box to select the graphic you

want to use.

Multistate Data Members

Table 2-38. Multistate Data Members

Data members Type Read | Write Description
none — — — Multistate objects do not have data
members
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Comments By creating several graphic images that depict a sequence of events,
Multistate can be used to create animation sequences on control panels such as
hydraulic pistons moving back and forth. A more typical use of Multistate is for
three-color pilot lights, where green represents running, red represents stopped,
and yellow represents failed, for example.

For smooth, high speed animations, use the Animator object.

Related Objects Animator
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Neutralzone

Neutralzone is an ON/OFF Controller. It functions the way a home air
conditioning thermostat does; if the temperature rises above a certain level,
the above data member goes TRUE (turning the A/C on). When it drops
below a lower temperature, the below data member goes TRUE (turning
the A/C off).

When the incoming Signal value rises above both Low limit and High
limit, the data member above turns on, and the data member below turns
off. When the incoming Signal value drops below both Low limit and High
limit, above turns off, and below turns on. The above and below data
members do not change state when the signal value falls back within the
two limits (within the neutral zone). Signal, High limit, and Low limit are
all numeric expressions.

M ame: IW
Signal = ||
High limit = |
Low limit= |
QK | Cancel | Help |

Figure 2-58. Neutralzone Definition Parameters Dialog Box

The previous discussion assumes numeric constants for both limits.
However, you could use variable setpoint signals from Pot objects so an
operator could dynamically adjust Neutralzone behavior.

@ Note Neutralzone does not have a display parameters dialog box. You can easily display
the result of Neutralzone output signals by referencing its data members in an expression.
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Table 2-39. Neutralzone Data Members

Data Members

Type

Read

Write

Description

above

logical

yes

no

ON if signal is greater than both
limits, OFF if signal is less than both
limits, and does not change if signal is
between both limits

below

logical

yes

no

ON if signal is less than both limits,
OFF if signal is greater than both
limits, and does not change if signal is
between both limits

Comments You can use this object to turn pumps on and off or open and close valves
based on line pressures or tank levels. Neutralzone objects prevent pumps from cycling
on and off around a single setpoint, just as an air conditioning thermostat prevents your
home air conditioner from incessantly starting and stopping.

Often the term deadband is mistakenly used to describe a neutral zone.
However, deadbands refer to the amount of change a numeric value must
travel in the reverse direction before the output numeric value begins to

change.
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OneShot

OneShot is an adjustable delay timer. When On/off signal transitions to on,
the output signal goes TRUE and the Timer delay begins to count down.
At the end of the delay countdown, the output signal goes FALSE.

Unlike the Interval timer, the OneShot timer output remains on for the
Time delay period even if On/off signal goes FALSE. So a OneShot timer
requires only a momentary signal to begin the Timer delay period. Pulsing
the On/off signal during the time delay period does not extend the time
delay period of a OneShot timer.

Create OneShot timer: E
Mame: Timerl

On/off signal = I
Timer delay = I
Dizplay format: I Mk:S5 - l

Ok | Cancel | Help |

Figure 2-59. OneShot Definition Parameters Dialog Box

The On/off signal is a logical expression while Timer delay is a numeric
expression. Normally, this is a simple time constant such as 0:20 (twenty
seconds). See Numeric Data Members in Chapter 2, How Lookout Works,
of the Getting Started with Lookout manual for information on time
constants.

Timer delay can range from 0.0 seconds to several years. The effective
resolution is 0.1 seconds over the entire range.

Lookout Object Reference Manual 2-116 www.natinst.com



Chapter 2 Lookout System Objects

The object is represented on a control panel by showing the time delay
remaining in the format defined by the Display format parameter. It is
updated approximately once per second. If the delay period has expired,

it shows OFF.

Text colar S oy F o
ackground style rame style
mEEREREER EEEE 9sz v
Background color nse e
D. .  Rectangle & Mone
....... & Transparent
 Justify left & Justify centered  Justify right

off

Cancel |

Font... |1DptAriaIEloId

Figure 2-60. OneShot Display Parameters Dialog Box

OneShot Data Members

Table 2-40. OneShot Data Members

Data Member

Read

Type Write

Description

(implicit)

logical yes no

Logical timer value

Comments You can use the OneShot timer to hold a valve open for a set period of time
after a pushbutton is pressed, or to prevent pump starts from occurring too rapidly in

succession.

Related Objects DelayOff, DelayOn, Interval, Pot, TextEntry
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Pager
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Pager is an object class Lookout uses to contact a numeric or alphanumeric

pager through a modem, sending a message to the pager.

Create Pager E

Mame: IF'ager‘I

Pager type: INumeric Only vl

Fager number = |“555'5555“
I"Lookout numberic Page 123-4567"

Meszage =

Mumeric Only p

Drelay: I‘I 2 zeconds

Baud rate: I‘I 0 > l
Serial port: ICDM'I j
I_

Communication alam priority: |2

QK I Cancel | Help |

Figure 2-61. Numeric Only Pager Definition Parameters Dialog Box

Create Pager E

Mame: IF'ager‘I

Pager type: IAlphanumeric A l

Fager number = |“555'5555“
I"Lookout numberic Page 123-4567"

Meszage =

Alphanumeric p

Terminal number: |392250594

Fietry attempts: I4 Feceive timeout: 2000 MEecs

Baud rate: |12DD 'l
Serial port: ICDM'I j

Communication alarm pricrity: I8

QK I Cancel | Help |

Figure 2-62. Alphanumeric Pager Definition Parameters Dialog Box

Pager type determines whether the Pager object operates in numeric only
or alphanumeric mode. A detailed description of the operation of these two

modes follows.
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Pager number is the phone number of the pager you want to contact.
When the Pager object is in Alphanumeric mode, this number corresponds
to the pager ID number.

Message is the message you want to send to the pager. Notice that in
Numeric Only mode only numeric characters are sent.

Delay is how long the Pager object waits after dialing the pager number
before it dials the message number. This parameter is valid in Numeric
Only mode only.

Terminal number is the phone number of the remote paging terminal you
want to contact. This parameter is valid in Alphanumeric mode only.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device if it is not getting a
valid response. After it tries the number of Retry attempts specified, the
Pager object generates an alarm and releases the COM port. Refer to
Chapter 3, Serial Communications, in the Lookout Developer’s Manual for
more information. This parameter is valid in Alphanumeric mode only.

Receive timeout is the time delay Lookout uses in waiting for a response
from a device before retrying the request. This parameter is valid in
Alphanumeric mode only.

Baud rate indicates the baud rate Lookout uses to communicate with the
modem and paging terminal.

Serial port specifies which COM port Lookout uses to communicate with
your modem. You must have this COM port configured as dial-up under
Options»Serial Ports.

Communication alarm priority determines the priority level of alarms
generated by the Pager object. You can relate such alarms to
communications with the modem or with the remote paging terminal.
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Pager Data Members

Table 2-41. Pager Data Members

Data Member Type Read | Write Description
Message text no yes Pager message
Phone text no yes Individual pager phone number or Page ID
number
Send logical no yes Sends the message on transition from FALSE
to TRUE

Pager Object Modes

Numeric Only

In Numeric Only mode, the Pager object establishes a connection with
your local modem. Once this connection has been established and the pager
number dialed, the Pager object waits for the time specified by Delay, then
dials the number that is the message. Because the Message data member is
a text value, the Pager object in Numeric Only mode omits any
non-numeric characters from the message when it is sent.

Alphanumeric Mode

In Alphanumeric mode, the Pager object actually establishes a connection
with a remote paging terminal, then transmits an alphanumeric message
using Telocator Alphanumeric Protocol (TAP) version 1.8. TAP is an
industry standard protocol for paging terminals that accept alphanumeric
pages. Alphanumeric messages are limited to 250 characters. The text
value in the Message data member will be truncated to this length if it is
longer.

Pager Serial Port Settings

Notice that there are two different retry settings that affect the operation
of the Pager object in Alphanumeric mode. The retry settings in the Pager
object dialog box govern serial communications with the remote paging
terminal. This means that after the two modems have connected and
finished handshaking, and the serial transaction is underway, each
individual frame is timed by the Receive timeout setting, and retried

the number of times specified by Retry attempts.
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These retry settings will not dial the phone number again if the remote
paging terminal for some reason does not answer or is busy, which happens
occasionally. This setting and other important modem settings (including
the AT initialization string that the Pager object must use on your modem)
can be found in Option»Serial Ports, and should be chosen carefully.
These settings are important in both Pager object modes.

@ Note You may have to increase your Receive Gap setting from its default of 5 to
something closer to 20 or 25. You must also have your COM port configured as dial-up.

Pager Queueing

The Pager object queues up to 10 messages in either mode. If the object is
in the process of sending out a page and the Send data member goes high
again, the current value of the Message data member will be queued and
sent out when the Pager object has time. Messages that are already in the
queue will not be duplicated.

Pager Status Messages

Paging terminal refused logon

Alphanumeric only error code

Paging terminal forced disconnect

Alphanumeric only error code

Paging terminal NAKed block transmission
Alphanumeric only error code

Paging terminal abandoned block transmission

Alphanumeric only error code

No response within timeout period

This means that the modem is not responding to Lookout requests.

Queue full

The paging queue currently has 10 pages in it, and will not accept any more
until at least one of those pages is successfully sent.

Garbled response

A response from the modem was corrupted or in an unrecognizable form.
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Panel

Lookout Object Reference Manual

Panel is a unique object class that accepts display members of other objects.
Panels (Control panels) are a window into your process you can use to
monitor and control your system by flipping switches, depressing
pushbuttons, and turning knobs.

There is no limit as to the number of control panels you can create in
Lookout or the number of objects or graphics that you can display on a
given panel. Control panels can be any size, and you can display them
within the Lookout workspace in various states (maximized, normal,
minimized).

Create control panels with the Object»Create... command or with the
Insert»Control panel... command. Both commands deliver the same
result.

New Control Panel

M ame:

Title: IControl Panel

— Panel type Background color:

& Nomal

[ [ |
C Popup ENENEER ER
" Popup no icon

— Security level

EEuny E\I'EL idthe [512
Viewing: [0

I Height. [384 Cancel |
Contral: ID

Figure 2-63. Panel Definition and Display Parameters Dialog Box

There are three distinct panel types: Normal, Popup, and Popup no icon.

A Normal control panel can be maximized, normal size, or minimized
within the Lookout workspace. When you activate a Normal panel it
appears at the size defined by its Height and Width. When you maximize
a Normal panel, it fills the Lookout workspace. When you minimize a
Normal panel it appears as an icon. The Normal option is typically
selected for full-sized control panels.

Popup control panels can either be in a popup state or minimized (they
cannot be maximized). When you activate a Popup panel it appears at
the size defined by its Height and Width. When a Popup control panel is
activated, it remains on top of all other panels until it is minimized. When
you minimize a Popup panel it appears as a bar at the bottom of the
Lookout screen.
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Popup no icon control panels are identical to Popup panels except they are
not represented by icons when minimized. When you minimize a Popup no
icon panel it disappears from the Lookout workspace.

@ Note Because Popup no icon control panels are not represented by icons, they use less
memory. (Microsoft Windows allocates a fixed amount of memory to each icon.) If you are
experiencing memory problems when running a Lookout application that has many control
panels, consider converting your Popup panels to Popup no icon.

Normal panels and Popup panels can be chosen by selecting their icon,
using the Window menu command. Popup no icon control panels cannot;
they can only be accessed by triggering their activate data member.

The Security levels settings are globally applied to a given control panel.
The Control security level works in conjunction with all individual object
security levels on that panel. The higher security level of the two is used to
determine if an operator has control over the object. For example, consider
a single Switch object with a security level of 4 that is displayed on two
panels. The first panel has a control level of 6 and the second panel has a
control level of 2. Only level 6 and higher operators are able to flip the
switch on the first panel; however, level 4 and higher operators have control
over the same switch on the second panel.

Viewing security can hide entire control panels from low level operators.
This parameter affects the entire control panel. As an example take a
control panel with a viewing security level of 6. If a level 5 (or lower)
operator logs on, he is unable to see the control panel. In fact, he does not
even know it exists because it is not listed in the Window menu and it is
not shown as an icon. If a level 6 (or higher) operator logs on, the control
panel instantly becomes available for display. This feature is useful for
hiding panels that are rarely used or that contain sensitive information.
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h- Lookout - [Process1 =]

File Edit Options Alams  Window Bun  Help

[™ Mormal Panel

[FPopun i FIWET
084101315 Administratar Mational Instruments Internal Use Only | <& | = 1 alarms

This example shows a Normal control panel in a normal state and a Popup
control panel in a minimized state. The Normal panel could easily be
minimized or maximized by hitting the appropriate arrow button.

The following example is a typical scenario involving full screen control
panels with multiple popup panels displayed at once.

This configuration maximizes the amount of information that you can
display at once; and it allows you to have any number of different
combinations of control panels displayed on your monitor.

h- Lookout - [Frocess1 =] - [Normal Panel] M= 3
File Edit Options Alams  Window Bun  Help = |ﬁ'|1|
[ Popup #1 = B3
A Popup #2

|o8A0135 | Administrator | Mational Instruments Intemal Use Only | <2 | = | 1 alarms
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This example displays a Normal control panel in a maximized state and
two Popup control panels in a “popped up” state.

Manipulating Panels

Panel Switching

© National Instruments Corporation

Lookout control panels utilize the Microsoft standard Multiple Document
Interface (MDI) techniques. You manipulate Lookout windows the same
way you do other windows in the Microsoft Windows environment.

It is common to have several or even dozens of control panels. Creating

a methodology for moving between your panels can be as simple or as
elaborate as you want. One effective method utilizes pushbuttons that
invoke other control panels. You connect the pushbutton output signal to
the activate or maximize data member of the control panel(s) you want to
affect. When the button signal goes high the respective panel(s) appear.

The following example shows a single pushbutton and X with its output
signal connected to two Popup control panels. The pushbutton is inserted
on a third maximized panel.

Pop_Up1 connections E
Select object... |

— Select member:

‘wiitable members: Existing connections:

activate

masimize
minirnize

print

Gelect | Iactivate

Pop_Up1.activate = Pl
Mew logical connection Clear |
— Signals:
Tags: Pushbutton  path tMode: IHeIative j
In: IE paroikos. dy. natinst. com e e ]
E|-- Process1 ;I [implicit]
-y $larm wvalue

Quit |
Help |

- Paste | Fb1
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When you toggle out of Edit Mode and depress the button, both Popup
control panels instantly appear, as shown in the following illustration. Of
course you could have connected the pushbutton to another Normal panel
instead, and it would have appeared as the new maximized panel.

_EI_-Lookoul - [Process1 =] - [Normal Panel] M= 3
File Edit Options Alams  Window Bun  Help = |ﬁ'|1|
[} Popup #2 S =] Jeas |Pop Up Panels 1 and 2|
1 1

|osAoi3:20 | Administrator | Mational Instruments Intemal Use Only | <2 | = | 1 alarms

Lookout Object Reference Manual

As you can imagine, there is no limit to the number of connections between
various signals and control panels. In fact, you can create complex
expressions/alarms that automatically call up specific control panels.

Another way to move between panels is through the use of function keys.
Like the $Keyboard object, each panel has its own set of data members
representing the function keys F1 — F24. The following example shows the
F2 data member of Panell connected to the activate data member of Panel2.
The F2 data member of Panel2 is also connected to the activate data
member of Panel3. This way an operator can depress F2 to page forward
through several panels.

Panel1 Panel2 Panel3

Panel3 Panell

:'\X
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In similar fashion, the F1 data member of Panel3 is connected to

the activate data member of Panel2 and the F1 data member of Panel2
is connected to the activate data member of Panell. So now,
Panel2.activate = Panell.F2 OR Panel3.F1. An operator
can depress F2 to page forward through the control panels and F1 to
page back through the control panels.

Special Considerations for “Home Panel”

To ensure users do not get lost when switching between panels, you might
define one panel as your master control panel, or home panel or computer
main menu. You could connect the activate data member of your home
panel to $Keyboard.Shift.F1, or perhaps to a pushbutton object. If
connected to the function key, any time the user presses <SHIFT-F1>

(no matter what panel he or she is looking at), the home panel is called,
returning the operator to a familiar control panel.

You might also want the home panel to maximize upon startup. If you have
already created a pushbutton to call the home panel, you can connect it to
the maximize data member.

The exclamation point (!) instructs Lookout to use the opposite of the
pushbutton value. At startup, the pushbutton is not depressed so its value is
FALSE. But because you are using the opposite of the pushbutton value,
Panell.maximize is TRUE at startup. Any time a user depresses
CallHomePb after this connection is made, nothing happens until the
pushbutton is released—at which time the panel is called.

Panel Print

You can easily print a control panel using the Print Panel command. This
function works equally well for both Normal and Popup panel types.

Print the contents of a panel by clicking on the panel control menu and then
on Print Panel, or by connecting a logical expression to the Print data
member of the desired control panel. A panel does not have to be visible to
be printed.

@ Note Certain metafiles look different on the printed page than they do on the display
screen. This means that parts of layered objects sometimes appear opaque on the screen,
but translucent when drawn on paper.
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@ Note When you print a Normal panel, it is printed at its defined Height and Width
parameters. If you define a panel whose Height and Width are at the default
400 x 300 pixel setting, maximize the panel, and then add graphic elements to the full
panel, those elements outside of the default 400 x 300 pixel range are not shown when the
panel is printed. To print all the elements on a maximized panel, modify the Width and
Height of the panel to match the full-screen dimension of the panel.

You can modify an existing control panel by toggling into edit mode and
right-mouse clicking on its title bar. You can also modify a panel with the
Object»Modify... menu command just like any other object.

Screen Resolution and Lookout Graphics

Lookout graphics and control panels appear different, depending on the PC
you are using and the resolution of your screen driver. When you position
a graphic (or any other display element) onto a control panel, Lookout
identifies the position you selected by recording the specific pixel position
of the graphic. (A pixel is the smallest possible dot on the screen.) Lookout
actually counts the number of pixels that the graphic is from the upper
left-hand corner of the screen. When you subsequently recall a panel,
Lookout knows the exact location to place the graphic.

The reason to bring this up is because different computer screen drivers
have different screen resolutions. VGA screens are 640 X 480 pixels. Super
VGA screens typically range from 800 x 600 pixels to 1024 x 768 pixels.
A panel created at 640 x 480 pixel resolution does not fill the screen of a
1024 x 768 super VGA monitor. A panel created at 1024 x 768 pixel
resolution will overflow the screen of a 640 x 480 VGA monitor.

It is best to create your panels using the display driver resolution of the
computer on which you intend to run Lookout. If you are creating panels
for use on multiple computers, consider developing panels using the
display driver resolution of the most common resolution monitor (if you
have a dozen Super VGA computers and one VGA computer, develop your
panels in Super VGA, not VGA). You will then have to modify the panels
slightly to fit on the less common resolution computer(s).

You can usually change the resolution of your screen from VGA to Super

VGA by changing System Settings in Windows Setup. Refer to your
Microsoft Windows manual for more information.
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Table 2-42. Panel Data Members

Data Members

Type

Read

Write

Description

<CTRL-F1> -
<CTRL-F24>

logical

yes

no

Each of these 24 data members
represent a function key, <F1> —
<F24>—when pressed in conjunction
with the <CTRL> key. Returns TRUE
when the panel is active and its
associated function key is pressed in
conjunction with the <CTRL> key.

<F1> - <F24>

logical

yes

no

Each of these 24 data members
represent a function key, <F1> —
<F24>. Returns TRUE when the
panel is active and its associated
function key is pressed.

<SHIFT-F1> through
<SHIFT-F24>

logical

yes

no

Each of these 24 data members
represent a function key, <F1> —
<F24>—when pressed in conjunction
with the <SHIFT> key. Returns
TRUE when the panel is active and its
associated function key is pressed in
conjunction with the <SHIFT> key.

activate

logical

no

yes

Upon transition from FALSE to
TRUE, calls control panel to focus or

pop up.

active

logical

yes

no

Returns TRUE when the panel is the
currently selected panel (i.e., it is
active).

maximize

logical

no

yes

Upon transition from FALSE to
TRUE, maximizes control panel,
replacing existing maximized control
panel.

© National Instruments Corporation
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Table 2-42. Panel Data Members (Continued)

Data Members Type Read | Write Description

minimize logical no yes Upon transition from FALSE to
TRUE, minimizes control panel to
icon state.

print logical no yes Upon transition from FALSE to
TRUE, sends the control panel to the
Windows Print Manager.
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The Pareto object class is one of the Lookout Statistical Process Control
(SPC) tools and can play an important role in your Total Quality
Management (TQM) program. This object class displays a frequency
distribution of occurrences sorted by category so that you can identify the
most frequently occurring anomalies or defects in your process.

The Pareto object class displays weighted and/or unweighted Pareto charts.
The charts can be interactive, automatic, or a combination of both. An
optional percentage line, showing cumulative percentage of factors, may be
displayed. The number of factors to display, which may be less than the
total number of factors defined, is user selectable. The chart background
color, as well as the label, weight, and color of each factor, can be defined
by the user.

The Pareto chart object definition dialog box is shown in the following
illustration.

Create Pareto E

MName:  |[EELEN]

Reset = I

™ &llow Interactive Choice [ Allaw Decrement Count

Bins to display = I

Mofactors  Mew factor = Factar ID: 1
Label =

Accept | I
[Ielete | T:Eht:
M Calor:

|| HE =
| peEeEEEEE EEEE

QK I Eancell Help |

Figure 2-64. Pareto Definition Parameters Dialog Box

Reset is a logical expression that, on transition from FALSE to TRUE,
resets all of the factor counts to zero.

Use Allow Interactive Choice to indicate whether the operator can
increment (and possibly decrement) factor counts by clicking the mouse
cursor on the Pareto chart object.
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Allow Decrement Count indicates whether the operator can decrement the
factor counts if you enable interactive choice.

Bins to display is the number of factor bins to display in the Pareto chart.
This can be a numeric expression or a constant.

Bins parameters enable adding, modifying, or deleting factors to and from
the Pareto chart. Label is the descriptive title for the factor. It can be a text
constant or expression. Weight is the bias you can apply for a factor if you
are going to display a weighted Pareto chart. It can be a numeric constant
or expression. Color is the color of the bar for the factor. Factor ID is a
number generated by the object to uniquely identify the current factor count
when it is being saved to or restored from the Lookout state file. It is a
visual indication to the user that a factor count is associated with a
particular Factor ID, and not with the Label.

The Pareto display dialog box is shown in the following illustration.

Faper colar:
N HE N
HENENEEEESN EEEE

¥ Weaighted Pareto

Cumulative percentage options

IV Show percentage line

Line color:

Cancel |

Figure 2-65. Pareto Display Parameters Dialog Box

Show percentage line determines whether a cumulative percentage line
will be displayed in the color selected by Line color.

Weighted Pareto determines whether the Pareto is displayed as a weighted
chart or an unweighted chart.
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Weighted or Unweighted Charts

Using the same Pareto object, you can display weighted or unweighted
Pareto charts. An unweighted Pareto chart shows which factors occur most
frequently. If the factors are of approximately equal importance, an
unweighted chart is a good indication of trouble spots.

100 Total: 118 Unweighted Pareto Total shown: 118

90
80
70
60
5']__ ____________________________

40
29 /24.6% 18/ 15.3%

30
20
50.0% 68.6% 84.7%
factor 5 (29) factor 1 (20) factor 2 (10) factor 4 (200) factor 3 (30)

[ 25.4%

Figure 2-66. Unweighted Pareto Chart

If some factors are much more serious than others, using a weighted Pareto
chart to ascertain the cost or exposure of a factor is a much more effective
tool for identifying problem areas. For example, in the unweighted Pareto
chart in Figure 2-66, factor 1 and factor 5 together account for 50 percent
of the defect occurrences. However, as you can see on the weighted Pareto
chart in Figure 2-67, factor 4 alone accounts for 60.8 percent of the total
expense of all defects.
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100 Total: 6250 Weighted Pareto Total shown: 6250
_______________________________________________________ E——
900 / 14.4% 750 £ 12.0% 580 / 9.3% 220 / 3.5%
e
75.2% 87.2% 96.5%
factor 4 (200) factor 3 (30) factor 5 (29) factor 1 (20) factor 2 (10)

Figure 2-67. Weighted Pareto Chart

Incrementing Factor Counts

You can use a Pareto chart to interactively or automatically increment
factor counts. In fact, the object can accept any combination of automatic
and interactive inputs.

If you select the Allow Interactive Choice option in the object definition
dialog box, the operator can manually increment factor counts. To do this,
the operator clicks the mouse cursor on the Pareto chart object. This pops
up box that lists all the possible factors you can choose. The factor that the
cursor is on when the operator clicks on the chart determines which factor
is highlighted when the dialog box pops up. In this example, the mouse
cursor was over the factor 2 bin.

Choose the factor

factor 1 (20
factor 2 [10]

If you select the Allow Decrement Count option in the object definition
dialog box, the Decrement button is displayed in the pop-up, allowing the
operator to decrement a factor count. Operators with a high enough security
level can correct errors if necessary.
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The Pareto object can use external connections to trigger the factor counts
automatically. You can connect a pushbutton, an alarm, an expression, a

PLC output, and so on, to a factor trigger to increment a factor count on a
transition from FALSE to TRUE. The following table lists data members
of the Pareto object class.

Table 2-43. Pareto Data Members

Data Members Type Read | Write Description

count.sorted1 — 1000 numeric yes no The count in the respective
sorted-by-count factor bin.

count.weighted.sorted numeric yes no The weighted count in the respective

1-1000 sorted-by-weighted-count factor bin.

count.weightedl — 1000 | numeric yes no The weighted count in the respective
unsorted factor bin.

countl — 1000 numeric yes no The count in the respective unsorted
factor bin.

factor1l — 1000 logical no yes On transition from FALSE to TRUE,
increment the respective factor count
by 1.

label.sorted1 — 1000 text yes no The label of the respective
sorted-by-count factor bin.

label.weighted.sorted text yes no The label of the respective

1-1000 sorted-by-weighted-count factor bin.

labell — 1000 text yes no The label of the respective unsorted
factor bin.

percent.sorted1 — 1000 numeric yes no The percent of the total count in the
respective sorted-by-count factor bin.

percent.weighted.sorted | numeric yes no The percent of the total weighted

1 -1000 count in the respective
sorted-by-weighted-count factor bin.

percent.weighted numeric yes no The percent of the total weighted

1-1000 count in the respective unsorted
factor bin.
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Table 2-43. Pareto Data Members (Continued)

Data Members Type Read | Write Description

percentl — 1000 numeric yes no The percent of the total count in the
respective unsorted factor bin.

total numeric yes no The total of all unweighted factor
counts in all defined factors.

total.shown numeric yes no The total of all unweighted factor
counts in all currently displayed
factors.

total.shown.weighted numeric yes no The total of all weighted factor counts

in all currently displayed factors.

total.weighted numeric yes no The total of all weighted factor counts
in all defined factors.

visible logical yes yes When TRUE, the Pareto chart
becomes visible on the control panel.
When FALSE, it is invisible. The
default value is TRUE.
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PID

The PID object compares a Process Variable to a Setpoint. If there is a
difference, it calculates the error and adjusts its output to compensate until
the Process Variable is equal to the Setpoint.

PID stands for Proportional-Integral-Derivative. These are three factors in
the equation that can be applied against the calculated error. You specify
Gain which is the proportional factor, Reset (the integral factor), and Rate
(the derivative factor) to define how the object responds to the error.

@ Note The way in which the PID object responds to your process can vary greatly
according to the parameters you enter and the process you are controlling. Any discussion
regarding tuning of a PID loop falls outside of the topics addressed in this manual.

Create PID Controller E
Name: |F'ID1 Type IPosition j

Process Yariable = I

Min I

Setpoint = I ID_ W
Manual Dutput = I IU_ W
Sample Pulse = l— Resst = l—
Gain = I Rate = l—
Autornatic Enable = l— Wtaut Tiime: W
LovrlbnitsEratie = ID”— ¥ Add proportional incremet
High Limit: Erratle = Ifo " Freeze Enable

QK I Cancel | Help |

Figure 2-68. PID Definition Parameters Dialog Box

Type selects either positional control or velocity control. Detailed
descriptions of both control modes are provided in the following sections.

Process Variable (PV) is typically the numeric signal from the field that
you want to control. The PID loop equation does not expect this value to be
normalized; rather the PID object performs the scaling of loop input and
output values from engineering units.

Setpoint (SP) is typically the value of a Pot object, a constant numeric
value, or the output signal from another PID object in a cascaded loop. Like
the process variable, the setpoint is also scaled internally by the PID object.
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Setpoint Min and Max are numeric constants that specify the range of SP
and PV in engineering units.

Manual Output is a numeric parameter that specifies the output of the
object when it is in manual mode; that is, when the Automatic Enable
expression is FALSE. Users typically enter either a constant, or the name
of a Pot object in this field.

Output Min and Max are numeric constants that specify the range of the
object output signal. The output is often referred to as the manipulated
variable (MV).

Sample Pulse indicates the frequency at which the PID object executes.
This parameter field can contain either a numeric constant or a logical
variable. If you use a numeric constant (like 0: 01 for one second), the
object calculates a new output value at the defined frequency. If you use a
logical variable, then the variable should pulse at some desired frequency.
Any time the pulse transitions from FALSE to TRUE, the object calculates
a new output value. It is very important not to over-sample your data. Start
with a slow sample rate.

Gain (K,) is a numeric parameter that determines the overall sensitivity
of the PID loop to changes in error. A gain value of 1.00 changes the
proportional increment of the PID equation by 50 percent when there is a
50 percent change in error. A gain value of 0.25 changes the proportional
increment by 12.5 percent with a 50 percent change in error.

Reset (7)) also referred to as integral time, is a numeric parameter that
specifies the amount of time it takes for the integral sum increment of the
PID loop equation to react to a given change in error. For example, if the
error suddenly changes by 20% and reset = 0:10 (10 seconds), the integral
increment of the PID loop increases at a rate of 0.5 percent per second until
it has changed by 20 percent after 40 seconds. This 20 percent contribution
is multiplied by the gain, so if the gain is 2.0, the integral term contributes
40% to the loop output in this example. In other words, the shorter the reset
time, the faster the object output responds to a change in either PV or SP.

Rate (T) also referred to as derivative time, is a numeric parameter that
dampens loop response. It is calculated based upon the rate of change of PV
and adds an increment to the output that attempts to anticipate and slow the
change in PV. As an example, if PV is increasing by 10 percent per minute,
and rate is 0:30 (0.5 minutes), the derivative increment is calculated as
—(10%/min. x 0.5 minutes)= —5% (or —0.05). So the derivative term would
contribute —5% to the output if the gain is 1.0.
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Automatic Enable specifies whether the loop controller is operating in
automatic mode or manual mode. When it is ON, controller is operating in
automatic mode and the output signal is being calculated using the PID
algorithm. In manual mode, the output signal is equal to the Manual
Output input signal.

The PID object provides bumpless transfer from manual to automatic
operation—when the controller is switched from manual to automatic,
its output begins changing from the current manual output setting.
Contrast this with a loop controller without bumpless transfer. When
such a controller is in manual, the integral term continues to accumulate.
When the controller is switched to automatic, the loop controller would
immediately go to a high or low output.

Add proportional increment specifies whether the loop equation adds
the proportional increment of the PID equation to MV. This value is
typically ON.

Freeze Enable specifies whether the loop bias should be frozen or actively
back-calculated when the controller output signal goes out of range. In
either case, the loop controller is protected from integral wind-up, but if
Freeze Enable is OFF (recommended setting), the bias is actively
back-calculated to prevent controller overshoot when PV comes back into
range.

The PID object protects against integral windup in one of two selectable
ways: It either freezes the bias term when the controller output goes out

of range, or it actively back-calculates the bias so the controller responds
smoothly with less chance of overshoot when its output returns to range.

Output Time is a numeric constant that specifies the time domain of the
controller output when operating in velocity mode. For example, if the
object output controls a value with dimensions of inches per minute, output
time would be 1:00 (one minute).

Low Limit Enable is used in velocity control mode. It is an optional
logical signal that clips the PID output to a value grater than or equal to
zero when TRUE. This input can be used to signal the controller that the
low limit switch on the controlled device has been activated.

High Limit Enable is used in velocity control mode. It is an optional
logical signal that clips the PID output to a value less than or equal to zero
when TRUE. This input can be used to signal the controller that the high
limit switch on the controlled device has been activated.
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PID Positional Control

When you select Position, the PID object calculates the output as
follows:

MV = K_(e, +integral sum, — T ;/dT(Pv,—Pv,_,))
where:
dT = time increment between current and previous calc.
MYV = controller output (manipulated variable)
K. = controller gain (units: % output / % error)
e, = error at sample n (error = SP — Pv,)
integral sum, = integral sum,_; + dT / T; (e, — e,_;) also called bias
T4 = rate, or derivative time

Pv, — Pv,_; = change in PV from previous to current calculation

PID Velocity Control

dMV = MV, -

Lookout Object Reference Manual

The output of the velocity form of the PID equation is the velocity or rate
of change of the output signal. The velocity form of the PID equation is the
first derivative of the position form of the PID equation with respect to
time, so the result is the rate of change of the controller position.

When you select Velocity, the object calculates the output as follows:
MV, ,=K.((e,—e,_ ;) +T,e,/T;+Ty/T(Pv,—2PV, _,+PV, _,))
where:

MV = controller output position (manipulated variable)

dMYV = contoller output velocity

K. = controller gain (units: % output / % error)

e, = error at sample n (error = SP — Pv,)

T4 = rate, or derivative time

PV = process variable
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Table 2-44. PID Data Members

Data Members Type Read | Write Description
Error numeric yes no This is the difference between the
Setpoint (SP) and the Process
Variable (PV).
Output numeric yes no This is the PID controller output

value, also called MV, or the
manipulated variable. This value is
either the result of the PID loop
equation or the Manual Qutput,
depending on the state of Automatic
Enable.

Comments The proportional term of the PID equation contributes an amount to the
output equal to the error multiplied by the Gain. This provides an immediate output
compensation when the error value changes.

The integral term of the PID equation calculates a running total of the error
summed (or integrated) over time—think of this increment as adding the
area under the curve of a plot of error versus time. While SP is greater than
PV, the integral term is increasing, and while PV is greater than SP, the
integral term is decreasing. The sensitivity of the integral output is set by
the gain and the reset variables. Integral action can be eliminated by setting
Reset to a higher number. At least some Integral action is required,
however, for the loop controller to operate properly with bias adjustment.
If you do not use any Integral, you may experience offset, a condition in
which the output is adjusted to compensate for the error, but not enough to
correct the error.

The derivative term of the PID equation acts to dampen the change in PV
by adding a negative value for a positive-going PV and a positive value for
a negative-going PV. Because PV is subject to sudden small changes and
signal noise in many process loops, derivative action can cause a loop to
respond erratically. Rate can be set to 0, especially when initially tuning the
loop, to eliminate derivative action. Derivative action dampens process
loops that tend to oscillate around the setpoint and thus provide better loop
response. Rapidly changing loops such as liquid flow control in a pipe may
not benefit from derivative action, but more sluggish loops that tend to build
momentum, such as temperature control, benefit from derivative action by
preventing overshoot and dampening oscillatory action.

© National Instruments Corporation 2-141 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

Pipe

Pipe displays different color rectangles (pipes) on a control panel as
defined by the values of Conditional expressions. Pipe determines which
color rectangle to display based on the order and current status of your
Conditional expressions. If several Conditional expressions are TRUE
at once, Pipe displays the color associated with the first TRUE expression.
Conditional expressions must result in logical values.

MName:  |(E=

Conditional expressions:

Mew Pipe E

Fipe colors:

=

Elseif= |

Elseif= |

Elseif= |

Elseif= |

Elze

QK | Cancel | Help |

Pipe Data Members

Figure 2-69. Pipe Definition Parameters Dialog Box

Table 2-45. Pipe Data Members

Data Members

Type

Read

Write

Description

none

Pipe does not have data members.

Comments You can easily create a complex piping network scheme (including
changing colors) with a single Pipe object. Display the object on a control panel and
copy the pipe display with the shift-drag method to create additional pipes with the
same parameters. You can then move, resize, and group the pipes as you choose.
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Playwave connects Microsoft standard wave form files (. wav) to events in
Lookout. Playwave plays the audio file specified by Wave file when Play
when transitions from off to on. Play when is a logical expression and
might range from a simple pushbutton, to a digital input from a PLC, to an
alarm generated in Lookout. You can also create your own custom audio
files with various software products. Therefore, you can connect individual
alarms to custom wave files to be played each time an alarm goes TRUE.

Playwave Data Members

Create Playwave: E

M ame:

Flay when = I

W ave file: I

Browse... |

ok |

Cancel |

Help |

Figure 2-70. Playwave Definitions Parameters Dialog Box

Table 2-46. Playwave Data Members

Data Members

Type

Read | Write

Description

none

Playwave does not have any data

members

Comments Many computers do not come equipped with quality speakers built in. If
this is the case, your wave files may sound distorted or may even be inaudible. If you
want to take advantage of the Playwave feature, you may need to buy additional
hardware, in particular a Microsoft Windows compatible sound board (with Windows
driver) and external speakers.
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Pot is a potentiometer that you use to change numeric setpoint values. You
can display Pots on a control panel as a knob, vertical slider, horizontal
slider, increment/decrement pushbuttons, or digital entry. You can also use
Pots as multiple-position switches.

If you change the background color of a panel and add a Pot object
displayed as a slider, its color is always gray. To change the background
color of a Pot to match your panel, select the Pot object, then pick
Change»Background Color from the menu.

Mew poltentiometer: E
MName: |(EL0]

Minimum: IU

M airnum: |1 oo

Resalution: |1
— Position source

@ Local

 Femate
’VUHL:=|
= DDE
SEnyiGe: l—
Tapie: l—
IEerm: l—

Control security level: ID ¥ Log events

QK I Eancell Help |

Figure 2-71. Pot Definitions Parameters Dialog Box
Minimum is the lowest value signal the pot will generate.
Maximum is the highest value signal the pot will generate.

Resolution is the smallest increment of change, or detent spacing the
Pot supports.

Position source determines where the value of the Pot resides. Local
indicates the value of the Pot lies within the object itself—on the control
panel.

Remote Pots get their values from a remote source, often the register on a
controller they are connected to. Adjusting the Pot changes the value in
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the register, and changing the value in the register adjusts the Pot. In effect,
the Pot is tracking a remote value. This is especially useful when you want
to prevent Lookout from changing the value of setpoints or registers upon
initial startup, or reconnection of lost communication.

The Remote option calls for a URL to locate the data member you want to
connect to. The URL field is green, and you cannot use a complex
expression as a URL. If you need to use one RadioButton for several
purposes, you can use a Symbolic Link to make a more complex connection
than that possible with a URL.

You can right-click in the URL field and use the URL Editor dialog box
to assemble the URL, in the same way you use the Lookout expression
editor.

A remote position source connection is completely reciprocal. A change in
your Lookout control changes the data member that control is remoted to.
Any change in that data member also changes the control. It is not
necessary, and is incorrect, to use the Edit Connections dialog box to
connect a control object to its controlled data member.

Because the remote connection is reciprocal, you can only make such a
connection to a data member that is either writable, or readable and
writable.

When a process with remoted controls first opens, those controls take their
initial values by following the URL to read the data members they are
remoted to. The control will be covered by a red X to indicate that the
remote connection is not functioning.

@ Note You should use Remote to connect a control in a client process to a data member
in a server process. Connections inside a single process can be made using Object»Edit
Connections.

Because complex expressions are read-only values, you cannot remote
directly to them. For the same reason, you cannot remote one control to
another control’s (intrinsic) data member (though you can remote a
control to another control’s value data member).

Much like Remote Pots, DDE (Dynamic Data Exchange) Pots get their
values from a remote source. This could be a cell in a spreadsheet, another
DDE aware application, or a second copy of Lookout running on the
network. The last DDE parameters used on any object automatically
become the default values for any new DDE object.

© National Instruments Corporation 2-145 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it.

The Log events option creates a permanent audit trail for the object—who
did what and when. All adjustments of the Pot are logged to disk, including
the time of the adjustment, the operator account name, and what adjustment

was made.
Insert: PressSetPoint | ]

= m 100

(] [ [ [«

knaok
Cancel |
Figure 2-72. Pot Display Parameters Dialog Box
@ Note You can modify the background color on vertical and horizontal sliders with the

Change»Background color... menu command. You can modify the font and font color of
digital Pots using Change commands.

Pot Data Members

Table 2-47. Pot Data Members

Data Member Type Read | Write Description
(implicit) numeric yes no Current value
decrement logical no yes When this data member value

transitions from FALSE to TRUE, the
implicit value of the Pot object
decreases by the Pot Resolution
amount.

enable logical no yes If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is on. This input is ignored for
non-DDE TextEntry objects.
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Table 2-47. Pot Data Members (Continued)

Data Member Type Read | Write Description

enterValue logical no yes Under specific circumstances, when
this value transitions from FALSE to
TRUE, pops up a Enter new value
dialog box for an operator to use in
entering a value for the Pot. See the
note following the table for more
detailed information.

The enterValue data member is
designed for use under unusual
circumstances, in particular when
pointing devices are not available on a
computer running Lookout. Because
of its unusual operation, this data
member should not be used unless it is
necessary for hardware reasons.

increment logical no yes When this data member value
transitions from FALSE to TRUE,
the implicit value of the pot object
increases by the Resolution amount.

reset logical no yes While this value equals TRUE, the
control will be set to the value in
resetvalue.

resetvalue numeric no yes Sets the value a control will take when
the reset data member transitions
from FALSE to TRUE.

value numeric yes yes The current value of the control. If
you have remoted this control, then
value is the current value of the
position source.

visible logical no yes When FALSE, the Pot object cannot
be seen on the display panel. When
TRUE, the Pot can be seen and
controlled.
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@ Note When the entervalue input transitions from FALSE to TRUE, and if the Pot is
visible, if Lookout is not in edit mode, and if the Pot has at least one digital display, the
Enter new value dialog box pops up so an operator can input a value, just as if the operator
had clicked on the digital display.

The numeric format and position used for the dialog box are based on the digital display
for a Pot. Even if the panel containing the Pot digital display is inactive, the Enter new
value dialog box will pop up. You can prevent this by predicating the entervalue input
on the panel's active data member.

Comments Potentiometers are one of the most common control objects used in process
controls. Using Pots, a plant operator can make setpoint changes with the mouse. Pots
also work well as H-O-A switches. To create an HOA switch with a Pot, specify the
minimum as 1, the maximum as 3, and the resolution as 1.

The increment and decrement data members enable quick connection of
Pot objects to $Keyboard and Panel function keys, and screen Pushbuttons.
These are often used to control Pot objects when Lookout is running on an
industrial PC platform that has restricted or no mouse functionality.

Lookout Object Reference Manual 2-148 www.natinst.com



Chapter 2 Lookout System Objects

Pulse

Pulse is a timer that generates a periodic pulse of a specified duration.
When On/off signal transitions to ON, the output signal turns on for the
pulse duration time and then turns off for the remainder of the period. The
output signal immediately turns off when the On/Off signal goes low.

Timer period is the time interval for the full pulse cycle, and Timer
duration is the width of each pulse. These parameters can range from
0.0 seconds to several years, with an effective resolution of 0.1 seconds
over the entire range. Timer duration should always be less than Timer
period.

The object is represented on a control panel by showing the time remaining
before the output changes state. It is depicted in the format defined by the
Display format parameter. It is updated approximately once per second.
If the On/Off signal is FALSE, it shows OFF.

Create Pulse timer: E
Mame: Timerl

On/off signal = l—
Timer period = l—
Timer duration = I

Dizplay format: lm

Ok | Cancel | Help |

Figure 2-73. Pulse Definition Parameters Dialog Box

The On/off signal is a logical expression while Timer period and Timer
duration are numeric expressions. Normally, these are simple time
constants such as 0:20 (twenty seconds). See Numeric Data Members in
Chapter 2, How Lookout Works, of the Getting Started with Lookout
manual for information on entering time constants.
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Figure 2-74. Pulse Display Parameters Dialog Box

Table 2-48. Pulse Data Members

Data Members Type Read | Write Description
(implicit) logical yes no Logical timer value
Comments Pulse can be used to periodically open a valve for a specified time duration.

It can also act as a flasher to turn text and graphic signals on and off for display

purposes.

Related Objects DelayOff, DelayOn, Interval, OneShot, TextEntry

Lookout Object Reference Manual
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Pushbutton

Pushbutton generates a logical signal for receipt by other objects. A
pushbutton changes state when you position the cursor over it and press the
mouse button, trackball, touchscreen, or space bar. The pushbutton remains
depressed and the output signal remains high until you release the button.
If a Verify on message is defined, the operator must first acknowledge the
message, then the output signal goes high, but only momentarily.

Create pushbutton E

M ame: (=

Buttan text: |

Werify on = I
- Position source—————————————————
@ Local

i Remate ————
E |

I | Lt cutput

" DDE

SEnyiGe: I
Tapie: I
IEerm: I

Control security level: IU ¥ Log events

QK | Cancel | Help |

Figure 2-75. Pushbutton Definitions Parameters Dialog Box

Button text displays the specified text on the pushbutton.
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Use Verify on to create a dynamic text expression to be displayed in a
message dialog box. See Chapter 6, Security, in the Lookout Developer’s
Manual for more information on security.

MotorStartPb =]

@ Do you want to start Maotor 27

[ila] |

Figure 2-76. Verification Message Dialog Box

Position source determines where the value of the Pushbutton resides.
Local indicates the value of the Pushbutton lies within the Pushbutton
itself—on the control panel. If the pushbutton is not depressed its signal
is OFF, if depressed its signal is ON.

Remote Pushbuttons get their values from a remote source, often the
register in a controller they are connected to. Depressing the pushbutton
changes the status of the register, and changing the status of the register
depresses the pushbutton.

The Remote option calls for a URL to locate the data member you want to
connect to. The URL field is green, and you cannot use a complex
expression as a URL. If you need to use one RadioButton for several
purposes, you can use a Symbolic Link to make a more complex connection
than that possible with a URL.

You can right-click in the URL field and use the URL Editor dialog box
to assemble the URL, in the same way you use the Lookout expression
editor.

A remote position source connection is completely reciprocal. A change in
your Lookout control changes the data member that control is remoted to.
Any change in that data member also changes the control. It is not
necessary, and is incorrect, to use the Edit Connections dialog box to
connect a control object to its controlled data member.

Because the remote connection is reciprocal, you can only make such a
connection to a data member that is either writable, or readable and
writable.
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When a process with remoted controls first opens, those controls take their
initial values by following the URL to read the data members they are
remoted to. The control will be covered by a red X to indicate that the
remote connection is not functioning.

@ Note You should use Remote to connect a control in a client process to a data member in
a server process. Connections inside a single process can be made using Object»Edit
Connections.

Because complex expressions are read-only values, you cannot remote
directly to them. For the same reason, you cannot remote one control to
another control’s (intrinsic) data member (though you can remote a
control to another control’s value data member).

When you select the Remote option, you can choose whether or not the
Pushbutton latches its output. The Latch output check box configures
Lookout for controlling a latching-relay.

When a user clicks on a Pushbutton that has latching selected, the
pushbutton remains depressed, sending an ON signal (TRUE or high) until
the Remote Position signal turns ON. Assume for example that an operator
clicks on MotorStartPb, configured above. The pushbutton remains
pushed in, sending a TRUE signal, until PLC.C101 goes TRUE. As soon
as PLC.C101 goes TRUE, the pushbutton releases.

Much like Remote Pushbuttons, DDE (Dynamic Data Exchange)
Pushbuttons get their values from a remote source. This could be a cell in a
spreadsheet, another DDE aware application, or a second copy of Lookout
running on the network. See Chapter 5, Dynamic Data Exchange, in the
Lookout Developer’s Manual for information on Service, Topic, and Item
parameters.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it. See
Chapter 6, Security, in the Lookout Developer’s Manual for more
information on security.
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The Log events option creates a permanent audit trail for the object—who
did what and when. Any depression of the Pushbutton is recorded to disk,
including the time the button was depressed, and the operator’s account
name. See Chapter 7, Logging Data and Events, in the Lookout
Developer’s Manual for more information on logging events.

Display pushbutton: MotorStartPb | ]
Text colar

Button colar
[N N
ECENEER

 Justify left

& Justify centered

Style
. & Button
& Transparent
Ok, |
Cancel |

 Justify right

Font... |1DptAriaIEloId

Figure 2-77. Pushbutton Display Parameters Dialog Box

Table 2-49. Pushbutton Data Members

Data Members Type Read | Write Description

(implicit) logical yes no Value of object (TRUE when button is
depressed)

enable logical no yes If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is on. This input is ignored for
non-DDE TextEntry objects.

reset logical no yes While this value equals TRUE, the
control will be set to the value in
resetvalue.

resetvalue numeric no yes Sets the value a control will take when
the reset data member transitions
from FALSE to TRUE.
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Table 2-49. Pushbutton Data Members (Continued)

Data Members

Type

Read

Write

Description

value

numeric

yes

yes

The current value of the control. If
you have remoted this control, then
value is the current value of the
position source.

visible

logical

no

yes

When FALSE, the Pushbutton cannot
be seen on the display panel. When
TRUE, the button can be seen and
controlled.
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RadioButton
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The RadioButton object creates a set of radio buttons on your panel. You
can have from 2 to 40 buttons in a set. Only one button at a time can be
activated in each radio button group.

Create Radio Buttons E

Name: IHadio1

Buttons [2-40]): |3

Button labels [comma separated):

one, two, three]

Pasition Source
@ Local

" Remote
’VUHL:= f
V Logevents Security level: IU

QK I Eancell Help |

Figure 2-78. RadioButton Definition Parameters Dialog Box

Set the Buttons (2-40) in each set. You can have as many as 40 buttons in
each group, but you must have at least 2.

Position source determines where the value of the RadioButton resides.
Local indicates the value of the RadioButton lies within the object
itself—on the control panel.

The Remote option tells Lookout to initialize the RadioButton value from
a remote source. Adjusting the RadioButton changes the value in the
register, and changing the value in the register adjusts the RadioButton. In
effect, the RadioButton is tracking a remote value. This is especially useful
when you want to prevent Lookout from changing the value of setpoints or
registers upon initial startup, or reconnection of lost communication.

The Remote option calls for a URL to locate the data member you want to
connect to. The URL field is green, and you cannot use a complex
expression as a URL. If you need to use one RadioButton for several
purposes, you can use a Symbolic Link to make a more complex connection
than that possible with a URL.
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You can right-click in the URL field and use the URL Editor dialog box
to assemble the URL, in the same way you use the Lookout expression
editor.

A remote position source connection is completely reciprocal. A change in
your Lookout control changes the data member that control is remoted to.
Any change in that data member also changes the control. It is not
necessary, and is incorrect, to use the Edit Connections dialog box to
connect a control object to its controlled data member.

Because the remote connection is reciprocal, you can only make such a
connection to a data member that is either writable, or readable and
writable.

When a process with remoted controls first opens, those controls take their
initial values by following the URL to read the data members they are
remoted to. The control will be covered by a red X to indicate that the
remote connection is not functioning.

@ Note You should use Remote to connect a control in a client process to a data member in
a server process. Connections inside a single process can be made using Object»Edit
Connections.

Because complex expressions are read-only values, you cannot remote
directly to them. For the same reason, you cannot remote one control to
another control’s (intrinsic) data member (though you can remote a
control to another control’s value data member).

@ Note You cannot break a group of radio buttons into multiple rows.

Enter any text for the buttons in the Button labels field. Separate each
button label with a comma. If you need to include a comma or a backslash
in any button text, precede that character with a backslash(\). If you want
to leave a button blank, you can enter two commas without any text or
numbers between the commas. You do not have to enter a label for every
button. Lookout will leave each button after your last label entry blank. If
you enter more labels than you have set buttons, your labels will be
preserved but not displayed.

To log changes in button state, check the Log Events checkbox.
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Security level sets the minimum security level an operator must have to
change the radio buttons.

Create Display: m

—Style — Preview

@ Left & Vertical

& Cantar © Horizantal Frame style

 Right & Mone  White  Black ‘

Text Color: Background Colar: [~ Transparent
Fant... | 10 pt Avial Bold OK I Cancel

Figure 2-79. RadioButton Display Parameters Dialog Box

Create Display: m

—Style — Preview
¢ Standard Pushbutton

= e

Select OMN graphics |

— Justification Crientation
@ Left & Vertical
& Cantar o M Frame style
" Right B ( & MNone " White " Black ‘
Text Color; Background Color. [~ Transparent
[ | [l N
[ D] [ H ENEEER

Fant... |1DptAriaI Bold OK | Cancel

Figure 2-80. RadioButton Display Parameters Dialog Box with
Custom Graphics Chosen
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You can use a standard Lookout pushbutton, standardized radio buttons,
or custom graphics for your radio button groups.

Notice that you cannot enter text in the Create Display dialog box. You
must enter any text you intend to use in the RadioButton Definition
Parameters dialog box. You can change font and text size in the Create
Display dialog box. The first text label you entered for your radio button is
displayed in the Preview field so you see the effect of font changes.

The default display uses a standard Radio Button display. You can adjust
text and background color for any of your display choices.

Selecting Standard Pushbutton displays standard on/off buttons in your
radio button array.

Select Customized Button for a free range of choices from the Lookout
graphics library, or create your own ON/OFF indicators for a radio button
array. See the Creating Custom Graphics section of Chapter 2, Graphics,
in the Lookout Developer’s Manual for detailed information on creating
your own graphics for use on a Lookout control panel.

Set the Orientation of the radio button array to horizontal or vertical by
checking the appropriate checkbox. Set label text Justification and button
Frame style in the appropriate fields.

Related Objects L3Pot, L3Pushbutton, L3Switch, Pot, Pushbutton, Switch

RadioButton Data Members

Table 2-50. RadioButton Data Members

Data Member Type Read Write Description

1-40 logical yes no Reports ON/OFF status of each button in a
radio button set.

current numeric yes no Reports which radio button is active in a set.

(implicit) numeric yes yes Radiobutton value.

value numeric yes yes Number of the currectly active radiobutton.

visible logical yes yes Controls visibility of a radio button set.
Default=TRUE.
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Recipe objects are an efficient means of importing large arrays of data
(namely recipes and their ingredients) into Lookout using an Excel (. x1s)
spreadsheet. Once created and implemented, the operator can easily and
quickly change the current recipe with the click of the mouse, thus selecting
a new set of ingredients.

The best way to describe how the Recipe class works is to step through a
typical example, in this case involving cookie manufacture.

There are two steps to creating and implementing a recipe object. First,
you define your recipes with their respective ingredients in a spreadsheet
program such as Excel (anything that creates an . x1s file will
work—including Lotus 123). You can define up to 1,000 recipes in a single
.x1s file. Each recipe can have up to 255 ingredients. Three cookie recipes
are defined in this spreadsheet.

X Microsoft Excel - Cookies.xls

ﬁEile Edit %iew |nsert Format Tools Data DAQ  Serial GFIE  Window
Help =& x]
DSE &lale] -3 ofod| = £ 21Z il
Mz Sans Serif = o 5] Bl[lgl glglgll $|%| y |*_I
a7 =
A |B|c|D|E|F|G|H|I1|J|K|[L|M|N|O]|T
E
i = = 1]
5 %2 2 = o 2
AL AR 2] =
- s o © =g g E T o
s 52223 %28 £s828 5
1 CEfdTacLsSSasadsH
2 |Chocolate Chip 100 50 60 10 8 5 6 3 8 7 0 0 60 43
3 |Oatmeal 120 45 50 15 14 3 5 4 7 550 0 0 51
4 |Ginger Snap 110 40 40 8 11 4 4 5 9 8 057 0 638
5
|l i cookIES |« | LIJJ
Ready | Sum=0 | | | | [ 4

The first row of the spreadsheet is reserved for ingredient names. They
begin in column B. These ingredient names later become alias data
members of the Recipe object. Therefore, ingredient names must be
unique. They cannot have the same name as a native data member (see
the Recipe Data Member table for data member names). Also, you cannot
name an ingredient missing; this is a reserved word. Valid characters in
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an ingredient name include A — Z, 0 — 9, the dollar sign ($), and a period
(.).If youenter Hi_@#! ! There as an ingredient name, Lookout names the
alias HiThere. Alias names are case sensitive.

Beginning in Row 2, Column A lists the names of the various recipes.
Recipes follow the same naming convention as ingredients. Each recipe is
followed by its unique ingredient values.

Ingredient values can represent process inputs, parameters, and outputs.
Process inputs typically represent raw materials and other inputs consumed
in the batch process. Examples include the number of eggs consumed,
amount of flour used, amount of energy consumed, possibly even work
hours required or amount of traceable fixed costs consumed.

Another type of ingredient value is a process parameter. Process parameters
identify operational settings such as furnace cooling time, an air pressure
setpoint, or a Low pH alarm limit. Process parameters might also include
identifications of specific equipment to be used during the batch process.

The third type of ingredient value is a process output. Such an ingredient
value might represent the number of finished cookies expected from the
batch, amount of byproduct expected, or a cost variance calculation based
on the selected recipe.

Ingredient value quantities may be specified as constants or as equations
based on other formula parameters such as batch size.

The second part of defining a recipe involves defining a recipe object in

Lookout.
Mame: IEookieH ecipe

Security levels

Chooze recipe: |2
Load recipe file: IS

V Logevents

QK I Eancell Help |

Figure 2-81. Recipe Definition Parameters Dialog Box
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The first recipe dialog box defines security and event data logging.

Choose recipe security level specifies the minimum security level an
operator must have to be able to select a recipe from all the recipes listed
in the currently selected spreadsheet file.

Load recipe file security level specifies the minimum security level an
operator must have to be able to select a different spreadsheet file.

The Log events option creates a permanent audit trail for the object—who
did what and when. Any selection of a different recipe or recipe file is
logged to disk, including the time the action occurred and the operator’s
account name. See Chapter 7, Logging Data and Events, in the Lookout
Developer’s Manual for more information on logging events.

After defining security and event data logging, Lookout presents you with
a file selection dialog box.

CookieRecipe EHE
Look in: IaSamples j gl l_
B rawpurmptxls
File narne: ICDDkies.xIs Qpen |
Files of type: IMS Excelfiles(*xls) j Cancal |

Select the cookies.x1s spreadsheet file because it has the three batch
recipes in it.
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Once a file is selected, Lookout presents a list of recipes.

CookieRecipe | ]

IChDCDIate Chip Presimns

d

Mext
Ginger Snap

Cancel |
—recipe file
File: chprogram fileshnational Lemal |
instrumentshlookoutsamplesicookies xls
Yersion loaded: Fri Dec 12 12:18:52 1997
Contains 3 recipes x 14 ingredients

As you can see, the recipe names come from column A of the spreadsheet.
You can use the Previous and Next buttons to identify a recipe from among
the list, or type the name in the data entry field above the list. (This same
dialog box appears later when an operator clicks on the pushbutton
representing this object.) Click on OK to choose the recipe you want to use.
Select the recipe for oatmeal cookies.

The recipe file Load button invokes the file list dialog box, described
previously. Click on this button to select a new . x1s file.

@ Note If the recipe is changed in the spreadsheet, the change is noted in the recipe file
dialog box—but the values currently resident in the object data members remain intact.
The operator must load the spreadsheet again to update the copy of the recipe file in
Lookout. If you select a new . x1s file to load but click on the Cancel button, it does not
update! You must select OK for the recipe to actually be loaded.
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After loading the spreadsheet, Lookout presents the display
parameters box.

Display recipe: CookieRecipe

Text calor

Background style Frame style
OsEREREER EEEN ST L
Background color nse e
D. .  Rectangle & Mone
........ .  Transparent
 Justify left & Justify centered  Justify right

Chocolate Chip|

Font... |1DptAriaIEloId

K

Cancel |

Figure 2-82. Recipe Object Display Parameters Box

After you choose the object display parameters, you can paste it into the
panel.

When you select a new recipe, Lookout writes the ingredient values for the
selected recipe into the corresponding data members of the object.

Lookout Object Reference Manual
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The actual number of data members that a recipe object has is based on the
number of ingredients within it. This is best demonstrated by looking at the
Insert Expression dialog box.

Insert expression E
IEookieHecipe.Butter
Dizplay Type: Inumeric 'l Path Mode: IHeIative j
— Signals:
Paste | CookieR ecipe. Butter
IE paroikos. dy.natinst. com j Contents:
ity AlarmS =] BrownSugar. unavail -
ity AlarmB o Butter
iy AlarmHelpPanel Butter.lagical
-y AlamHelpPh Butter.tat
-y AlamHelpPbl Butter. unavail
-y CockiePanel Chocalate
¥y CoockiePanelPb Chocaolate. lagical
-y CockieRecipe Chocaolate.tst
-~y Count Chocolate. unavail
-y Data_cav Cinnaman
-~y DatalogTrend Cinnaman. logical
by Flow Cinnaman.txt
-~y FoatCount x| ¥4 Cinnaman. unavyai x|
Recipe hUMmeric
Cancel | Help |

Notice that there are four data members for each defined ingredient. Actual
data member names vary from object to object, depending upon your recipe
ingredients. However, the four readable data member types for each

ingredient are consistent.

Recipe Data Members

Table 2-51. Recipe Data Members

Data Member Type Read | Write Description

(implicit) text yes no Name of currently selected recipe

B-1V numeric yes no Each letter, B through IV, represents a
column in the spreadsheet. The value
of the data member is the numeric
amount of the ingredient for the
currently selected recipe.
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Table 2-51. Recipe Data Members (Continued)

Data Member Type Read | Write Description
B.logical through logical yes no Each letter, B through IV represents a
IV.logical column in the spreadsheet. Returns

TRUE (ON) if the amount of the
ingredient in the spreadsheet cell for
the selected recipe is greater than
zero. Returns FALSE if the specified
amount for the ingredient is zero.

B.txt — IV.txt text yes no Each letter, B through IV represents a
column in the spreadsheet. The value
of the data member is the textual
amount of the ingredient for the
currently selected recipe.

B.unavail through logical yes no Each letter, B through IV represents a
IV.unavail column in the spreadsheet. Returns
TRUE if the spreadsheet cell is empty.
Returns FALSE if the cell contains
data.

pickl through pick1000 | logical no yes Upon transition from FALSE to
TRUE, chooses the respective recipe
within the spreadsheet. When used
with pushbutton objects, these data
members can eliminate the need for
operators to use the recipe list dialog
box.

Comments The recipe object reads a block of continuous columns. Therefore, the
ingredient names should be a contiguous list in Row 1. If a recipe does not use a
particular ingredient, just leave the respective cell blank.

When Lookout encounters a blank cell in Column A, it ignores the entire
row. Thus, you can easily annotate your recipes by leaving a cell in
Column A blank and adding text to the cell in Column B of the same row.
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Run

You can use Run objects to start an external program file from within
Lookout. When the result of the Run when logical expression goes TRUE,
the object executes the Command line.

M ame: lF!un‘I—

Run when = ITimer‘I

Command line = I"E:\Excel\ExceI.exe Report].«ls'|
Start program

Alarm priority: |5
QK I Eancell Help |

' lconic
& Marmal
' Maximized

Figure 2-83. Run Definition Parameters Dialog Box

In this example, Lookout runs an Excel macro called REPORT1 . XLM when
the logical value returned by Timer1 goes TRUE. Timer1 is a TimeofDay
object that triggers the report to run every day at 8:00 a.m.

The Command line text expression must be enclosed in quotation marks
as shown. Notice that the example includes the full path name of the
executable file. Ensure that your command line meets DOS syntax
requirements. Because this is an expression data field, the command could
be the result of a text expression.

Passing arguments in the Run Object in Lookout requires proper use of
double quotes depending on how many arguments you are passing and
whether or not those arguments have spaces in the path.

If your argument has no spaces in the path, you need only insert double
quotes before and after the argument.

If your argument has spaces in the path, you must insert two double quotes
at the beginning and the end of that argument to define it as a single
argument. These two double quotes are in addition to the double quotes you
must use in passing any argument.
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For example, when passing a single argument the following examples
demonstrate the correct use of double quotes (spaces are exaggerated for
effect):

""re:\my excellautoexec.xls"""

"c:\excel\excel.exe"

When passing two or more arguments, you follow the same rules for each
argument, as illustrated in the following examples:

""rveo:\program files\msoffice\excellexcel.exe"" c:\autoexec.xls"
""rveo:\program files\excellexcel.exe"" ""c:\my excellautoexec.xls"""
"c:\excel\excel.exe c:\working\autoexec.xls"

You can specify how an application presents itself when you activate it
with the Start program selections. If you select Normal, the application
window appears in front of the open Lookout window when it is activated.
If you want to reduce the application to an icon each time you start it, select
Iconic. If you select Maximized, the application window replaces the
Lookout window on the screen. (Lookout is still running; you just cannot
see it. Press <Alt+Tab> to switch between applications.)

Table 2-52. Run Data Members

Data Member Type Read | Write Description

none — — — Run does not have any data members

Comments If the application does not automatically shut down, multiple instances of
the program may be running because of previous starts. Over time, this can snowball
to the point where Windows performance is severely hampered.

If you want to execute DOS commands from within Lookout, put the
commands in a DOS batch file (. bat) and then identify the batch file in the
Command Line.
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Sample

The Sample object samples and holds data. Any time the Sample
expression transitions from OFF to ON and the Enable expression is
TRUE, the Sample object samples and stores a Data expression. Sample
maintains an array of up to 35 previous samples. If Enable is left blank it
is assumed to be TRUE. Data is a numeric expression while Sample and
Enable are logical.

Mame: W
[rata = ||
Sample = I
Enable = I
ok | Cancel | Help |

Figure 2-84. Sample Configuration Parameters Dialog Box

@ Note Sample does not have a display parameters dialog box. You can display the result of
a Sample output signal by using its data member in an expression.

Sample Data Members

Table 2-53. Sample Data Members

Data Member Type Read | Write Description

(implicit) numeric yes no Current Data value—tracks Data
input value.

1-35 numeric yes no Previous samples. Signal 1 is the most
recent sample since Sample went
high. If you display Sample, you
display the current and active value
for the object—that is, the (implicit)
value. If you display Sample.1, you
display the least complete value.

DataReset logical no yes Upon transition from FALSE to
TRUE, resets to zero all data
members—including the current
value and all previous samples.
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Comments The Reset expression can be a regular pulse interval created by a
TimeOfxxxx timer. For example, if you want to sample the temperature every hour of
the day, use the output signal from a TimeOfHour timer in the Reset expression to
sample the temperature at the beginning of each hour.

Related Objects Average, Maximum, Minimum, SampleText

Lookout Object Reference Manual 2-170 www.natinst.com



Chapter 2 Lookout System Objects

SampleText

SampleText samples and stores the result of the Data expression any time
the Sample expression transitions from OFF to ON and the Enable
expression is TRUE. SampleText maintains an array of up to 35 previous
samples. If Enable is left blank it is assumed to be TRUE.

Mame: W
Data = I
Sample = I
Enable = I
ak. | Cancel | Help |

Figure 2-85. SampleText Definition Parameters Dialog Box

Data is a text expression while Sample and Enable are logical expressions.

@ Note SampleText does not have a display parameters dialog box. You can display the
result of a Sample object output signal by using its data member in an expression.

SampleText Data Members

Table 2-54. SampleText Data Members

Data Member Type Read | Write Description

(implicit) text yes no Current Data value. Tracks Data
input value.

1-35 text yes no Previous samples. Signal 1 is the most
recent sample since Sample went
high.

DataReset logical no yes Upon transition from FALSE to

TRUE, resets all data
members—including the current
value and all previous samples.

Related Objects Sample, L3TextEntry, TextEntry
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Scale

You can use the Scale object to create dynamic scales—that is, scales
whose ranges and divisions can change based on numeric parameter
expressions.

@ Note If you want to create a simple scale that does not change dynamically (which is
normally the case), use the Insert»Scale command.

Create Scale E

Absalute Minimurn: ID

Absolute M aximurm: 100
Minimurn = ID
I awimum = |1 0o
Major unit = |1 1]
Minar unit = |2.5
QK I Cancel | Help |

Figure 2-86. Scale Definition Parameters Dialog Box

Absolute Minimum and Absolute Maximum are numeric constants.
They define the fullest possible range that the scale can show. These values
act as clamps, restricting Minimum and Maximum.

Minimum and Maximum are numeric expressions you can use to change
the minimum and maximum values on the scale. In the preceding example,
the highest value of the scale (Maximum) is 400 if Pot1 is less than 400,
1600 if Pot 1 is greater than 1600 (because of the Absolute Maximum), or
equal to the value of Potl.

Major unit specifies the number of units between major tick marks. Minor
unit specifies the number of units between minor tick marks.
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When you click on OK, the Display Scale dialog box appears.

Display Scale: RawPumpTrendScale | ]
Orientation

10 10
0 0 v i Cancel |

i i
L1 [ p—
103 Eo S oo
left side, increasing up V Minor tick marks
> pEnEEEE
ol Lefaels Lakel format:
Label font.. [ [ =
10 pt Arial Bold

Figure 2-87. Scale Display Parameters Dialog Box
Specify Orientation, Color, Label format, and Label font as you choose.

You can remove minor tick marks by deselecting the Minor tick marks
check box and you can remove label numbers from your scale altogether by
deselecting the Labels check box. (Only major units have numeric labels.)

Scale Data Members

Table 2-55. Scale Data Members

Data Member Type Read | Write Description

visible logical no yes When TRUE, the Scale becomes
visible on the control panel. When
FALSE, it is invisible. The default
value is TRUE.

Comments Many people use this object class in conjunction with HyperTrends that
are configured for a variable Y axis. They configure the Minimum and Maximum
parameters of the Scale object to follow the same values as the Max and Min data
members of the HyperTrend Object.

© National Instruments Corporation 2-173 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

Sequencer

The Sequencer object is a method for cycling through a collection of up to
100 differently configured ON/OFF states for your process.

Each Sequencer state has 26 logical outputs. Outputs left blank are
considered OFF.

You set each output to ON or OFF for each state. You can also create jumps
to skip from one state to another, or activate immediate jumps to a
designated state.

Create Sequencer E

MName: (T Statez: [7

[1-100)

State Time Limit Outputs

Mo Label HHMMSS) 4 B CDEFGH I JKLMNOPARSTUYVWXYZ

| ol o oo o oo oo
o o oo o oo oo
o o oo o oo oo
o o oo o oo oo

o o oo o oo oo

o o oo o oo oo
ol o oo e e e o e e e o

- R B R

QK I Cancel | Help |

Figure 2-88. Sequencer Definition Parameters Dialog Box

The States field activates the states you want in your sequence loop. If you
set States to 5, the sequence object will pass through states 1 through 5 and
then return to state 1 to repeat the cycle.

Notice that unused states can still be configured. In this way you can
preconfigure special states, create subroutines, and so on. See the
Programming the Sequencer section for further information on using this
object.

Use Label to label each state.

The Time Limit parameter determines how long the Sequencer holds each
state. If you leave this parameter blank, the Sequencer halts on that state
until a Goto or Jump is activated, or the Time Limit parameter is changed.
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@ Note When you set the Time Limit expression to reference a Lookout control, you must
make sure the output of that control is either in HH:MM:SS format, or in days.

Outputs are the ON/OFF settings for each state.

Programming the Sequencer

Left unmodified, the Sequencer cycles through the states selected in the
States field of the Sequencer parameter configuration dialog box,
beginning with state 1. If you enter 4 in the States field, the Sequencer will
cycle through states 1—4 continuously, spending the amount of time in
each state set by the Time limit.

Use the Goto data members to jump to a given state of the Sequencer
immediately. Use the Jump data member to skip automatically from one
state to a target state.

There is a tiny lag in state transition when you use the Jump data member.
For instance, if you have a sequence cycling through states 1—S8, and under
some circumstances you want to skip states 5 and 6, moving directly from
state 4 to state 7, set the jump5 . 7 data member to TRUE. When the
Sequencer reaches the end of the state 4 Time limit, it switches to state 5,
and then immediately jumps to state 7. State 5 will be active for a brief
period (about 10 ms), however, which you should take into account in
designing your sequences.

You can use sequential jumps if you choose. When you activate a jump
from state 1 to state 5, for example, and also a jump from state 5 to state 9,
the Sequencer skips from state 1 to state 9 with a 10 ms delay at state 5.

If you use a Jump or Goto data member to activate a state outside the
number you selected in your States field, the Sequencer will continue to
cycle through any states following the target state, until it either reaches a
state with no set Time limit, or state 100.

If the Sequencer reaches a state with no set Time limit, it remains in that
state until a Goto or Jump is activated, or until the Time Limit parameter
is changed.

If the Sequencer reaches state 100, and if state 100 has a Time Limit set,
the Sequencer cycles to state 1 at the end of that time, resuming its cycle
inside the states defined by the States parameter.
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If you use a Goto or Jump data member to activate a state outside the
ordinary cycle of a Sequencer object, you must use the Jump or Goto data
members to return the sequence to its automatic cycle.

Sequencer Data Members

See the Programming the Sequencer section for detailed information on
using Sequencer data members.

Table 2-56. Sequencer Data Members

Data Member Type Read Write Description
A-7Z logical yes no Sequencer outputs
Gotol — Goto100 logical no yes When activated, forces Sequencer to go

to the indicated state

Jumpl.1 - logical no yes When activated, jumps from the state

Jump100.100 indicated by the first number to the state
indicated by the second number

StateName text yes no Reports the currently active state name
(Label)

StateNumber text yes no Reports the sequence number (State

No.) of the current state

Time numeric yes no Reports the current length of time the
Sequencer has been in the current state

TimeLimit numeric yes no Reports the length of time set for the
Sequencer to hold the current state
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Spinner is a small, rotating disk. Its rotation speed can be variable, to
represent the magnitude of a numeric Signal, or its rotation can be turned
on or off based on the logical signal, Spin.

Mew Spinner E

% Logical [on/off)

Spin = I

Speed when spinning []: |1 oo
" Numeric
Sighal = I

Signallvalue &t 5 speed; ID

Sigrallvalive &b 00 speed; (100

QK | Cancel | Help |

Figure 2-89. Spinner Definition Parameters Dialog Box

Logical (on/off) and Numeric choose whether the spinner responds to a
logical signal or a numeric signal. Choose Logical if you want to be able
to turn the spinner on and off. Choose Numeric if you want the speed and
direction of the spinner to change depending on a numeric variable.

Spin is a logical expression. When the result of the logical expression is
TRUE, the spinner rotates at the rate defined by the Speed when spinning
(%) field. Speed when spinning (%) is a numeric constant, ranging from
-100 to 100.

Connecting the spinner to a positive value rotates the spinner in a
counterclockwise direction. A negative value rotates the spinner in a
clockwise direction.

Signal is a numeric expression. The result of this expression dictates the
spin speed based on the linear range defined by Signal value at 0% speed
and Signal value at 100% speed.

Table 2-57. Spinner Data Members

Data Members

Type Read | Write Description

none

— — — Spinner does not have any data
members
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Comments Spinners are typically used to represent flow through a line or to show a
motor running.

Pumps

#2
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Spreadsheet permanently stores data to disk in spreadsheet files. You can
log data on even and uneven intervals, when a data value changes, when
an event occurs, or when any one of these things happen. Hence, you can
implement complex logging criteria to meet almost any data storage need.

After each log, a new row is automatically added to the spreadsheet file.
Lookout can log a new row of data approximately 10 times per second;
however, the time stamps associated with each row are rounded to the
nearest second.

Each spreadsheet file may store any number of data signals. Each data
signal is assigned a spreadsheet column, beginning with column number
two. The first column contains the date and time. The first row contains the
expressions associated with the data in each column. You may create any
number of Spreadsheet objects for a given process.

Create spreadsheet storage object E
M ame: ISheet‘I

— File configuration

— Mechanizms to tigger data logging
Interval logging

Mame =

lSheet‘I— Interval = [30:00

[hh:mm: sz, 35 or variable]

Type: Icsv 'l Lomgim= Ion

Directory tree location
' Daily
& Monthly
 VYearly
' Perpetual

[turnz interval logging on and off]

Log now = I
[log data every time signal goes tue]

™ Logon every data change

— Data field .
Mo data fields:

Ok

Editing field 01 fnew field] = Lo

SavE: | I

Delet Faormat: Field:
ﬂl IGeneraI vl |1

Help

il

Figure 2-90. Spreadsheet Configuration Parameters Dialog Box

Name is the filename used to create a spreadsheet file. Lookout assigns a
DOS filename to each spreadsheet file by adding the Type extension to the
Name. Currently, Lookout supports only one Type: comma separated
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Lookout Object Reference Manual

value format (. csv). Most database and spreadsheet programs including
Microsoft Excel directly read the . csv file format.

Because the Name parameter is a text expression field, you can create new
.csv files with unique names dynamically. This is especially useful for
recording batch processing data. The definition dialog box Figure 2-86 is
configured so that an operator can enter a batch name using a TextEntry
object before the batch is started. The text expression appends the filename
to the specified path, C : \BATLOG\. So if the operator enters a file name like
BATCH71, then the full path name would be C: \BATLOG\BATCH71.CSV.
When the Bat chRun logical signal goes TRUE, Lookout creates the new
.csv file and begins writing to it. When Bat chRun goes FALSE, logging
ends, leaving a comprehensive log of all data associated with the batch.

This example forces Lookout to store the . csv file in a particular directory
because it specifies a full path name. If you enter a relative pathname like
"\BATLOG\"&TextEntryl, the file is located in that subdirectory of the
identified Directory tree location. So, for example, the full path name of
the file might be C: \LOOKOUT\1995\SEP\BATLOG\BATCH71.CSV.

If you enter just a filename such as "DATA™", the file location is based on the
Lookout directory. For example, the full path name of the file might be
C:\LOOKOUT\1995\SEP\DATA.CSV.

If you select Daily, Lookout creates a new file and subdirectory every day
in which to store the data. If you select Monthly, Lookout creates a new file
and subdirectory every month in which to store the data. If you select
Yearly, Lookout creates a new file and subdirectory every year. Perpetual
files are stored in the root directory as specified by your Data files location
parameter.
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The following examples are the DOS filenames and directory trees created
by Lookout for a spreadsheet file named, DATA.

Daily Yearly
c:\lookout\1993\sep\09\data.csv c:\lookout\1993\data.csv

\sep\l0\data.csv \1994\data.csv

\sep\ll\data.csv \1995\data.csv

Monthly Perpetual

c:\lookout\1993\sep\data.csv c:\lookout\data.csv

\oct\data.csv

\nov\data.csv

The Mechanisms to trigger data logging are a set of tools used to create
a simple or complex logging scheme, as desired. Use these parameters to
log data based on a timer, event, or any combination of the two. When the
spreadsheet is triggered, all data in the Data fields is logged to disk.

Interval is a numeric expression used to create a Pulse timer with a pulse
period of the specified time period and a pulse duration of zero. Normally
this is a time formatted constant value such as 15:00 (fifteen minutes),
for example.

Logging is a logical expression that turns the Interval parameter on and
off. It could be a switch on a control panel, a logical input from an external
device, or a more complex expression. Normally this is a constant value,
ON or OFF.

Log now is a logical expression. When Log now transitions from OFF to
ON, Lookout logs the data. A transition from ON to OFF has no effect. This
expression could be a pushbutton on a control panel, a logical signal from
a device, or a more complex expression.

The Log on every data change option should be used with care. When
turned on, it triggers the logging of data any time any one of the data fields
experiences a change. This is normally used to log the starting and stopping
of pumps, opening and closing of valves, or other similar events. If your
data fields contain even a single analog value that changes often, you could
end up triggering the logger thousands of times. Or if they contain a logical
value that changes frequently, you could have the same problem.
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The Data fields window lists all expressions that have been entered for
logging in the order of their field number.

The Save button saves your new or modified expression in the Data fields
window along with a new field number if any. Normally, Data fields
contain simple expressions like PL.C1.Tanklevel.

The Delete button deletes the currently selected expression from the data

fields list.

The Format option specifies the numeric format assigned to the currently
selected numeric expression when it is logged to disk. This has no effect on
logical or text expressions.

Field indicates the number of the currently selected data field.

@ Note Field numbers should not be modified after data has been stored or the data will not
appear under correct headers until a new file is created.

Spreadsheet Data Members

Table 2-58. Spreadsheet Data Members

Data Members Type Read | Write Description
logged logical yes no Spreadsheet file update pulse. The
Spreadsheet object generates this
logical pulse with a pulse duration of
zero after each successful log.
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SqlExec

SqlExec is an object Lookout uses to communicate with the ODBC driver.
ODBC allows Lookout to connect to any database that supports ODBC.

SqlExec connects to ODBC using the standard ODBC calls, and queries the
database using SQL statements. The data, if any, is returned in the object
data members.

Create Sql E
Mame: I

D ata Source=

SOL=

Alarm priority: IS_
™ Buffer SOL
QK I Cancel | Help |

Figure 2-91. SqlExec Configuration Parameters Dialog Box

Data Source specifies the Data Source Name (DSN) as well as any other
parameters needed by the ODBC driver to make the connection to the data
source. For example if you want to connect to Excel 4.0, use:

"DSN=Excel Files; DBQ=C:\pathname;"
SQL is the SQL string you want to pass to the ODBC driver.
Alarm Priority determines the priority level of object-generated alarms.

Buffer SQL tells the SqlExec object to buffer any entries that fail for that
object. An entry consists of the Data Source string and the SQL string.
While Lookout does install a Lookout ODBC driver, you must manually
create your own data source in order to access the Citadel database using
ODBC. Consult Chapter 8, Structured Query Language, of the Lookout
Developer’s Manual for information on how to create your Lookout data
source.
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@ Note Some applications are not completely ODBC compliant. If you plan to use
Microsoft Query, Microsoft Access, or Microsoft Visual Basic, ensure that the maximum
column name length does not exceed 62 characters. These applications cannot handle
longer names. Applications that are completely ODBC-compliant can handle names up to
126 characters long. All traces whose names exceed the maximum column name length are
excluded from queries.

Because Lookout objects may include network path information in their names, and
because you can arrange Lookout objects in hierarchies inside your processes, you may

find it easy to exceed the 62 and 126 character limitations of ODBC. Consideration given
to naming and organizing objects can minimize the risk of encountering this difficulty.

SqlExec Data Members

Table 2-59. SqlExec Data Members

Data Member Type Read | Write Description

cl —c65535 numeric yes no Value of the nth column in the row
returned by ODBC.

cl.logical — logical yes no Value of the nth column in the row

c65535.1ogical returned by ODBC.

cl.txt — c65535.txt text yes no Value of the nth column in the row
returned by ODBC.

Execute logical no yes Executes the submitted SQL

statement when it receives a change
from low to high.

Failure logical yes no High if the last submitted query
failed.

ReadOnly logical yes yes If TRUE, opens the file in read only
mode.
If FALSE, opens the file in read write
mode.

Status logical yes no High when the object is processing a
query.
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SqlExec Comments

The placement of the data in the data members is determined by the SQL
string. If you submit the SQL string

"select Album, Artist, NumTracks from cdTable

where NumTracks>5"

the return value for Album is contained in the data member c1 . txt, Artist
in c2.txt, and NumTracks in c3. This value is displayed according to the
data member you choose—Text, Logical, or Numeric. If you connect both
to c1 and cl.txt, you are connecting to the same value twice. In these
circumstances, the value is represented in a different form.

A select statement only returns the first row that it encounters with the
matching criteria. An update statement updates all the rows it encounters
with the matching criteria.

If you connect your SqlExec object to a timer that pulses faster than several
times per second, Lookout may become so busy handling SQL queries that
it becomes unresponsive to user input from the mouse or keyboard.

Comma Separated Value (CSV) files are supported in ODBC. You can
append data to them using the SQL insert command, but you cannot update
records using the SQL update command. This is a limitation of the CSV file
format.

*  Excel files are accessible through ODBC, but they do have some
unusual properties.

» If you use SqlExec to update an Excel 5.0 or greater workbook, the
workbook must be closed and have multi-user editing turned off.

* Ifyou are just trying to read from a workbook using a select query, then
multi-user editing can be on, and the file can be opened or closed.

* If you try to access an Excel 5.0 or greater workbook while it is open
and multi-user editing is off, Lookout locks up until the Excel file is
closed. This is caused by a problem in the Excel ODBC driver.

* If you are using Excel 4.0 you can update or read from the worksheet
only when it is closed. If you try to access an Excel 4.0 worksheet
while it is open, you will receive an alarm in Lookout.

Citadel is also accessible through ODBC, but is opened exclusively in
read-only mode to protect the integrity of the data.

The following table lists a few sample DSN and SQL strings for connecting
to different types of databases through ODBC. Notice that they differ
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slightly from database to database. Remember that Data Source and SQL
are expressions. If you enter a string into the expression box, the string must
be properly set off by quotes. The strings in the following table appear

exactly as you would type them into Lookout.

Database Type

Data Source String

SQL String

CSV

DSN=Text Files;
DBQ= c:\ldev\ald2csv;

"select Priority, ""Date &
Time, " "Description from
alarm.csv where

Priority = 4"

Excel 4.0

DSN=Excel Files;
DBQ= c:\ldev\ald2csv;

select Priority," "Date &
Time," "Alarm Codes
(Set:Reset:Acknowledge",
"Description from alarm.xls
alarm where Priority = 4"

Excel 5.0

DSN=Excel Files;

"select Priority," "Date &
Time," "Alarm Code

(Set :Reset :Acknowledged), "
"Description from Tablel
where Priority = 4"

MS Access

DSN=MS Access 7.0
Database;

DBQ=c:\My Documents\
compact .mdb;

"select Title, AlbumID,
Length from tracks where
TrackID = 7"

Citadel

DSN=Citadel 32-bit;

"select Interval,
LocalTime, " "Waves.Square"
"from Traces where
Interval = 0:1 and
LocalTime >" "2/14/97
14:34:30"
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SQL Command Buffering

The SQLExec object can create a buffer for SQL commands so that
commands are not lost if the connection to the database is temporarily lost.
Buffering stores failed commands in a file so that they can be resubmitted
once the connection to the database is reestablished.

If you check the Buffer SQL checkbox in the Create SQL dialog box, the
object buffers entries that fail for the following reasons.

e Unable to connect to data source: error code 08001.
e Connection in use: error code 08002.

e Communication link failure: error code 08SO1.

e Drivers SQLAllocEnv failed: error code IM004.

¢ Drivers SQLAllocConnect Failed: error code IM0O05.
*  Unable to load translation DLL: error code IM009.

Entries are not buffered for any other error codes. This is to prevent entries
that always cause an error from being buffered, such as a syntax error in an
SQL string.

You should only enable buffering for SqlExec objects that are inserting new
data into a database, such as an SQL insert command.

When entries are being buffered, they are buffered according to the data
source with which they are trying to connect. This prevents an SqlExec
object being buffered for an Excel data source from blocking an SqlExec
object connected to an MS Access data source.

Separating the buffers by data source also keeps entries from different
SqlExec objects trying to connect to the same data source in their proper
chronological order.

If an SqlExec object has to buffer data, it keeps the data in a directory called
dsndata in your Lookout data directory. The data is kept in a . csv file,
you can view in Excel. Do not try to view these files while Lookout is
running.

Once an object starts buffering, it buffers all subsequent entries to that data
source for all objects that have buffering turned on. Because of this, an
entry with a syntax or other error that should not be buffered, can be
buffered. If this occurs, the buffering system discards that entry after the
entry is passed to ODBC and ODBC returns an error. You are not notified
when the entry is discarded.
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If an object has buffering turned off, and that data source is currently being
buffered, then that entry bypasses the buffer entirely. It then either succeeds
or fails according to the state of the connection to the data source.

If a data source has buffered data, the buffering system automatically tries
to reconnect to the data source periodically. Once it connects, it clears the
buffer by periodically de-queuing the first few entries and sending them
to ODBC.

During buffering, the Failure data member has a slightly different
meaning. If it is high, then the first entry in the buffer failed and was kept
in the buffer. If it is low it means that the first entry in the buffer was
successfully submitted to ODBC, and objects are still being buffered until
the buffer can be cleared.

If you are creating and testing a process file, you may accumulate a large
amount of buffered data in the dsndata directory. You can safely delete

this directory when Lookout is not running. You will lose all the buffered
data, but the SqlExec objects then loads with no errors or alarms.

SqlExec Status Messages

Lookout Object Reference Manual

ODBC Environment not allocated. No buffering will occur

Indicates that memory could not be allocated for the connection to ODBC.
This only occurs if your system is about to run out of memory. No buffering
occurs if this alarm is set. Data that has already been buffered is not lost.

ODBC(32).DLL Not loaded

Indicates that the DLL could not be loaded. No buffering can occur if this
alarm is set. Data that has already been buffered, is not lost.

Data Source Name: Objects are being buffered for this data source

This indicates which data sources are being buffered. Once the buffered
entries have been cleared, the alarm ceases.

Incorrect data source string, check syntax

This means that the Data Source string is missing the DSN=driver name;
pair.

SqlExec displays any error messages that it receives from ODBC as an
alarm. If the error is an error that should cause buffering, the status message
indicates whether the entry was buffered or not buffered. Each message
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returned by ODBC belongs to the ODBC group. Some of the more common
ODBC error messages are:

[Not Buffered] 37000/-3100: [Microsoft][Driver Name] Syntax error in
query expression ¢ ...’

The SQL string has a syntax error in it.

[Not Buffered] S1000/-1811 [Microsoft][Driver Name]Couldn’t find
file ‘(unknown)’

This usually means that your data source expression is incorrect, or you
have ODBC configured incorrectly for that data source expression, such as
trying to connect to an Excel 5.0 workbook your ODBC Excel driver set up
for Excel 4.0 worksheets. Check the data source expression and the
configuration of the ODBC driver.

[Not Buffered] 42000/-1809 [Microsoft][Driver Name]can’t update.
Database or object is read-only.

The file has been opened in read-only mode, but you are trying to write to
it. If you have the data member ReadOnly set to TRUE, set it to FALSE.
For some drivers, you can specify in the ODBC administration tool that all
files opened by that driver should be opened in read-only mode. Check the
ODBC configuration if you have ReadOnly set to FALSE and are still
getting this error. For some ODBC drivers (such as Citadel) the file is
always opened in read-only mode to protect the integrity of the files.
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Switch

Switch generates a logical signal for receipt by other objects. Switches
change state when you click on them with a mouse button, trackball,
touchscreen, or space bar on your keyboard.

o - Position source—————————————————
ame:
@ Local
Action verification messages——— " Femote
On= [ WRIE= |
Off =  DDE
SEnyiGe: I
Control security level: ID ¥ Log events :
Tapie: I
IEerm: I
QK | Cancel | Help |

Figure 2-92. Switch Definition Parameters Dialog Box

Use Action verification messages to create dynamic text expressions to be
displayed in message dialog boxes. See Chapter 6, Security, in the Lookout
Developer’s Manual for more information on security.

Switch1 =]

@ Are You Sure?

Figure 2-93. Verification Message Dialog Box

Position source determines where the value of the Switch resides. Local
indicates the value of the Switch lies within the object itself—on the control
panel. If the switch is up the signal is ON, if down the signal is OFF.

Remote Switches get their values from a remote source, often the register
on a controller they are connected to. Flipping the Switch changes the status
of the register, and changing the status of the register flips the switch.

The Remote option is especially useful when you want to prevent Lookout
from changing the value of setpoints or registers upon initial startup, or
reconnection of lost communication.

The Remote option calls for a URL to locate the data member you want to
connect to. The URL field is green, and you cannot use a complex
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expression as a URL. If you need to use one RadioButton for several
purposes, you can use a Symbolic Link to make a more complex connection
than that possible with a URL.

You can right-click in the URL field and use the URL Editor dialog box
to assemble the URL, in the same way you use the Lookout expression
editor.

A remote position source connection is completely reciprocal. A change in
your Lookout control changes the data member that control is remoted to.
Any change in that data member also changes the control. It is not
necessary, and is incorrect, to use the Edit Connections dialog box to
connect a control object to its controlled data member.

Because the remote connection is reciprocal, you can only make such a
connection to a data member that is either writable, or readable and
writable.

When a process with remoted controls first opens, those controls take their
initial values by following the URL to read the data members they are
remoted to. The control will be covered by a red X to indicate that the
remote connection is not functioning.

@ Note You should use Remeote to connect a control in a client process to a data member in
a server process. Connections inside a single process can be made using Object»Edit
Connections.

Because complex expressions are read-only values, you cannot remote
directly to them. For the same reason, you cannot remote one control to
another control’s (intrinsic) data member (though you can remote a
control to another control’s value data member).

Much like Remote Switches, DDE (Dynamic Data Exchange) Switches get
their values from a remote source. This could be a cell in a spreadsheet,
another DDE aware application, or a second copy of Lookout running on
the network. See Chapter 5, Dynamic Data Exchange, in the Lookout
Developer’s Manual for more information on Service, Topic, and Item
parameters.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it.

The Log events option creates a permanent audit trail for the object—who
did what and when. All adjustments of the Switch are logged to disk,
including the time the Switch was flipped, the operator’s account name,
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and the direction the Switch was flipped. See Chapter 7, Logging Data and
Events, in the Lookout Developer’s Manual for more information on event

logging.

Display switch: Switchl

¢ Standard

7

COn

NS

N

&«

N
\\\\\\\\\\\\\\

Cancel |

You can replace the standard switch types with custom graphic symbols.
If you decide to use custom graphics, you must specify both symbol
parameters, On and Off. See Chapter 2, Graphics, in the Lookout
Developer’s Manual for more information on creating custom graphic
symbols and the use of transparent pixels.

ers

Table 2-60. Switch Data Members

Data Members Type Read | Write Description

(implicit) logical yes no Switch Position

enable logical no yes If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is ON. This input is ignored for
non-DDE TextEntry objects.

reset logical no yes While this value equals TRUE, the
control will be set to the value in
resetvalue.

resetvalue numeric no yes Sets the value a control will take when
the reset data member transitions
from FALSE to TRUE.
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Table 2-60. Switch Data Members (Continued)

Data Members

Type

Read

Write

Description

value

numeric

yes

yes

The current value of the control. If
you have remoted this control, then
value is the current value of the
position source.

visible

logical

no

yes

When FALSE, the switch object
cannot be seen on the display panel.
When TRUE, the Switch can be seen
and controlled.

Comments If a switch with more than two positions is needed, use a Pot object instead.

Related Objects Pushbutton, Pot
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Symbolic Links

A Symbolic Link is a Lookout object you use to make certain kinds of
remote connections easier and more efficient. This object can also be used
to manage failover redundancy in Lookout 4. (Redundancy is not
implemented in the Lookout 4 Preview.)

The Symbolic Link serves as a flexible intermediary between separate
processes whether they are running on one computer or on different
computers.

Create a Symbolic Link using the Lookout object browser. Right-click on
the process or folder into which you want to insert the new Symbolic Link.
The following dialog box appears.

Create Symbolic Link E

M ame: I

Source
% Static

URL = |

' Dynamic

Erpi= I

()8 I Cancel |

The Symbolic Link can represent either a static or a dynamic source. The
Static source is a URL pointing to a computer, process, folder, or object
running in some instance of Lookout on your network. A typical Symbolic
Link set to a process appears in the following illustration.
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Obiject Explorer

y Unlverse -
Hetnork]
E| parolkos dy.natingt. com
I % $Keyboard
I {;&3— $System

o $darm
=8 I‘ [ServeriLink]

3% Server_1_Main_Panel
% Server_1_PLCY

<3 Server_1_Patl

-6y Server_1_wWavefarml
-8 Call_Reset_Values_Panel_PB
-8 Choose_Trends_Rbtn

-8 Client_1_Main_Panel

-8 Client_1_Reset_alues_Panel
(-4 Client_Pot1

Lot Clioer Dotd

As you can see, all the objects in the Server_1 process are represented in
the Symbolic Link [Link_to_Serverl]. You can drag and drop any of
the objects or data members onto a panel in the process containing the
Symbolic Link, where they will appear as expressions.

The Dynamic source must always be an expression that evaluates as a text
string. When you select this option, you can use text strings and text
variables to prepare the Symbolic Link to be used by a control for remote
connections that cannot be made directly.

For example, you cannot use a complex expression in a Pot control remote
source URL. You can, however, construct a complex expression as the
dynamic source in a Symbolic Link, and then set the URL to connect to that
Symbolic Link.

For instance, the following expression evaluates as two different URLs

depending on the position of Switchl (line breaks inserted for clarity).

tif (Switchl,
"\\.\server_1\Server_1_Waveforml.sinewave",
"\\.\Server2\Server2_Waveform.sinewave")

If you connect a HyperTrend item to the Symbolic Link containing this
dynamic source, changing the switch changes which server provides the
wave form being plotted on the HyperTrend graph.

As another example, because Lookout data is now polymorphic, you can
construct strings using both text and numeric inputs.
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For example, if you create Pot1l with a minimum of 0, a maximum of 9,
and an interval of 1, you can use the expression

"Modbus1.4001" & Potl

as the entry for the Dynamic option in a Symbolic Link.

You can then use the Symbolic Link to connect a control to Modbus data
members 40010-40019, depending on the setting of Potl.

While you could not directly remote your control to that range of Modbus
data members, you can make a remote connection from that control to the
Symbolic Link using that dynamic expression.

If you connect the Dynamic expression to a data table, you have a nearly
unlimited ability to have one object control a large number of data
members, either through a cursor control or a radio button control.
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$System is a global object. It makes global Lookout data such as the
currently logged in user name and security level available for use in your
process. You can use $System data members just like other object data
members.

The seclevel data member is always an integer value between 1 and 10. This
number represents the Lookout security level of the user currently logged
in. For more information about Lookout security levels, see Chapter 6,
Security, in the Lookout Developer’s Manual.

The time data member represents the current date and time of the system.
Like all time values in Lookout, this is a floating point number in which the
integer represents the date and the fraction represents the time of day. You
can use the various Lookout date and time numeric formats to view this
value in the most convenient format. This data member updates itself every
minute, on the minute. It also updates itself immediately after it is created
or when its process is opened.

The username data member is the account name of the user currently
logged in. For more information about Lookout security accounts, see
Chapter 6, Security, in the Lookout Developer’s Manual.

$System Data Members

Table 2-61. $System Data Members

Data Member Type Read | Write Description

NetworkStatus text yes no Reports the status of the last network
transaction of your computer. You
may need to use this data member in
conjunction with a Sample object to
keep track of high levels of network
activity with many I/O points.

seclevel numeric yes no Security level of the user currently
logged in

time numeric yes no Current operating system time

username text yes no Name of the user currently logged in
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With TextEntry you can manually enter textual notes with the keyboard.
These notes may contain any combination of numeric and alphanumeric
characters; however, the result of your entry is converted to a text value.
Just like any other text expression in Lookout, your note can be logged to
disk, connected to other data members that accept text signals, and so on.
The note is saved and displayed as a single line entry—you cannot embed
carriage returns into the message.

Mew TextEntry: E

[REINE T extEntry

Entry prompt:

— Test source
@ Local

 Femate
’VUHL:= |
 DDE

SEnyiGe: I
Tapie: I
IEerm: I

Contral security level: ID V Logevents

QK I Eancell Help |

Figure 2-94. TextEntry Parameters Dialog Box

Entry prompt is the text that appears at the top of the text entry dialog box
when an operator selects the text entry pushbutton.

Text source determines where the user-entered text resides. Local
indicates the user-entered text lies within the object itself—on the control
panel.

Remote indicates that the user-entered text resides in a remote source,
such as a text expression or another TextEntry object.

The Remote option calls for a URL to locate the data member you want to
connect to. The URL field is green, and you cannot use a complex
expression as a URL. If you need to use one RadioButton for several
purposes, you can use a Symbolic Link to make a more complex connection
than that possible with a URL.
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You can right-click in the URL field and use the URL Editor dialog box
to assemble the URL, in the same way you use the Lookout expression
editor.

A remote position source connection is completely reciprocal. A change in
your Lookout control changes the data member that control is remoted to.
Any change in that data member also changes the control. It is not
necessary, and is incorrect, to use the Edit Connections dialog box to
connect a control object to its controlled data member.

Because the remote connection is reciprocal, you can only make such a
connection to a data member that is either writable, or readable and
writable.

When a process with remoted controls first opens, those controls take their
initial values by following the URL to read the data members they are
remoted to. The control will be covered by a red X to indicate that the
remote connection is not functioning.

@ Note You should use Remote to connect a control in a client process to a data member
in a server process. Connections inside a single process can be made using Object»Edit
Connections.

Because complex expressions are read-only values, you cannot remote
directly to them. For the same reason, you cannot remote one control to
another control’s (intrinsic) data member (though you can remote a
control to another control’s value data member).

Much like Remote TextEntry objects, DDE TextEntry objects get their
values from a remote source. This is the option you use to tie the text to a
cell in a spreadsheet, a database lookup table, or any DDE aware
application—including a second copy of Lookout running on the network.
See Chapter 5, Dynamic Data Exchange, in the Lookout Developer’s
Manual for more detailed information on Service, Topic and Item.

@ Note The last DDE parameters used on any object automatically become the default
values for any new DDE object.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it.

The Log events option creates a permanent audit trail for the object—who
did what and when. When selected, all text entries in this object are logged
to disk. Each entry includes the time of the entry, the operator’s account
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name, and what entry was made. See Chapter 7, Logging Data and Events,
in the Lookout Developer’s Manual for more information on event logging.

Lookout presents the following display parameters dialog box after you
define the object. It lets you define the text font and presentation style.

Text calor S oy F o
ackground style rarme style
II=III==I.IIII € Flate  Black

e - i
Background color Inset White

D. . ;  Rectangle  Mone
& Transparent
B
ENENEEE |
 Justify left & Justify centered  Justify right
O

Font... |1DptAriaIEloId

Figure 2-95. TextEntry Display Parameters Dialog Box

TextEntry Data Members

Table 2-62. TextEntry Data Members

Data Members Type Read | Write Description
(implicit) text yes no Current, user-entered text
enable logical no yes If TRUE (the default), enables DDE.

If FALSE, disables DDE. The default
value is ON. This input is ignored for
non-DDE TextEntry objects.

reset logical no yes While this value equals TRUE, the
control will be set to the value in
resetvalue.
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Table 2-62. TextEntry Data Members

resetvalue

numeric

no

yes

Sets the value a control will take when
the reset data member transitions
from FALSE to TRUE.

value

numeric

yes

yes

The current value of the control. If
you have remoted this control, then
value is the current value of the
position source.
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TimeOfxxxx are timers that generate a periodic pulse of a specified
duration. The timers are turned on and off by On/off signal. The time
period is defined by the type of timer used—a TimeOfMinute timer has a
one-minute period, a TimeOfYear timer has a one-year time period, and so
on. The output of these timers goes high after the specified Timer offset
has elapsed in the current period and remains high for the specified Timer
duration.

Create TimeDfDay timer: E
Mame: Timerl

On/off signal = l—
Timer offset = l—
Timer duration = I

Dizplay format: lm

Ok | Cancel | Help |

Figure 2-96. TimeOfDay Definition Parameters Dialog Box

The Timer offset and Timer duration can range from 0.0 seconds to a
year, and the effective resolution is 0.01 seconds over the entire range. The
Timer offset plus the Timer duration should always be less than or equal
to the time period.

The object display shows the time remaining before the output changes
state and is updated approximately once per second. It is shown in the
selected Display format. If the On/off signal is OFF, the display
shows OFF.

The On/off signal is a 